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Searching Bibliographic Records

Searching in the GUI OPAC (NOT YET AVAILABLE)
To be written by Betsy Friesen.
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Moving the Record Into Cataloging

While viewing any of the Full formats of the record in the GUI OPAC (Staff
Search), click the Push to Catalog icon at the top of the screen.

This will automatically open the Cataloging module, if it is not already open. Make sure
you are connected to the correct database. A copy of the record will be made on your
local drive and will be opened on your screen for you to edit. 

Alternatively, while viewing the Full record, you may click the Add to Nav. map button;
when the Navigation Window is displayed, click the Catalog BIB button.
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Searching in the Cataloging Module 
Just as in the GUI OPAC (Staff Search), you can do a Find (keyword) search or a Scan
(browse) search in the Cataloging module. However, there are limitations to the searching
options within the module that may make searching in the GUI a better choice in some
cases. Searching bibliographic utilities (OCLC and RLIN) is only available in the GUI;
this capability is not available in any other module.

In the Cataloging module, both types of searches are limited to eight indexes. (Refer to
the “Cataloging Module Indexes” listing in “Aleph Codes and Lists” for the specific
indexes.) If other search indexes or options are needed, go to the GUI and push the record
to Cataloging.

Also, the search within the Cataloging module does not allow you to save or manipulate
your search results as you can in the GUI.

Find (Keyword) Search

Scan (Browse) Search
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Z39.50 OCLC and RLIN Searching

Z39.50 Indexes and Search Tips

Connecting to RLIN or OCLC

In the GUI OPAC, choose File, Connect to, then RLIN or OCLC.

Reminders
� Network traffic is lighter early in the day, so response time is better then.

� Currently, you can use only the FIND command (the binocular icon or Search, Find
from the pulldown menu at the top of the screen) to search OCLC or RLIN. We have
blanked out the BROWSE pulldown to remind you that Z39.50 browse search results
cannot be used for cataloging. We are working with Ex Libris to correct this problem.

� You can do standard number, keyword, and left-anchored phrase searches from the
FIND pulldown. The descriptions of search types distinguish keyword and left
anchored phrase searches.

� Some searches work only on OCLC, and some work only on RLIN. We can define
only one pulldown menu for the searches, so we have noted which searches work
with which database. See also the comments in the list of available searches below.

� Phrase searches are automatically right truncated. Keyword searches are not, nor can
they be.

� You can choose a search type from the pulldown menu or you can click on the CCL
tab to use command line searching. Relevant index names for command line
searching are listed under "Index Names for Command Line Searching" below.

Available Searches

Search Comments
All Fields OCLC only. Use only if you're truly desperate.

Author Keywords

Author Phrase Recall high and precision low in RLIN.

Personal Name Phrase Recall high and precision low in RLIN.

Corporate Name Phrase Includes conference names in RLIN.

Conference Name Phrase Includes corporate names in RLIN.

Title Keywords
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Search Comments
Title Phrase

Series Title Phrase

ISBN

ISSN

LCCN

Music Publisher Number (028)

OCLC Number (OCLC only)

RLIN Number (RLIN only)

Order of Precedence for Searches
1. If you have a standard number, i.e., ISBN, ISSN, LCCN, or Music Publisher

Number, search using that number. These are always the most efficient searches.

2. If you have a reliable title citation, use a title phrase search. Or use a series title
phrase search, if you suspect the title you have is for the series, rather than the
individual volume in the series.

Use most or all of the title to avoid the "too many truncated words" error message on
OCLC.

3. If you do not have a reliable title citation or a title phrase search yields no results, but
you do have a reliable author citation, use an author phrase search.

4. If all else fails, resort to a title keyword search or an author keyword search. Use the
most distinctive words you have available to search.

Index Names for Command Line Searching

WANY All Fields (OCLC only) SETTL Series Phrase

WAUT Author Keywords ISBN ISBN

AUT Author Phrase ISSN ISSN

PERS Personal Name Phrase LCCN LCCN

CORP Corporate Name Phrase MUS Music Publisher Number (028)

CONF Conference Name Phrase OCLC OCLC Number (OCLC only)

WTTL Title Keywords RLIN RLIN Number (RLIN only)

TTL Title Phrase
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Limiting by Format
Yes, you can limit searches by bibliographic format. You need to use command line
searching to do so, and you must combine this limit with another search.

Here's how: The index name for format is WFMT for either RLIN or OCLC.

RLIN
The index value to use with the WFMT limit is the leader 06 or 06/07 value(s) for the
format.

For all formats except serials, you only need to use a leader/06 value:

a Language material

c Notated music

d Manuscript notated music

e Cartographic material

f Manuscript cartographic material

g Projected medium

i Nonmusical sound recording

j Musical sound recording

k Two-dimensional nonprojectable graphic

m Computer file

o Kit

p Mixed material

r Three-dimensional artifact or naturally occurring object

t Manuscript language material

For serials, use one of the values above plus s, e.g., as, es.

Example

TTL=gone with the wind and WFMT=j
[for records with a title field that begins "gone with the wind" that are musical
sound recordings]

WTTL=aardvark and WFMT=g
[for records with the word "aardvark" in a title field that are videos, etc.]

TTL=physics letters and WFMT=as
[for records with a title field that begins "physics letters" that are serials]
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OCLC
The index value is the OCLC format code:

bks books ser serials

com computer files sco scores

map maps rec sound recordings

mix mixed materials vis visual materials

Example

TTL=gone with the wind and WFMT=rec
[for records with a title field that begins "gone with the wind" that are
sound recordings]

WTTL=aardvark and WFMT=vis
[for records with the word "aardvark" in a title field that are videos, etc.]

TTL=physics letters and WFMT=ser
[for records with a title field that begins "physics letters" that are serials]
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RLIN Record Clusters
The Z39.50 interface does not display records in clusters as we were accustomed to
seeing when searching RLIN directly. The Z39.50 algorithm chooses a record determined
to be the most complete or authoritative. For example, a full-level LC record, if available,
will usually be retrieved as the "master" record. There is not an option to display records
in clusters and choose according to CATCAT values.

However, the first record retrieved will list all the other RLIN records for that title in a
sequence of 952 fields. These will be visible at the bottom of the record if you choose the
MARC Tags tab of the full record display. Subfield a contains the RLIN record number,
and subfield b indicates the institution with which that record is associated.

To view one of these alternative records, copy down the RLIN record number, and do a
RLIN number search. Any subsequent record retrieved will not contain the listing of
952's for other institutions, so you may want to copy down all record numbers you wish
to search before closing the full record display of the master record.
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Importing and Overlaying Bibliographic
Records

Importing Bibliographic Records

What Is Z39.50? 
Z39.50 is a protocol that allows a client, or local computer, to search a remote computer
using a single search interface. Using local search commands, through Z39.50 the search
is translated so that it is understood by the remote machine. Results are sent back to the
user and displayed in a way the local computer can understand. This operation is
seamless for the user.

The searching of OCLC, RLIN and other bibliographic databases, and importing records
from those databases in Aleph, uses the Z39.50 protocol. This means that rather than
logging into another catalog, executing a search, and exporting the record into MNCAT,
you will search the utilities within the GUI OPAC. The records will be brought into your
client, and then pushed into the cataloging module for editing. Once the record has been
edited, it is saved to the Aleph server.

Connecting to the Z39.50 Databases

The Z39.50 connections operate as separate Aleph
libraries (databases). Use the Connect to from the GUI
OPAC status bar or File menu. Remember, these
databases will only be available in the GUI OPAC, and
not the individual modules such as Cataloging or
Acquisitions.

Once connected, you will have search options similar to
those for searching the local bib database. However,
some of the searching options will be only applicable to
specific databases.

Importing Records
From your results list, select the record you wish to import by bringing up a full view of
the record. Push the record to cataloging by clicking the Catalog Record icon on the
module toolbar, or selecting the option from the File menu.
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This will open the cataloging module, if it is not already open. You will then be asked to
select the format for the new bibliographic record that will open on your client. Highlight
the appropriate format and click OK. This will open the imported record as a NEW*
local bibliographic record on your client.

Saving Imported Records to the Server
The current importing configuration requires several steps before an imported record can
be saved to the server:

1. From an imported local record, issue the Duplicate record command from the File
menu, or press Ctrl-N.

2. Select the library where the record is to reside and click OK.

3. (Records imported from OCLC or RLIN only). From the Edit menu, select Fix
record. From the menu, choose Fix new RLIN records or Fix new OCLC records,
depending on which database the record was imported from. Click OK.

4. Make any other needed editorial changes.

5. Save to the server.
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Overlaying Bibliographic Records
Bibliographic overlay is accomplished by using the Copy Record/Paste Record functions
in the cataloging module.

To overlay a minimal record in our database with a fuller record from OCLC or RLIN:

1. Open the record to be overlaid in the cataloging module.

2. In the GUI OPAC, search for full copy in OCLC or RLIN.

a. File > Connect to > OCLC

OR

File > Connect to > RLIN
b. Perform a find search.

c. Open a full view of the record; choose tab 3 (MARC tags) to view the MARC
record.

3. To select the record for overlay, push to cataloging by clicking the Catalog record
icon from the OPAC toolbar (or choose Catalog record from the file menu). The
record will be pushed to the cataloging module.

4. Choose record's format, and click OK.

5. Go to the Edit menu, and choose Copy > Copy record (or Ctrl-D).

6. Move your cursor to the record to be overlaid (it should be directly behind the
OCLC/RLIN record you just copied) and highlight it so it becomes active.

7. From the Edit menu, choose Paste > Paste record (or Alt-D). The entire contents of
the OCLC/RLIN record will overlay the record. 

8. Be sure that you have overlaid the correct record, and that there are no notes or other
fields that need to be added back into the record. 

9. Perform any necessary editing, and save the overlaid record to the server. The system
number will remain the same, including the connections to orders, invoices, and other
record types.

10. The OCLC/RLIN record, which exists as a NEW local record in the EXT01 library,
can simply be closed, and deleted from your local drive if you wish.
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Bibliographic Overlay Workflow

From menu click
File/Connect to/
[OCLC or RLIN]

Overlay a Bibliographic Record

SEARCH FOR FULL
COPY IN OCLC OR
RLIN IN GUI OPAC:

Use a “find”
search to locate

better copy

Push record to
Cataloging: from
the menu click

File/Catalog record
or click the

Catalog record icon

Select record’s
format & click OK

From menu click
Edit/Copy/

Copy record

Move your cursor
to the record to
be overlaid &

highlight it so it
becomes active

From menu click
Edit/Paste/

Paste record

Need
better 
copy?

Yes

Return to
Cataloging 
Workflow

Click Full then
Select to display

bib record

OVERLAY RECORD
CURRENTLY DISPLAYED
IN UMN01 WITH THIS COPY:

With bib record to be
overlaid displaying in
Cataloging module...

From
Cataloging 
Workflow

Last updated 1/13/03

Click on Tab 3
(MARC tags)
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Searching Authority Records
In Aleph, authority records exist in databases separate from the bibliographic database.
They can be viewed in the bibliographic (01) databases, but you must switch to an
authority library (1X) to edit them. (See the “Authority Work” section of this manual for
details on using and updating the authority file and authority work for copy cataloging.)

� You can search authority files directly in the GUI OPAC or Cataloging module.

� To check a heading in the bib record on your screen, search field headings from the
bibliographic record (indirect search) in the Cataloging module.

Authority Searching in the GUI OPAC

Searching Authority Files Directly
In GUI OPAC, from the File menu, choose Connect to and select one of the authority
libraries. For authority searching, the All Headings browse index is the most inclusive
index and usually gives efficient results. However, you can use any appropriate GUI
OPAC browse or find search option. Keyword indexes of headings and references can be
searched if the initial entry element of a heading is unclear.

From the authority information on the results list, you can see the authority library where
the heading was found, the field tag where the search heading was found (1XX, 4XX, or
5XX), the values for Heading Use from the 008 field, and whether the authority record is
set for automatic updating.

Click Full to get a full view of the authority record. Click to the MARC Tags tab for the
best display. From the full view, you can push the record to cataloging for editing.
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Searching Authority Files Indirectly
The GUI OPAC can also be used to search indirectly for authorities.  When Aleph has
matched a bib heading to an authority, it displays brief information about the authority
tag in the right column of the index.  The Expand button can be used with a highlighted
line in the GUI OPAC to display a very abbreviated version of the authority record.

For a good display of the authority record, either search the authority file directly in
either GUI OPAC or Cataloging module, or search field headings from the bibliographic
record in the Cataloging module.

Authority Searching in the Cataloging Module

Searching Authority Files Directly
In Cataloging module, from the File menu, choose Connect to and select one of the
authority libraries.

For authority searching, the LCGEN (General) browse index is the most inclusive index
and usually gives efficient results. However, you can perform searches using other
Browse (Scan) or Find options. Keyword indexes of headings and references can be
searched if the initial entry element of a heading is unclear. Search options are different
than what’s available for searching the bibliographic database. (Refer to the list of
authority indexes in the Cataloging module in “Aleph Codes and Lists.”) 

Perform a scan or find search:
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From the results list, click Full, and then click Select to open the authority record for
editing.

Authority records can be edited and saved using the same methods as for saving
bibliographic records.

Search Field Headings From Bib Record (Indirect Search)
When in the Cataloging module, you can check a heading in the bibliographic record
currently on your screen:

1. Place the cursor on the heading.

2. From the Search menu, click Search field headings of another library (or press
CTRL F3). 

3. Select the authority file to be searched.

Aleph searches the designated heading in the selected file and reports the resulting
index.

4. From the index display, you can:

� Use the Expand button for a fuller view of each authority entry.

� From the Expand display, use the Select button to open the authority record for
editing.

� If you find a match for the person, body, etc. you’re looking for, you can use the
OK button on the index display to have the 1XX from the highlighted record
copied into the marked field on your bib record, replacing whatever is there.

Warning:

Do not use the OK button (or press Enter with OK highlighted) if you
do not intend to change the bib heading.
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Editing Bibliographic Records

Basic Navigation
A number of icons, quick keys, and keystroke sequences are available to use for common
tasks when working with bibliographic records. Refer to “Cataloging Module
Commands” in “Aleph Codes and Lists” for a complete listing.

Loading a Record From the Server
1. Select the Load record from server option from the File Menu, or use

the hotkey Ctrl-L, or click the Load record from server icon at the top
of the screen:

2. Type the system number of the desired record.

3. Click the OK button.

A copy of the record will be made on your local drive and will be opened on your screen
for you to edit. 

Loading a Record From the Local Drive
1. On the File Menu, select the Open record on local drive option or click

the Open record from local drive icon at the top of the screen. A popup
dialog box listing local records will be displayed.

2. Highlight the desired record. A preview of the contents of the record will be
displayed on the right side of the window.

3. Click the Open button.

The selected record will be displayed for you to edit.
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Fixed Fields 

Editing Fixed Fields
Fixed fields are edited by placing the cursor on the field tag and pressing Ctrl +F, which
presents the fixed fields (LDR, 006, 007, and 008) in a labeled form. 

Edit the contents of the field. You may move from space to space by using the tab key or
the up and down arrow keys. Note that the spaces of the form are of fixed length; you
may not enter text that is longer than the space provided on the form.

Click the OK button.

The contents of the field will be automatically inserted into the cataloging record.
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Adding Fixed Fields (NOT YET AVAILABLE)
To be written by Christine DeZelar-Tiedman.
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Help on Field

While in the form, click Help on
Field to receive a display of the
possible MARC values

Here’s an example of the
opened form for the 008
field.

While in the bibliographic
record, you can also
receive help on any field
by moving the cursor to the
field tag, and pressing F2.
This will bring up the Tag
information window, with
a display similar to the one
above.



University of Minnesota Aleph Cataloging Manual Page 29
Issue Date: 05-31-2002 Creating and Editing Cataloging Records
Revised Date: Editing Bibliographic Records

From: 401 Cataloging 1 Manual

Variable Fields

Moving in the Record
To move around variable fields of the record, you can use the following keys:

Up/Down arrows Move up or down one line.

Left/Right arrows Move left or right one space.

Tab Moves to the next field.

Page Up Moves up one page within the record, if there is too much data
to fit on the screen at once.

Page Down Moves down one page within the record, if there is too much
data to fit on the screen at once.

Ctrl+Home Moves to the very first line of the record.

Ctrl+End Moves to the very last line of the record

Adding Fields and Sub-Fields

F5 Add a new field (choose from list).

F6 Add a new field (staff defined).

F7 Add a new sub-field.

F8 Select a sub-field value from a list.

Options on the Edit Menu 
Right-click anywhere in the bibliographic record and the Edit menu appears. 

Additional editing can be performed as follows: 

Tag: Overwrite (i.e., type over the characters) to change a tag. To
erase a character, use the Spacebar and not the Delete key. To
delete a field tag, press Ctrl-F5.

Indicator: Overwrite (i.e., type over the characters) to change an indicator.
To erase a character, use the Spacebar and not the Delete key.

Sub field code: Overwrite (i.e., type over the characters) to change a code. To
erase a code, use the hotkey Ctrl-F7 or Delete sub-field from
the drop-down Edit menu, not the Spacebar or the Delete key.
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Data area: This works in ‘insert’ mode. To erase a single character, use the
Delete key. To erase a string or group of characters, highlight
the text and then use the Spacebar or the Delete key. You can
highlight for deletion or copy by holding down the left mouse
button and dragging the cursor over the desired text. To copy,
use the hotkey Ctrl C or Copy from the drop down Edit menu,
and to paste, use the hotkey Ctrl V or Paste from the drop down
Edit menu.

Help on Field for Variable Fields 
For help with the variable fields, place the cursor on the field tag and press F2. The
display will look much like the Help display pictured earlier in the Help on Field LDR
graphic.

Entering 010 Field
The LCCN is structured with 12 characters. Unused characters at the beginning or end of
the string should be entered as spaces.

Pre-2001 Numbers

1. If there is no prefix, enter three spaces. Aleph will not allow you to enter more than
one space in a row using the space bar. Instead, enter the spaces as the circumflex or
"tent" character (Shift-6).

2. The number itself should be eight characters. Fill in zeros between the year and the
number that follows it to make the total eight characters.

3. Add a space at the end.

2001 and Later

There are four spaces allocated for the prefix, and the year is four digits. There is no
ending space.

Examples

Pre-2001:

2001 and later:

^^^89004324^
nuc76039265^

^^2002112454
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Search Sub-Field Options
When entering sub-field values, you may wish to use a drop-down menu to select text.
Certain sub-fields have been set up with tables, which can provide commonly used
values. Enter the proper sub-field delimiter and press F8, or begin entering text at the
beginning of a sub-field, and press the tab key. The system will either fill in the
remainder of the term, or show a list of terms beginning with that letter. This
functionality is case sensitive, so be sure to use a capital letter if required.

Refer to “Bibliographic Record Sub-Field Menus” in “Aleph Codes and Lists” for
complete instructions and available sub-field menus.
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Expand From Template
Templates can also be used with existing records. Fields from a template will be added to
an open record in the client. 

1. Open a record in the cataloging module.

2. Choose Expand from template from the File menu, or issue the Ctrl-E command.

3. From the Template window, select the appropriate template and click OK.

More than one template may be used consecutively in a single record. Valid information
will not be overwritten in non-repeatable fields. For repeatable fields, an additional field
will be added. Blank or incomplete fields will be filled in.

For bibliographic records, some examples of when this feature may be used:

� To enhance a provisional or minimal record.

� To fill in required note fields for a special project.

� To combine templates.

Expand from template may also be used with holdings records. 

Expand from template is often used in the creation of publication patterns for serials. This
will be covered in-depth in the class devoted to that topic.
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Using Diacritics

Floating Keyboard
Diacritics may be entered using the ALA BT Courier Keyboard. It is often referred to as
the Floating Keyboard because it “floats” over any application you have open and may
be dragged and dropped anywhere in the module’s window. It enables you to insert
characters that are not present in your workstation’s standard keyboard.

To Use the Floating Keyboard for Cataloging

Step 1:
The Floating Keyboard is activated by
selecting the Activate keyboard option from
the Options menu of the Cataloging module.
The Floating Keyboard will then be
displayed.

According to configuration settings, the
Floating Keyboard may be divided into tabs,
each one displaying a group of characters.

Step 2:
Click on the desired tab and then select a
character from the Floating Keyboard. The
character is then added to the lower section
of the Keyboard window. Note that you may
add more than one character.

The contents of the keyboard’s lower section
can then be copied and pasted into the
bibliographic record.

Russian Ligatures Using the Floating Keyboard

To be written by Christine DeZelarTiedman.
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Entering Diacritics Using Unicode Values
Note: Refer to “Unicode Values for Diacritics” in “Aleph Codes and Lists” for the four-

character values for the diacritic or special character.

1. Place your cursor at the point in the record where you want to enter a diacritic or a
special character.

2. Press F11 OR choose Enter unicode values from the Edit pull-down menu at the top
of the screen.

3. Type the four characters from the chart that correspond to the letter plus diacritic or
the special character you wish to enter.  E.g., to type a lower-case e with an acute
accent, type 00C9.

4. The character in question appears on the screen as soon as you are done typing the
value.

5. Escape from unicode entry mode by either a) pressing F11 or b) choosing Enter
unicode values from the Edit pull-down menu at the top of the screen. In short, you
can toggle between unicode entry mode and regular keyboard mode.

Fonts

In order for your computer to read certain unicode values, you must have the appropriate
font installed. Otherwise, you will see a rectangle in the space where the character should
be.

To activate the Arial Unicode MS font:

1. Go to the Windows Start menu.

2. Choose Programs, then Accessories, then Character Map.

3. The Font drop-down menu will give you an alphabetic list of available fonts. Select
Arial Unicode MS.

4. If Arial Unicode MS is not listed on your workstation, you will need to contact
autosys to have it installed on your workstation.
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Russian Ligature Unicode Values

Unlike most other diacritics in Aleph, Unicode values for ligatures are not entered in
"precomposed" form (in combination with a letter of the alphabet). Instead, they need to
be entered after the letters with which they are associated.

Therefore, you should enter data in this order:

1. First alpha character

2. Left half of the ligature: Unicode FE20

3. Second alpha character

4. Right half of the ligature: Unicode FE21

Though the display does not represent the way ligatures appear in printed text, the data is
correct and follows the rules for Unicode. The display is a problem with the Arial
Unicode font, and therefore improving it is not within our control.

The ligature characters are on the "Combine" tab of the floating keyboard, which is the
furthest tab to the right. You may need to scroll with the arrow key to make this tab
visible.
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Sorting Records
The Sort Record function sorts the fields of the current record according to a defined
order. The Sort Record function also removes any empty fields or sub-fields. 

On the Edit menu, select the Sort Record option, or press Ctrl+M.

Note that within the 5XX, 6XX and 7XX groups of fields, the order of the fields remains
as the cataloger entered them.

Copy Record/Paste Record (Edit Menu)
This menu option is used for merging and overlay of records. Pastes the entire contents of
one record into another, without changing the system number. You must first issue the
Copy record command from an open record, and then open a second bibliographic
record and Paste record. Since the system number remains the same, all associated
records, such as holdings, orders, and items, will remain linked.

Change Record’s Format
The Change record’s format option on the Edit menu in the Cataloging module allows
you to change a record from one format to another.

Saving Records
There are three options for saving records under the File drop down menu, two options
using the menu icons:

1. Save on local drive.

2. Save all on local drive.

3. Save on server and local drive.

� You may wish to save records on your local drive in order to continue working on
them later or because communication links with the server have dropped. The Save
on local drive option will save your record on your PC’s hard disk, but you will
receive no message informing you that it has been saved and it will not be available
for anyone else to find in the system. You can continue editing the record if you wish,
but no updates will be registered unless it is saved to the server. Local records will
automatically be deleted after seven days, unless the file is renamed. 
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� The Save all on local drive is similar to the above except that it saves every record
that is open on your cataloging client.

� The Save on server and local drive option updates the server database and assigns a
system number to the record (as opposed to the current local number). 

This example shows a local
number assigned to a new record
that has not yet been saved on
the server.

This example shows a system
number and the local number
assigned to the record.

When you decide to use the Save
on server and local drive
option, a prompt will ask if this
is what you really want to do.
The message Change cataloger
level refers to a feature that has
not been implemented locally.
You may ignore it. Press
Continue to advance the saving
process.

Field and Record Validation
When a record is saved to the server, it is automatically checked for MARC 21 standards
compliance and other errors. All the errors appear in the Messages dialog box.

For manual validation, the two options under the Edit drop down menu are:

� Check field Or on keyboard use Ctrl + W.

� Check record Check record also has an icon on the tool bar:

For either Check field or Check record a dialog box appears with the appropriate error
messages. If no errors are found an empty dialog is displayed. Below is an example of
Check field. Note how the system identifies the area in the bibliographic record to which
you have been alerted.
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There are three levels of messages:

� Message that can be overridden (question mark).

� Message that can be overridden and create a record trigger (question mark with
pencil). These can be set to generate reports to be checked later for editing, or
possibly authority work.

� Message that blocks update of the record (exclamation mark in red). These errors
must be fixed before the record can be saved to the server.

Check the messages to see
which errors need to be
corrected and make the required
changes. For those that refer to
new headings, click Override.
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Suppressing and Deleting Records

Deleting From the Local Drive
Deleting records from your client only deletes your local working copy of the
bibliographic record. It does not delete any associated server records.

Delete a Single Record

1. On the File menu, select the Open record on local drive option or click the
Open record from local drive icon at the top of the screen.

A popup dialog box listing local records will be displayed.

2. Highlight the desired
record.

3. Click the Delete
button.

A prompt will be
displayed asking you
if you are sure you
want to delete the
record.

4. Click the Yes button

The record will be
deleted from your
local drive.

Delete All Local Records

This function deletes all records whose filenames begin with the prefix NEW*. If there is
a NEW* file that you do not want to delete, you should rename it by selecting Rename
on local drive from the File drop-down menu.

1. Choose the Delete NEW* records option from the File Menu. A prompt will be
displayed asking if you are sure you want to delete.

2. Click the Yes button. All NEW* records will be deleted.

Warning:
All NEW records will be automatically deleted from your client after
seven days. Be sure to rename any local records you wish to retain
beyond that point.
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Deleting From the Server
There are several ways to delete different types of records from the system, or to prevent
records from displaying to the public and/or to staff. It is important to use the appropriate
method according to the situation.

Using the STA Field (Logical Delete)

Records can be deleted or suppressed using the STA field in the bibliographic or holdings
record. The records are not actually removed from the server, but will be removed from
public and/or staff view.

1. Add a field to the record (F6).

2. Enter STA and sub-field a.

� Enter SUPPRESSED (all caps) to suppress the record from displaying in the
public (Web) OPAC. The record will still be indexed and searchable by staff. Use
this for records that are for staff use only, such as membership records or cat sep
orders, or materials that have been withdrawn, cancelled, or never received.

� Enter DELETED (all caps) when a record has been created or imported in error,
and saved to the server. The record will be suppressed from public and staff view.
In the staff mode, it can still be retrieved by system number.

3. For DELETED records only, change the Record Status (05) in the LDR to d.

4. Save to the server.

The F8 function also works with the STA field. Enter the a subfield, and press Tab or F8
to retrieve the list of values from which to select. (Refer to “Bibliographic Record Sub-
Field Menus” in “Aleph Codes and Lists” for more details and a list of available sub-field
menus.) Or, type a capital S or D and press Tab to fill in the rest of the word.
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Creating Bibliographic Records

Create Using Manual Input
1. From the file menu, select New record. The Choose record format window will be

displayed.

2. Highlight the correct format and click OK.

3. The form for the leader will open, containing default values for the chosen format.
Edit the fields if needed, and click OK.

4. The 008 form will be displayed next. Fill in the required information and click OK.

5. The system will prompt you with forms to complete the 260 and 300 field
information.

6. You now have a NEW bibliographic record displayed, which contains a leader and
fixed fields, a blank 245, and the 260 and 300 values you filled in. You may add and
edit fields as instructed in Cataloging 1. Save the record to the server when cataloging
is completed.

Create Using Templates
Templates have been created for a number of formats and record types, and these can be
used by anyone cataloging using the University of Minnesota server.
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Use Server Template as a Workform

1. Click the Open template icon, or choose the option from the File menu.

2. Highlight the appropriate template, and click OK.

3. Fill in the leader and fixed field information.

4. Edit the record and save to the server.

Create Local Templates
You may wish to create templates for your own use on your local client. To do this, you
need to create a NEW bibliographic record with the fields and text you wish to include in
your template, and then save it as a template on your local drive.

1. Create a NEW record on your local drive by opening a server template, starting a new
record manually, or modifying an existing bibliographic record.

2. Fill in the fields you wish to include in the template, or modify an existing record to
include the desired fields.

3. Select Create template on local drive from the File menu.

4. Name the file and click OK.

5. The template will now be shown in the menu when you Open template.



University of Minnesota Aleph Cataloging Manual Page 43
Issue Date: 05-20-2002 Creating and Editing Cataloging Records
Revised Date: Creating Bibliographic Records

From: 402 Cataloging 2 Manual

Server templates appear in lower case letters, and identify the server library where they
are stored. Your local templates will be in ALL CAPS, and say (Local) after them. Local
templates are only available on your client—no one else will be able to access them.

Edit Local Templates
You can edit a local template by opening it, editing it, and saving it again using the
Create template on local drive option. If you wish to over-write the previous version,
simply give the template the same name. 

You cannot edit server templates. You may create your own version of a server template
by following the steps above and giving it a local name. The server template will still be
available on the menu along with your local version.

To delete a local template from your client, you need to go outside the Aleph program.
From Windows Explorer, find the folder C:\Program Files\AL500\Catalog\Template.
Find the template by its file name, highlight it, and delete.
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Creating Authority Records

Deriving a Name Heading from a Bibliographic Record
A name authority record can be created from a bibliographic record that has a new name
heading in the 100 field. The record must be saved to the server in order to perform this
function.

Select Derive new record from the Edit menu.

Select Create a new record in the Authority
DB, based on 100 field, and click OK.

A new name authority record is created in the
LC Authority library, with leader and fixed field
information, the heading in the 100 field, and the
source information in a 670 field.

Add a 010 field with TEMP in subfield a. If a
new LC Authority record is received which
matches the locally created authority, it will
overwrite the local record, and update all
associated bibliographic records if the heading
has changed.

The record may now be completed and saved to the server. 
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Creating Authority Records From Templates
A template may be used to create an authority record. Connect to an authority library.
Select Open template from the file menu. Fill in or edit the required fields and save to
the server. 

Server templates are only accessible in the library with which they are associated. For
example, when in TMN01, only templates for bibliographic records are available when
you open the template menu. In TMN10, you see only the server templates for authority
records.

Because locally created templates are not associated with any specific server, but are
saved as a file on your client, all local templates will appear when the template menu is
opened in any Aleph library. You can always recognize local templates because they
appear in ALLCAPS. However, if you are going to be creating a large number of
templates for your own use, you may want to develop a naming convention to distinguish
between different template types. For example, all bib templates could begin with a B,
holdings templates with an H and authority templates with an A. They will file
alphabetically and you should be able to quickly determine which group of templates to
choose from.

Manual Authority Record Creation
From an authority library, select New record from the file menu. In the Choose record
format window, highlight AU-Authority record and click OK. Fill in the leader and
fixed field information, and then enter the necessary fields. Save to the server. 
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Creating Holdings Records
Before a holdings record can be created, a Bibliographic record must be saved to the
server. To create a Holdings record, choose the Load HOL record from server
command (On File menu – also Alt-F, H or Ctrl-O) while the bibliographic record is
active. (Alternatively, you may click the Catalog HOL button in the Navigation
window.)

You will then see the Holdings List:

Click the Add record button. This will create a minimal Holdings record with at least a
Leader, 008 and LKR field. Currently, the system is set to create the call number in the
Holdings record, if there is one in the Bibliographic record. However, fields chosen to
populate the 852 are hard coded in this order: 099, 098, 090, 090, 092, 096, 050, 055,
050, 060, 070, 082, 086i. In the end, this may not prove very efficient for us and may be
switched off. (We’d welcome opinions on this following your practice.)

Note: At this point, you may choose to use one of the available holdings templates to aid in
creating your Holdings record.
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The LKR field will automatically be filled in with the system ID (subfield b) of the bib
record in the library specified in subfield l. 

Holdings records list the format “HO” in the title bar of the window for the record. This
can help you find the correct window if several are open at once.

Note: When you click Add record the Holdings record is automatically created on the server.
It already has a system number. There is no such thing as a purely local holdings record.
If you make a holdings record in error, you will need to logically delete the record (See
section on Deleting and Suppressing records).

Adding Additional Holdings Records
To add a holdings record when there are existing holdings, click Add record in the
holdings list as shown above, or, from an open holdings record, choose Duplicate record
(Ctrl-N) from the File menu, and change the appropriate fields before saving.

Editing Holdings Records
Select a holding record from the Holdings list by clicking it once. The Edit button is
activated. Click Edit, and the record will open for editing. Save changes to the server.

The Holdings records are identified in the Holdings list by their owner (sub-library and
collection) and by HOL system number. Be careful if there are multiple holdings for a
single collection, and be sure you are editing the correct copy.
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Expand From Template
Templates are available for editing holdings records. To use a holdings template:

1. Create a holdings record by issuing the Load HOL record from server command
from the file menu (or Ctrl-O), and choosing Add record.

You will be provided with a LDR, 008, LKR, and possibly a partial 852 field if there
is call number information in the bibliographic record. 

2. Go to the Edit menu and choose Expand from template (Ctrl-E) to open the menu
of template options.

Four holdings templates have been established, one each for institution codes MnSU,
MnU, MnU-B and MnU-L.

3. Select an option by highlighting it with your mouse and click the Open button.

This will add required fields and default values for the 852 and 940, including the
properly formatted institution code, to the holdings record you've started. 

Note: Do not use the holdings template under the Open templates option to create a new
holdings record. It will lack a LKR field, and therefore will not be linked to any
bibliographic record.

Modify Template for Your Use
If you wish, you may modify one of the templates for your personal use. For example,
you may want your template to include default values for the Sub-library and Collection
you work with most frequently.

To do this:

1. Select Open template from the File menu (or use the templates icon or Ctrl-A).

2. Make the needed modifications.

3. Select Create template on local drive from the File menu.

4. Give the template a distinctive name.

Note: Remember, fixed field values in a template will not overwrite the fields already in
holdings record when you use the Expand from template option.
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Holdings Record Fields Summary
The HOLdings record is edited in the Cataloging Module using the standard Cataloging
menus and function keys. (Refer to “Cataloging Module Commands” in “Aleph Codes
and Lists” for a complete listing.)

The required fields you will need to complete are the Leader (LDR), 008 (Fixed Field
Data), 852 (Location), and 940 (Export Control).

Note: Refer to “HOLdings Record Field Values” in “Aleph Codes and Lists” for more detailed
information on all HOLdings record fields.

Sample monograph holdings record

Sample serials holdings record
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The LKR (linker) field is automatically generated by the system when you create a
Holdings record. Subfield 1 indicates the database of the linked BIB record, and
subfield b gives the system ID number for that BIB record. This field maintains the link
to the bibliographic record. Changing the number will break the link so, unless you are
deliberately moving an entire holdings record to another bibliographic record, you
shouldn’t change this field.

As with bibliographic records, the Leader and 008 fields are entered using a form. The
852 (location information) may be entered directly in the holdings record, or with the
help of a form.

Leader
Only four values are required in the leader: record status, type of record, encoding level,
and item information in record. Default values for serial versus monographic materials
depend on where the Holdings record is initiated. Holdings records created in cataloging
will default to values appropriate for monographs. For serial items, the Holdings record
will be initiated as part of the serials receipting process, and therefore will default to
serial-type values. 

Item information (character position 18) should always be given the value n, since Aleph
uses a separate item record. 

Note: More detailed information on the Leader fields is available in the “HOLdings Record
Field Values” section of “Aleph Codes and Lists.”

Here is an explanation of the encoding level definitions. In most cases, we would use 1
(for monographs) or 4 (for multi-part titles).

Encoding Level

1 Holdings level 1 (Normally used for single-part items.) Minimally must have LKR
for Bibliographic record and Location (852 subfields b and c)

2 Holdings level 2 Requirements for level 1, plus codes in 008 positions 06,12,16,
and 26-31 and when appropriate 007 positions 00-01 (Physical Description Fixed
Field)

3 Holdings level 3 Requirements for level 2, plus summary holdings information,
that is, holdings at the first level of enumeration and chronology in the applicable
866/867/868 Textual Holdings fields

4 Holdings level 4 Requirements for level 2, plus detailed holdings information, that
is, the first and all subsequent levels of enumeration and chronology in either
itemized or compressed form or a combination of the two, in one or more
866/867/868 Textual Holdings fields
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5 Holdings level 5 Requirements for level 4, plus information that identifies a single
physical part in an 852 subfield p or 866-868 subfield a. (Seldom used in ALEPH)

m Mixed level, i.e. Some statements at level 3,others at level 4.

u Level unknown

z Other level Does not meet any of the levels of specificity defined by the other
codes.

008 Fixed Fields (Required)
Fill in character positions (06) Receipt or acquisition status, (12) General retention
policy, and (16) Completeness, according to current policies. Other fields may be left
with their default values. 

Note: More detailed information on the 008 fixed fields is available in the “HOLdings Record
Field Values” section of “Aleph Codes and Lists.”

852 Location (Required)
This field gives the location and shelving information. It can be entered directly in the
Holdings record, or using a Form (Open Form from Edit menu, or Ctrl-F). Using either
method, Help is available to fill in the appropriate values for each field. 

Note: More detailed information on the 852 field is available in the “HOLdings Record Field
Values” section of “Aleph Codes and Lists.”

1st Indicator: Shelving scheme (Required)

2nd Indicator: Second shelving order—Use only if a second call number will be
recorded on the record, e.g. for MLAC materials which are shelved
under a special number but for which we may want to retain the LC
call number.

Subfields

a NUC code (Required)

b Sub-library (Required)

c Collection (Required)

k Call number prefix (e.g. Quarto)

h Classification

i Item part (i.e. Cutter number)
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j Shelving call number or accession number

t Copy number (enter for copy 2 or higher)

l Shelving title

x Nonpublic note

z Public note

For items shelved by a sequential control number or accession number (1st indicator 4),
the number should go in subfield j. All other types of classification numbers (1st indicator
0, 1, 2, 3, 7, or 8) should use h for the basic classification and i for the terminal Cutter
number and year.

Sample of an electronic journal holdings record.

856 (Electronic Location and Access)
In Aleph, 856 fields, which provide a live link to electronic resources accessible over the
Internet, can be placed in either the bibliographic record or the holdings record. 
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URLs for freely-accessible Internet resources will remain on the bibliographic record. For
licensed resources for which there is restricted access, the Holdings record will be used.
When the resource is licensed to be available campus-wide, the Internet version of the
resource will have its own Holdings record, using the Sub-library TINTE. If it is licensed
to a particular sub-library or collection, the 856 will need to go on that sub-library’s
Holdings record.

Note: More detailed information on the 856 field is available in the “HOLdings Record Field
Values” section of “Aleph Codes and Lists.”

866, 867, 868 (Textual Holdings Fields)
These fields are primarily used for retrospective holdings of Serials. They can also be
used to record copy specific notes, such as numbering, inscriptions, or donor information.

Note: More detailed information on the 866, 867, and 868 fields is available in the “HOLdings
Record Field Values” section of “Aleph Codes and Lists.”

866 Basic Bibliographic Unit

867 Supplementary Material

868 Indexes

940 Export Control (Required)
This locally defined field will be used to control record export functions to OCLC and
RLIN, as well as allow for specific types of reporting.

Note: More detailed information on the 940 field is available in the “HOLdings Record Field
Values” section of “Aleph Codes and Lists.”

Subfield a – NUC Code

Input the appropriate institution (NUC) code here without hyphens and in all caps, e.g.
MNU, MNUB, MNUL, MNSU.

Subfield b - Status

CAT Fully cataloged (Most records will receive this code.)

ORD Ordered, but not received (For the most part, we will not be creating
holdings records until the piece is received, so this will be seldom used.)
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INP In process (i.e. has a minimal bib record and is going into long-term arrears
to wait for full-level cataloging)

UPD Updated (Use when updating a holdings record converted from NOTIS. Also
use when updating a holdings record that already has a 940 field with $$b
CAT; retain the existing 940 field and create a second 940 field with $$b
UPD.)

DEL Holdings have been deleted (Use for materials that have been permanently
withdrawn.)

GMN MLAC processors only: Use when any copy that does not belong to the
University of Minnesota—Twin Cities libraries is accessioned.

Subfield c – Status Date

Record the date on which the status in |a was set, using the format yyyy-mm-dd,
e.g. 2002-11-23. 

If you change the status in subfield b, remember to change the status date in subfield c.

Saving Holdings Records
Save the holdings record to the server in the same manner as saving a bibliographic
record. 

There will be the same type of checks done on the record notifying you of corrections
that must or should be made.

Opening Multiple Holdings Records
You may select multiple Holdings records from the Holdings list by holding down the
Ctrl key as you click each selected item. Click Edit record and all the selected records
will open at once. This will help if there are multiple copies in the same location and you
wish to consult the 852 t subfield to choose the correct copy number.
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ADM Records: Creating Publication Patterns

853/853 X Fields

Introduction
The ADM record, a MARC-like record, is managed in the Cataloging module. For
creating captions and patterns from the Serials module, two methods are available. Search
for your title and display it:

� From the Navigation window of the Serials module or the GUI OPAC, click the
button labeled Catalog ADM (the title for the record you wish to work on should be
in the window). This will push the record into the Cataloging module and open the
ADM record for editing.

� From the Navigation Window of the Serial module or the GUI OPAC, click the
button labeled Update ADM. (The title for the record you wish to work on should be
in the window.) Use only for editing existing fields, not entering new fields.

Enter 853 and 853 X fields, save the record to the server and go back to the record in the
Serials module. (Since you started in the Serials module, you should just be able to click
the Serials button on the bottom of your screen or click the Serials icon on the
Application tool bar.) Go to the Publication Schedule window in the Serials client and
click the Sched.Form button. If the system detects the presence of 853 and 853 X fields
in the ADM record, the Preview Publication Schedule window will open automatically
(bypassing the Publication Schedule Form) showing you the publication cycle for the
title.

If you are happy with the contents of the preview, you may click Continue to accept the
caption and pattern the cycle, otherwise, click Cancel and return to the ADM record to
revise the pattern.

Overview of the 853 Field
In Aleph, the 853 field is used to record captions, publication pattern, and punctuation.
To promote consistency in the communication and exchange of holdings information, we
recommend following the ANSI/NISO Z39.71-1999 standard. For captions the standard
states:

Abbreviate captions in accordance with the appropriate portions of Abbreviations
in Appendix B of the Anglo-American Cataloguing Rules (current edition and
revision) …other standards lists or ISO 832 rules. … When two forms of an
abbreviation are provided in a list, use the shorter one (for example, v. not vol).
For example: v.127:no.1 (2000:Jan.)
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Captions Identifying Enumeration Levels

1. Captions (abbreviations or words) that identify the enumeration levels of the serial:

Sub-fields a, b, c, d, e, f are used to specify the captions that identify up to six levels
of enumeration. Typically, only a, b, and c are used, which may, for example,
correspond to volume, issue number and part. In addition to these levels of
enumeration, you may also have an alternative numbering scheme used to identify
issues. The caption for this scheme may be entered in sub-fields g and h.

� A caption such as "v." that identifies the 1st level of enumeration - in sub-field a

� A caption such as "no.” that identifies the 2nd level of enumeration - in sub-field b

� A caption that identifies the 3rd level of enumeration - in sub-field c

� A caption that identifies the 4th level of enumeration (rarely used) - in sub-field d

� A caption that identifies the 5th level of enumeration (rarely used) - in sub-field e

� A caption that identifies the 6th level of enumeration (rarely used) - in sub-field f

� A caption such as "no." that is used as alternative enumeration - in sub-field g

Captions Identifying Chronological Levels

Sub-fields i, j, k, and l are used to specify the captions that identify up to four levels of
chronology. Sub-field i must contain year.

2. Captions (words) that identify the chronological levels of the serial:

� A caption such as "year" that identifies the 1st level of chronology - in sub-field i

� A caption such as "month" that identifies the 2nd level of chronology - in sub-field j

� A caption such as "day" that identifies the 3rd level of chronology - in sub-field k

� A caption that identifies the 4th level of chronology (rarely used) - in sub-field l

Publication Pattern

3. Codes (both alphabetic and numeric) that define the publication pattern:

Other sub-fields in field 853 are used to specify how many issues per volume,
whether issue numbering restarts for each volume or continues ad-infinitum, the
intervals between each issue, and the regularity of the pattern.

� How many numbers to each volume? - in sub-field u (numeric)

� Numbering continuous or restarts? - in sub-field v (alphabetic c or r)

� Frequency - in sub-field w (usually alphabetic; can also
be numeric if sub-field y also used)

� Regularity of the pattern - in sub-field y (alphabetic and/or numeric)
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4. Punctuation such as comma, colon, semicolon, equal sign, forward slash, hyphen,
parentheses, and spaces (^).

For every 853 enumeration and chronology sub-field that you use, you must have a
corresponding 853 X sub-field. Therefore, if you use sub fields a, b, i, and j of field
853, you must use sub-fields a, b, i, and j of field 853 X. These sub-fields, however,
may have a caret (^) to indicate no relevant data.

Overview of the 853 X Field
The 853X field is used to record the numerical starting point (volume no., issue no., etc.)
of the first issue, the chronological starting point (year, month, day, season etc.) of the
first issue, and the publication (expected receipt) date of the first issue.

� The numerical starting point of the first issue, e.g.:

853 X $a (the volume number of the first issue)

$b (the issue number of the first issue)

� The chronological starting point of the first issue, e.g.:

853 X $i (the year of the first issue)
$j (the month of the first issue)

� The publication date (expected receipt) of the first issue -- in special Aleph
sub-field 3.

853 X $3 19980115  (to indicate the 15th January 1998)

853 and 853 X Sub-Fields in Detail

Sub-Field a

Sub-field a is used for the first level of enumeration. Enter the appropriate caption in sub-
field a of the 853 field and the corresponding number in sub-field a of the 853X field.

Example

A publication that has volume numbering beginning with v.1 will have the
caption "v." recorded in sub-field a of the 853 field and the number 1
recorded in sub-field a of the 853X field.
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Sub-Field b

Sub-field b is used for the second level of enumeration. Enter the appropriate caption in
sub-field b of the 853 field and the corresponding number in sub-field b of the 853X
field.

Example

A publication beginning with v.4:no.7 will have the caption "no." recorded
in sub-field b of the 853 field and the number 7 recorded in sub-field b of
the 853X field.

If there is only one level of enumeration and the caption suggests a secondary level of
enumeration (e.g., "no."), enter a carat in sub-field a of the 853 field and enter the caption
in sub-field b of the 853 field.

Example

853

853X

$$a ^ $$b no. $$u 8 $$v r $$c :pt. $$u 2 $$v r
(spaces for readability only)

$$a ^ $$b 7 $$c 1

Whenever sub-field b is used, sub-field u must also be used to indicate the number of
second level units there are to every first-level unit (i.e., how many bs to every a). In
addition, sub-field v must be used to indicate the numbering continuity, where "c" defines
numbering that is continuous over volumes and "r" defines numbering that restarts at the
completion of the unit.

Example

A quarterly publication that begins each volume with issue 1 should have the
number 4 recorded in sub-field u and the letter "r" recorded in sub-field v.

Sub-Field c

Sub-field c is used for the third level of enumeration. Enter the appropriate caption in
sub-field c of the 853 field and the corresponding number in sub-field c of the 853X field.

Example

A publication beginning with v.12:no.1:pt.1 will have the caption "pt" recorded
in sub-field c of the 853 field and the number 1 recorded in sub-field c of the
853X field.

Whenever sub-field c is used, sub-field u must also be used to indicate the number of
third-level units there are to every second-level unit (i.e., how many cs to every b). In
addition, sub-field v must be used to indicate the numbering continuity, where "c" defines
numbering that is continuous over volumes and "r" defines numbering that restarts at the
completion of the unit.
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For a publication that has two parts to each number and 8 numbers to each
volume, you would set up the 853/853X fields as follows:

853

853X

$$a v. $$b :no. $$u 8 $$v r $$c :pt. $$u 2 $$v r
(spaces for readability only)

$$a 12 $$b 1 $$c 1

Example

To read: v.12:no.1:pt.1

Sub-Field d

Sub-field d is used for the fourth level of enumeration. Enter the appropriate caption in
sub-field d of the 853 field and the corresponding number in sub-field d of the 853X
field.

Whenever sub-field d is used, sub-field u must also be used to indicate the number of
fourth-level units there are to every third-level unit (i.e., how many ds to every c). In
addition, sub-field v must be used to indicate the numbering continuity, where "c" defines
numbering that is continuous over volumes and "r" defines numbering that restarts at the
completion of the unit.

Sub-Field e

Sub-field e is used for the fifth level of enumeration. Enter the appropriate caption in sub-
field e of the 853 field and the corresponding number in sub-field e of the 853X field.

Whenever sub-field e is used, sub-field u must also be used to indicate the number of
fifth-level units there are to every fourth-level unit (i.e., how many es to every d). In
addition, sub-field v must be used to indicate the numbering continuity, where "c" defines
numbering that is continuous over volumes and "r" defines numbering that restarts at the
completion of the unit.

Sub-Field f

Sub-field f is used for the sixth level of enumeration. Enter the appropriate caption in
sub-field f of the 853 field and the corresponding number in sub-field f of the 853X field.

Whenever sub-field f is used, sub-field u must also be used to indicate the number of
sixth-level units there are to every fifth-level unit (i.e., how many fs to every e). In
addition, sub-field v must be used to indicate the numbering continuity, where "c" defines
numbering that is continuous over volumes and "r" defines numbering that restarts at the
completion of the unit.
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Sub-Field g

Sub-field g contains alternative enumeration information. In Aleph, sub-field g is used for
continuous numbering only and does not need a corresponding sub-field u or sub-field v.
Enter the appropriate caption in sub-field g of the 853 field and the corresponding
number in sub-field g of the 853X field.

A quarterly has both numbering that restarts and numbering that is continuous
over volumes. The pattern begins with v.1:no.1= no.1; the next volume begins
with v.2:no.1=no.5. The number "1" in v.2:no.1 illustrates numbering that
restarts; the "5" in "no.5" illustrates numbering that is continuous.

In order for the serial to be displayed in the Publication Schedule window as
follows:

Description
v.1:no.1=no.1
v.1:no.2=no.2
v.1:no.3=no.3
v.1:no.4=no.4
v.2:no.1=no.5
v.2:no.2=no.6
v.2:no.3=no.7
v.2:no.4=no.8

Expected Receipt
01/01/1998
04/01/1998
07/01/1998
10/01/1998
01/01/1999
04/01/1999
07/01/1999
10/01/1999

You would set up the 853/853X fields as follows:

Example

853

853X

$$a v. $$b :no. $$u 4 $$v r $$g =no. $$w q
(spaces for readability only)

$$a 1 $$b 1 $$g 1 $$3 19980101

Sub-Field i

Sub-field i is used for the first level of chronology. Enter the appropriate caption in sub-
field i of the 853 field and the corresponding number(s) in sub-field i of the 853X field.

A publication that begins with v.1 (1998) will have the caption "year" recorded
in sub-field i of the 853 field and the numbers 1998 recorded in sub-field i of
the 853X field and would be recorded:

Example
853

853X

$$a v. $$b :no. $$u 2 $$v r $$i ^((year))
(spaces added for readability)

$$a 1 $$b 1 $$i 1998

Note that for readability in the OPAC, we are entering a space between the enumeration
and the chronology, i.e. $$i ^(())
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Sub-Field j

Sub-field j is used for the second level of chronology. Enter the appropriate caption in
sub-field j of the 853 field and the corresponding number(s) in sub-field j of the 853X
field.

A publication that begins with v.3:no.1(1998:June) will have the caption
"month" recorded in sub-field j of the 853 field and the numbers 06 (for the
month June) recorded in sub-field j of the 853X field.

Example
853

853X

$$a v. $$b :no. $$u 2 $$v r $$i ^((year): $$j (month))
(spaces added for readability)

$$a 1 $$b 1 $$i 1998 $$ 06

Sub-Field k

Sub-field k is used for the third level of chronology. Enter the appropriate caption in sub-
field k of the 853 field and the corresponding number(s) in sub-field k of the 853X field.

Example

A publication that begins with v.1:no.1(1998:Jan.15) will have the caption
"day" recorded in sub-field k of the 853 field and the numbers 15 recorded in
sub-field k of the 853X field.

Sub-Field l

Sub-field l is used for the fourth level of chronology. Enter the appropriate caption in
sub-field l of the 853 field and the corresponding number(s) in sub-field l of the 853X
field.

Sub-Field u

Sub-field u is used only in the 853 field and specifies the number of units per next higher
unit. Sub-field u is numeric and must be repeated for each additional level of
enumeration; only sub-fields a and g do not have corresponding sub-field u. The product
of all sub-field u should equal the value of the sub-field w (frequency) less whatever is
omitted in sub-field y. In the case of combined issues, the number in sub-field u should
match the higher issue number.

Example

If nos. 3 and 4 of a quarterly publication are combined into one issue,
sub-field u will be 4.
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Sub-Field v

Sub-field v is used only in the 853 field and contains numbering continuity information.
Like subfield u, sub-field v should be repeated for each instance of sub-fields b through f.
Valid codes are "c" and "r," where "c" defines numbering that is continuous over volumes
and "r" defines numbering that restarts at the completion of the unit.

Note: Sub-fields u and v must be used for each occurrence of enumeration levels 2, 3, 4, 5, and
6 (corresponding to sub-fields b, c, d, e, and f).

Sub-Field w

Sub-field w is used only in the 853 field. It defines the frequency of issues (i.e., the
intervals between issues) and must be present. The frequency will determine the
publication date of all the issues that will be opened from the 853 and 853X fields (unless
they are specified in sub-field y). The publication date of the first issue specified in sub-
field 3 is the starting point for the calculation of issue dates.

The following frequency codes in MARC 21 are valid in Aleph:

Code Description Interval
a Annual 1 year
b Bimonthly 2 months
c Semiweekly Twice a week
d Daily 1 day
e Biweekly 2 weeks (14 days)
f Semiannual Twice a year (6 months)
g Biennial 2 years
h Triennial 3 years
i Three times a week Three times a week
j Three times a month Three times a month
m Monthly 1 month
q Quarterly 3 months
s Semimonthly Twice a month (the 1st day is the day specified in 853X

sub-field 3 and the 2nd day is that + fourteen)
t Three times a year 4 months
w Weekly 1 week

The frequency should equal or exceed the number of issues actually printed. In other
words, if the serial is published eight times a year, bimonthly plus January and July,
assign the frequency monthly to sub-field w and in sub-field y specify that four issues
should be omitted. The frequency may also be recorded as a number, provided that sub-
field is also used.
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Sub-Field y
Sub-field y is used only in the 853 field and is used to qualify or modify the regularity of
the publishing pattern as recorded in sub-field w (frequency). Note that sub-field y is
mandatory for frequency codes c, i, and j, or if the frequency recorded in sub-field w is a
number.

Sub-field y has three elements:

� Publication code
Use o (publication omitted) or p (published).

� Chronology code definition
To indicate a day:

� Use lowercase d if you will be specifying a particular date.
� Use uppercase D if you will be specifying a particular day of the week (such as

Friday).
� Other values are m (month) and s (season).

� Chronology code(s)
If you use lowercase d to represent date, then to record the date, enter the number of
the month (01-12) and the number of the day (01-31). For example, March 15 is
recorded as 0315.

If you used uppercase D to represent day, then indicate the specific day of the week
by its number (0=Sunday, 6=Saturday). This will enable you, for example, to omit
every Friday from the publication schedule.

To record the month, enter the number of the month: 01-12.

To record the season, enter one of the standard two-character codes:
21 (spring)
22 (summer)
23 (autumn)
24 (winter)

Note: Multiple chronology codes should be separated by a comma, and combined issues are
designated by a slash (/).

Examples

Subfield y
pm04,08,12
ps21,23
pd0101,0115,0201,
om06,12
os24
od0615,1215
oD0,6
pm03,06,09/12

Explanation
Published in the months Apr., Aug. and Dec.
Published in the seasons spring and autumn
Published on the days Jan. 1, Jan. 15, Feb. 1, [etc.]
Publication omitted in the months June and Dec. [etc.]
Publication omitted in the winter season
Publication omitted on the days June 15 and Dec. 15
Publication omitted every Saturday and Sunday
Published in the months Mar., June and Sept./Dec.
(combined issue)
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Sub-Field 3

Sub-field 3 is used only in the 853X field and indicates the publication (expected receipt)
date of the first issue of the pattern. The date should be expressed as an eight-character,
numeric code, where the first four characters indicate the year, the next two characters
indicate the month (01-12), and the final two characters indicate the day (01-31).

If you want the following to be displayed in the Publication Schedule window:

Description
v.1:no.1(1998:Spring)
v.1:no.2(1998:Summer)
v.1:no.3(1998:Autumn)
v.1:no.4(1998:Winter)

Expected Receipt Date
03/15/1998
06/15/1998
09/15/1998
12/15/1998

You should enter the data in the fields as follows:

Example

853

853X

$$a v. $$b :no. $$u 4 $$v r $$i ((year): $$j (season)) $$w q
(spaces for readability only)

$$a 1 $$b 1 $$i 1998 $$j 21 $$3 19980315

Note that the date entered in sub-field 3 of the 853X field (19980315) generated an Issue
(expected receipt) date of the fifteenth of the month for each issue.

Sub-Field 8

Sub-field 8 is used only in the 853 field and is used to indicate the numeric starting point
for a new publication pattern.

If a semiannual publication that begins with v.1:no.1(2000:Jan.) becomes a
quarterly beginning with v.3:no.1(2002:Jan.), the 853/853X fields should be set
up as follows:

853 $$a v. $$b :no. $$u 2 $$v r $$i ((year): $$j (month)) $$w f
853X $$a 1 $$b 1 $$i 2000 $$j 01 $$3 20000101

Example

853 $$a v. $$b :no. $$u 4 $$v r $$i ((year): $$j (month)) $$w q $$8 3

Note that the number "3" in the sub-field 8 of the second 853 field instructs the system to
create publication schedule issues on a quarterly basis beginning with v.3.  853 and 853X
fields may be paired, if for example the enumeration changed from monthly to season.
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Using Sub-Fields Together
There are three main fields that are used to identify the item as being a particular issue.
These fields are year (sub-field i), volume (sub-field a) and issue (sub-field b). Note that
"part" sub-field c is not used. (However, if you enter "part," it will be included in the
description field of the issue.)

In the OPAC, the list of issues are sorted according to the year, volume and issue. If there
is additional information, such as part, this is not taken into account in the sort.

Sub-Field Notes

Enumeration Sub-Fields (a-h)

In order to display an enumeration level with no caption, use a ^ sign in the enumeration
sub-field of the 853 field.

For example, $$a ^ will display the volume number with no caption.

To display ordinal numbers, a + sign followed by a ^ sign should be inserted in the
enumeration sub-field of the 853 field preceding the enumeration text.

For example, $$a +^series will be displayed as 1st series, 2nd series, etc.

Chronology Sub-Fields (i-l)

Sub-fields i-l of both the 853 and the 853X contain chronology information.

To suppress the display of the chronology captions, enclose them in parentheses.

Season and month display texts are generated in conjunction with the language code in
position 35-37 of the 008 field of the ADM record. Based on the language code, the
season and month names appropriate to that language will appear in issues description
fields, including diacritics. These fields are not mandatory.

Establishing the Pattern
In order to correctly predict the publication dates of a serial's issue, you have to predict
the publication pattern of the serial, based on previous experience or on published
information.
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Although the Publication Schedule Form can be used to set up a pattern for a serial, we
will not be using this method. Instead we will be using the Aleph 853/853X fields. (Refer
to “853 and 853X Sub-Fields in Detail” in this manual.) 

The definition of the pattern should describe the entire volume, even if the library begins
to receive issues in the middle of the year (or, as in our case, we start establishing
patterns in the middle of the year). If an incomplete definition is given, the system will
not be able to open the pattern for the next year. If issues come in before the start of a
complete volume, you will have to create item records manually (as we may have to do
on converted records). If the frequency of a publication changes, in the middle of the
year, after a pattern is established, you may have to alter the existing pattern until you are
at the beginning of a volume.

To enter the 853 and 853X fields, first retrieve a serial record. Then go to the Navigation
Window and click Catalog ADM. 

Doing so will transfer you to the Catalog module with the ADM record open for you to
edit.
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You may call up Help on Field, which provides information about special codes that
may be entered in each sub-field.

Once in the Catalog module, you may use any templates your library has prepared for
common publication patterns. To merge the fields of a template with the open ADM
record, go to the Edit menu and choose Expand from template.

Select a template from the template list and click Open. The template will then be
merged with the ADM record. Continue editing the ADM record. Save your record to the
server when you are finished.

After you have entered data in the 853 and 853X fields, return to the Serials module and
open the Publication Schedule window by clicking on the Publication Schedule
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Window icon (P on the module toolbar) and click the Sched.Form button. The Preview
Publication Schedule window will open, allowing you to view the schedule information
before it is saved in the Publication Schedule.

If the information displayed is correct, you may accept it by clicking the Continue
button, which will create the list of issues in the Publication Schedule window. 

If the information displayed is incorrect, you may click the Cancel button, return to the
Navigation Window, and click the Update ADM or Catalog ADM button to revise the
fields.

Creating Patterns
There may not be a pattern template in the system for the journal you are working on. For
these occasions, you may have to create a publication pattern. Patterns can be manually
keyed into the 853/853X fields of the ADM record. Follow the procedure as outlined
above to the point of being on the ADM record. Instead of selecting Expand from
template from the Edit menu, simply press F7 to create a new field. Type in 853. While
the 853 is highlighted, select Open form from the Edit menu and fill in the appropriate
fields. Repeat the process for the 853X field. Save your record by clicking on the Server
icon (red arrow). Go back to the Serials module and check your pattern as described
above.
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Arriving Supplements/Special Issues or Combined Numbers
on a Publication Schedule

Supplement/Special Issue

The publication information about one issue can be edited in the Publication Schedule
window of the Serials module in order to record supplements, special issues or combined
numbers.

1. In the Publication Schedule arrive the issue the supplement came with or highlight the
previous issue. Click Duplicate. This will duplicate the Issue form of the previous
issue.

2. In Tab 1 of the Issue Form:

Fill in the date of arrival in the Issue date field and give a description of the piece.

3. In Tab 2 of the Issue Form:

In order for the supplement to display after the issue it is supplement to, a decimal is
placed after the issue number in the Issue Number field.
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4. After the Supplement has been added to the Publication Schedule, arrive the item by
clicking Arrive. The system will automatically open the item during the arrival
process.

Combined Issues

In order to arrive an issue that combines two or more expected numbers, the publication
schedule for the title needs to be altered.

Example: v. 6, no. 1-2

1. Delete the earlier of the numbers from the schedule. In this example, delete the line
containing v.6:no. 1.

2. Modify the line containing the last number so that it includes the previous numbers.
In this example, modify the line containing v.6:no. 2 so that it reads v. 6:no. 1/2 and
correct the issue date, if necessary.

3. By arranging the combined issues in this manner, claims are not sent out for the
earlier number and the issue date and next expected issue stays on track in the
schedule.
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Irregular Serials

The problem with irregular serials is that the behavioral pattern cannot be predicted
accurately. In this case, you have a choice about how to use the Publication Schedule
window:

Option 1: You can create a "rough-cut" Publication Schedule based on an estimate of
the serial's publication pattern. Then, when each issue arrives, you can
modify the Issue Form to reflect the correct issue information. The first
volume's data can be the basis for defining the next volume's Publication
Schedule.

Option 2: For very irregular serials, no publication pattern may be possible. You can
do manual check in by creating an item record for each issue. In this
scenario, there is no Publication Schedule defined at all and fast check in
will not be possible. Refer to your Holdings and Items Manual for specific
instructions on how to create an item record.
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Item Records

Navigating the Items Module
Refer to “Items Module Menus and Icons” in “Aleph Codes and Lists” for menu
commands, icons, and keystroke sequences used for Items Module navigation.

Items Module Windows
Every distinct physical part of a title will have an item record created for it. Monograph
items will be most often created at time of order. Serial item records will be created
automatically, if a title has a publication pattern. If an item record is not created
automatically, you must create one manually. All item records will probably have to be
touched to provide the piece with a local barcode and to check for accuracy.

Navigation Window
When you push from a module to the items module, two windows automatically appear.
The Navigation window is similar to what you see in the GUI OPAC, except that you can
only have one record in the Nav. Map (left side of screen) at a time. 

From the menu bar (between the blue bar and the icons), you can Delete item defaults
set through the item form (under File). Print a label or Change item process status
(under Utilities). Under Retrieve, you can search for an item by barcode or search for a
title through scan or find. You may also Quick Catalog, that is create a brief
bibliographic record in the items module. Under Options, you can Show PC/Server
Transactions and Retrieve Triggers. 

The Quick Catalog function allows you to create a short bibliographic record through
the items module. This function will probably be used mostly by Circulation and, so, will
not be covered here. 

By clicking Show PC/ServerTransactions off the Options menu, you can get a list of all
the transactions that have occurred on a given item record:

Deleting item defaults, printing labels, and deleting item defaults will be covered later in
the manual.
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Item List
You will also see the Item list. This will list all items for the associated bibliographic
record and allow you to manage them. The buttons on the right side of the item list will
allow you to add an item (using Add or Duplicate), change an item form (Modify),
remove an item if it has never been loaned (Delete), look at, but not change an item
(View), look at the item(s) history (Item History, All Item History), see circulation
summaries (Circ. Summary), and performing binding (Bind/Changes) and labeling
(Label) functions. It also allows you to link and unlink items to Holdings records
(Retrieve HOL) and to make broad changes (Global Changes). More about each of
these functions will be discussed later.

The information displayed for each item includes:

Hol+Sublib
+Coll+Call

This column displays the Holdings record number (if the item is
linked to a holdings record), the sub-library & collection, and the call
number (if the item is linked to a holdings record).

This line will not be repeated for multiple items with the same
information (except on long item lists, when it is occasionally
repeated so that the information is easier to find).

Copy no. The copy number will display in this column.

Description The description (enum/chron) information will display in this column.

Status The loan status will display in this column.

Barcode The barcode number will display in this column.

The items may be sorted in various ways (through the sort options box). 
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If the material type in an Item Form is Issue (used for unbound serials), the items will
sort differently than if the material type is anything else.

When you have an Item List displayed, other people may view the Item List, but they
cannot modify any of the item forms. The first person to call up the item list locks other
people out.

Item Form

If you click Modify on the Item list, you will see the item form for the currently
highlighted item. The item form is also accessible from other modules.

Clicking on Refresh will populate fields, once you have linked to a Holdings record and
show any other changes you have made.

Note: All changes you make in the items module are made to the server by clicking Update.
This is different than the cataloging module where you need to specify that your changes
are saved to the server.

When you click Save defaults, the information entered in certain fields of the current
form will be automatically entered in every form you open from then on (or until you
save another set of defaults). All the fields that were filled in on the record are saved and
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copied to all records. If you want to delete the defaults, simply click on the File menu and
click again on Delete item defaults.

If you wish to see an item’s circulation history, click on Circ. History and the number of
holds, number of photocopies, and total number of loans will appear. Alternatively, you
may view an item’s circulation history from the Item List, by highlighting the item you
desire to view and click on Circ. History. 

The item form will be locked for 100 seconds for you to fill out the information. During
this time, other users may read but not edit any information on the same item record.
Once that time has expired, you must save the record to the server and open it again in
order to re-lock it.

Creating Item Records

Automatic Creation in Acquisitions
If a checkmark was placed in the Create items field of the Order Form window in
acquisitions, the system will automatically create the proper number of item records for
the number of units indicated. The system defaults to a checked value.

You can view items that were created from an order by bringing up the Order List
window for the title, highlighting the appropriate order and then clicking on the Copies
button for monographic and standing orders.
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With automatically created item records, some information, such as sub-library,
collection, and material type, will be filled into the Item form. Double-check this
information for accuracy.

Manual Item Record Creation
To create a new Item record, click Add on the item list window. This will bring up a
blank Item form. You can also highlight an existing item and click Duplicate. Be sure to
change all the appropriate values.

If there is a holdings record for the item, information from the holdings will override any
information entered in the item form once the holding and item records have been linked,
unless the box for ‘Temporary Location’ is checked. (This will be discussed more
later).

Item Form Tabs and Fields
Whether you are creating a new item, modifying an item or duplicating an item, you will
use the Item Form, which has four tabs: 

� General Information (1)

� General Information (2) 

� Serial Information (3)

� Serial Level (4)
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General Information (1) Tab

Barcode: This number is supplied by the system when the item is created
automatically. It can be changed, but must be unique. If you leave this
area blank, the system will insert a barcode when you click Refresh or
Update.

Refer to “Smart Barcode Slips” in this manual for procedures on using
macros for smart barcode slips.

Sub-library: The sub-library will be automatically entered from the appropriate
holdings/order, but it can be changed, if the item is to have a temporary
location. Clicking the right arrow button will give you a list of sub-
libraries. The sub-library code may also be keyed manually.

Refer to the Sub-Library Codes listing in “Aleph Codes and Lists” for valid
values.
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Collection: The collection will be automatically entered from the appropriate
holdings/order, but it can be changed, if the item is to have a temporary
location. Enter the code for the appropriate collection or click the right
arrow button to choose from a list. Only the collections valid for the sub-
library selected above will appear.

Refer to the Collection Codes listing in “Aleph Codes and Lists” for valid
values.

Call Number Type: Enter the code for the Call Number type or click the right arrow button to
choose from a list of call number types.

Temporary
Location:

If you need to change an item’s location temporarily, e.g. reserve, change
the sub-library and/or collection, and other fields as appropriate (note the
item status especially), and click the Temporary Location box. Clicking
this box holds the location change until the box is clicked again. When the
check is ‘clicked out’ of the box, the original location will automatically
return to the Sub-library/Collection areas when Update is clicked. You will
have to manually change the item status back to its original value.

Sample temporary location, where the latest ed. is on reference

Call Number: Enter the Call Number manually, if needed, or click the right arrow
button to choose from a list of previously used call numbers.

2nd Call Number
Type:

Use this field to define the Second Call Number type (used only for MLAC
numbers here).

2nd Call Number: Enter the Second Call Number (used only for MLAC numbers here).

Copy number: Enter copy number, if it is copy 2 or higher. (0 indicates a single copy.)
Copy numbers (0 is the system default) do NOT carry over from the
Holdings record, so it must be entered manually.

Enum.level.1
(a)(vol)

Enter first enumeration. Type only the number. The caption is not
necessary, e.g. v.1, bd.1, t.1.

Enum.level.2 (b) Enter second enumeration. Type only the number. The caption in not
necessary, e.g. no.2, hft.2
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Description: The description field is used for the full enumeration of serials. Input the
enumeration as it should appear in the Web OPAC, e.g. v.1:no.1 (2002
Jan.). To make it easier for you to consistently enter the same text (which
is necessary to ensure that this function works properly), a list of
previously used descriptions is available by clicking the right arrow
button to the right side of the field. Make sure to carefully edit this
information to reflect the item in hand. In addition, it is worth noting that
the description text is displayed in the OPAC in alphanumeric order.
Note: For standing orders and serials, the initial item record description
field will include a volume number and a note concerning future volumes
(e.g. Vol.2 and future volumes). Make sure to correct this to reflect the
item in hand.

Material type: Carefully check this area. The system will default to the most common
material type for the sub-library. Make sure the correct code for the
material type is keyed in or click the right arrow button to choose from a
list.

Refer to the Item Material Type Codes listing in “Aleph Codes and Lists”
for valid values.

Item status: Carefully check this area. The system will default to the most common
item status for the sub-library. Make sure the correct item status is keyed
in or click the right arrow button to choose from a list. (This status will
help determine the circulation period and will become active whenever
there is no Item Process status filled in.)

Refer to the Item Status Codes listing in “Aleph Codes and Lists” for valid
values.

Item process
status:

Enter the code for the Item Process status or click the right arrow
button to choose from a list. Although some process statuses are created
/ modified automatically, you may change the Item Process status here
and you MUST remove this status when it is no longer needed.

Refer to the Item Process Status Codes listing in “Aleph Codes and Lists”
for valid values.

Hol Link: If a holdings record is created prior to the item record, the holding number
will be entered by the system. If a Holdings record is created after the
item record, link the item record to a holdings record, click the arrow and
select the correct holding and holdings record number will be entered in
the field. If a new holdings record is needed, leave this field empty. Click
the Refresh button and information from the Holdings will populate the
Item record. 

"Hol link: If the sub-library that the order is for already has a holdings
record, the item can be linked to it from this field. If a new holdings record
is needed, leave this field empty."
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General Information (2) Tab

OPAC note: Use for notes that should display to the public. (The Web OPAC team has
found no examples for this and may NOT include the column in the Web
display.)

Circ. Note: These are notes for the use of circulation staff or to alert circulation to
some feature of the piece, e.g. a CD in the back pocket.

Internal note: The text entered here is item specific and will appear only on this form
and is intended for library staff only. (Note can be up to 200 characters.)

Order number: The order number will be entered by the system from the order. However,
you may change the order number by entering the correct order number
in this field or you may select the order number from the Order Index
List by clicking the right arrow. If, for some reason, there is no number,
find the appropriate order number and type it in.

Invoice Key: If an invoice has been created for this order, you can add the Invoice
information by clicking the right arrow. The Invoice List will be displayed.
By clicking the Select button, the invoice information will be inserted into
the Invoice Key field of the Item Form.

Invoice Note: This is a read-only field. This note comes from the Note in the Line Item
of the Invoice.
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Inventory number: Do not use.

Inventory date: Do not use.

Last Invent. Report
date:

Do not use.

Price: Read only: This is filled in by the system. To compute the price, the
system uses information that was entered in the Order Form and divides
the local price by the number of units.

Statistic: Do not use at this time.

Open date: Read only: This is filled in by the system. This is the date that the Item
was created.

Update date: Read only: This is filled in by the system. This is the date that the Item
was last updated.

Serial Information Tab

Schedule: This is the line number in the Publishing Schedule in the Serials module.
It is filled in automatically by the system if the item has been opened in
the Serials module.
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Subscription no: This is the sequence number on the Subscription List in the Serials
module. It is filled in automatically by the system if an item was opened in
the Serials module.

Pages: Optional: Enter the pages included in the issue.

Description: The description field is used for the full enumeration of serials.
Information in this field should move automatically from the General
Information 1 tab. In the event it doesn’t, input the enumeration as it
should appear in the Web OPAC, e.g. v.1:no.1 (2002 Jan.). To make it
easier for you to consistently enter the same text (which is necessary to
ensure that this function works properly), a list of previously used
descriptions is available by clicking the right arrow button to the right
side of the field. Make sure to carefully edit this information to reflect the
item in hand. In addition, it is worth noting that the description text is
displayed in the OPAC in alphanumeric order.

Issue Date: This is the publication date of this issue. If publication patterns are in
force, this area will populate via predictive check-in. However, if there is
no predictive check-in for the title, or one library is using predictive check-
in and the other is not (e.g. for annuals), the non-predictive check-in
library must fill this field in manually.

Exp. Arrival Date: This is the expected date of arrival of the issue, taking into account the
delay between the issue date and the date of receipt. This area should
populate via predictive check-in, if there is a publication pattern for the
title. However, if there is no predictive check-in for the title, or one library
is using predictive check-in and the other is not (e.g. for annuals), the
non-predictive check-in library must fill this field in manually.

Arrival Date: This is the actual date on which the item was received. This area should
populate via predictive check-in, if there is a publication pattern for the
title. However, if there is no predictive check-in for the title, or one library
is using predictive check-in and the other is not (e.g. for annuals), the
non-predictive check-in library must fill this field in manually.
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Serials Levels Tab

The Serials Levels tab is shown in the illustration below. The fields relate to the various
numerical and chronological designations of the serial. If predictive check-in is being
used, much of the information in tabs 3 and 4 will be filled in automatically. For manual
serial item creation, use a previous item record for the same location, if one exists, and
duplicate. For new serial titles, item records will have to be created from scratch. Fill in
the appropriate fields on all tabs.

The Enum levels will populate from the General information tab. However,
Chron.level.1 must be filled in with only the year of the issue.

After filling in the Item Form, click the Update button to activate changes/creation.
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Duplicating an Item
To duplicate an item, open the item list for the title. Highlight the item you wish to
duplicate (the most current item would be the most likely candidate) and click on the
Duplicate button. This action will fill in a new item form exactly like the one you just
duplicated. Edit the record according to the information available on the item in hand.
Modify the following data on the first General Information tab, as needed: barcode,
enum levels, description, and item status, if necessary. Add other information, such as
circulation and OPAC notes to the second General Information tab.
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Modify the description field of the Serial Information tab, as shown.

The Serials Levels is shown below. Modify and/or add information to this tab as needed,
such as the Enum.level.1 and Chron.level.1 fields. Clicking on the Refresh button will
allow you to see the information you have modified. When you are satisfied with the
information, click Update, to save the changes.

Creating Spine Labels
Labels are printed in the Items module. There are two methods:

Method #1: Clicking on Utilities (in the bar at the very top) and selecting Print
Item Labels. The system will display a window into which several
barcodes can be read.

Method #2: Highlighting the item in the Items List and clicking on the Label button.

Method #1
From the Utilities drop down in the Items module, choose Print Item Labels.
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Barcodes may be scanned or typed in (press Add after each barcode, if your scanner does
not ‘enter’ automatically). You may scan in as many barcodes as you like (the limit is
greater than 50). Click on Print. The print function should bring up your Notepad
session, with the call numbers listed.

Edit the call numbers, as
necessary, per unit policy.
Select and click Print, from
the File pull-down menu and
then click OK on the print
dialog box. This action causes
the labels to print.

Method #2
To print one label at a time, highlight the item on the item list and click on Label. The
call number will come up in Notepad Print as directed above.



University of Minnesota Aleph Cataloging Manual Page 87
Issue Date: 05-15-2002 Creating and Editing Cataloging Records
Revised Date: 03-25-2003 Item Records

From: 403 Holdings and Items Manual

Binding
The binding process for Aleph is also managed in the Items module. On the Items List
screen click on the Bind/Changes button and the Items List for Binding pops up. This is
the binding screen. It is divided into two parts. On the left side select the issues, for
binding, and move them to the right side of the binding screen via the right arrow.

Click on Bind and a new item form will be displayed. Edit this new record as needed,
especially note the Enum.level.1 and the Description. Click Update. The individual item
records are preserved in the Item History and will not display in the OPAC. A new
Material Type of ISSBD is system defined for Bound volumes.
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Updating Item Process Status
To update an item’s item process status quickly, click on Change item process status in
the Utilities menu of the Items module. Choose an item process status from the drop
down menu that appears when you click the right arrow. Alternatively, the process
status code may be keyed in manually.

Linking Holdings
If the item(s) is not linked to a holdings record, you will need to link them to a Holdings
record. Click Retrieve Hol from the Item list. You will see a list like this:

All of the Holdings records will appear in the list of Holdings. Pay attention to the
Holding record number when cataloging so that you can distinguish it in the list. Select
the appropriate Holding record. Click Link to Item. The item list will now look like this:
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To unlink an item from Holdings, you can reverse the process by clicking Unlink Item.

Global Changes
Click Global Changes from the Item List to make changes on a selected set of items.
The Global Changes will appear. Changes can be made on all items in the list or on a
group of items selected according to defined criteria. While the following example shows
a change from TBIOM to TEFW for a single volume, this process may be most efficient
for moving multiple volume sets from one sub-library/collection to another.
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Smart Barcode Slips
Smart barcodes on slips of paper are needed for certain types of materials. Macros are
used to generate these smart barcodes. Contact Michael Johnson (m-john1@tc.umn.edu)
for your initial setup to work with these macros. Once you are set up, follow these
procedures.

Have the following files opened:

� scargbarcode.xls
Note: This file contains macros, and a warning message will pop up when you open

it. You can click either Disable Macros or Enable Macros.

� scarg.mdb

The Excel sheet should have the first unused item ID with the focus, that is, the box
selected.

In Access:

� Click to close the popup intro screen.

� Click on the Tables tab.

� Double-click ItemInfo to open the table.

� The cursor in Access should be at the start of the first field of the new record.

Procedure
1. Store information.

� Run the macro “Copy to Access” from the Cataloging module, with the particular
record to be retained having the focus.

� You will be prompted to enter the Bibliographic ID.  It can be found as part of the
title bar for the record.

� You will then be prompted for a sub-library and collection.  Enter this information
without a comma and in lower-case. (The macro will automatically change it to
upper case.)

Note: For speed, each user can be set up with a default location code that will be
used if they just press [Enter] without entering information.

� The macro copies the record and analyzes it internally, extracting the information
it needs.  The macro will switch to Excel, save the current item ID, delete it from
the spreadsheet, and move the focus down to the next item ID.  It then moves to

mailto:m-john1@tc.umn.edu
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the Access database, and stores the record ID, location code, call number, title,
author and item ID.  Upon completion, the cursor will be at the starting field of a
“new” record.

2. Transfer item ID to Item Record.

� In Access, make sure that the cursor is in the first field of the new record.

� Complete all work on the item record before running this macro.  Specifically,
any copy number or description that is to be extracted for the smart barcode
should already on the item record, the record updated and then closed.

� In the Items module, highlight (but do not open) the specific item record that
needs updating.

� Activate the macro “Update Item Record.”
The macro will open the item, pull the item ID from Access, return and put the
item ID in the record, and then extract copy number and description and return
those back into the Access database.

3. Print barcodes.

� Switch to the Access database.

� If the table “ItemInfo” is displayed, click on the box with an “x” to close it.

� Click the Reports tab.

� Highlight the report named “PrintMe.”

� Select Print under file, or click the Print button on the toolbar to send the print
job to the printer.

� Return to “Tables” and “ItemInfo,” putting the cursor in the first field of the new
record.

� If barcodes printed without error, you can delete all previous records by selecting
(clicking the row headers in front of each record), and pressing the [Delete] key.

Warning:
This cannot be undone, so you should be confident that you no
longer need the given records.

� Click through the confirmation screens.

� After deletion, or anytime you are finished working in Access, the cursor should
be returned to the first field in the new record.

4.  Close spreadsheet.

� Each time the Excel spreadsheet is closed, you will be asked whether you wish to
save the changes. Always click Yes.
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Monographs
Monograph Copy Cataloging Workflow

Monograph Copy Cataloging Workflow

Receive
monograph

Find & display
record in Aleph

Check copy against
piece, edit as 

needed

Need auth
work?

Yes

No

Click
Update

Send to
marking

*The linking process is now complete,
but the changes will not be reflected until
you call up the item & click Refresh.

**If scanner is programmed  to enter
after scan, make wanding barcode the
last step on item record.

Additional
volumes?

Yes

No

Edit fields as
needed: Copy #,

 Material type,
Item status

Edit HOL
as needed

BIB RECORD:

Select item in
list & click
Duplicate

Save bib record on
server & local drive

To
Authority 
Workflow

Multi-
volume?

Yes No

Save
HOL to
server

Edit 866; add
867, 868

as needed

Multi-
volume?

Yes

No

Enter volume
designation in
 Description

Item has
pieces?

Yes

No

Indicate in
Circ. Note,

e.g., 2 pieces;
CD and text

Gift?
Yes

No

To Gift 
Workflow

Need better
copy?

Yes

NoTo Overlay
Bib Record 

Workflow

Check error msgs
& correct or override

as needed

Push to
Items module

Check Item List
Hol+Sublib+Col+
Call field for Hol

number, indicating
that Item is linked

to HOL.

ITEM RECORD(S):
•For LDR & 008, click on field, then from menu
click Edit/Open form to display/edit.
•It is not necessary to delete 9XX fields or SID.

HOL RECORD:

From menu click Edit/Expand
from template. Select the

appropriate hol.mrc (local)
template & click Open

HOL fields to edit:
•LDR (different for multivolume)
•008 (different for multivolume)
•852: call#, remove |x routing data
•940: |b, |c

Hol#
present/Item

linked to
HOL?

Yes

No

Click Retrieve HOL
on Item List

Select correct
holdings record &
click Link to Item*

Route
for auth work,
call #, etc.?

Change
Item

process
status to

blank (not
 in process)

Leave status
at in process

& add
appropriate

Internal
note code

Yes No

Edit fields in
new item as

needed

Click
Modify

Click
Refresh

System
supplies fields

based on
first item

If dummy barcode
is present, wand

in real one**

Last updated 12/4/02

System
supplies 852 subfields

& 940 with |a

NOTIS
converted

order?

Yes No

Click Add
on HOL

list

Select HOL
record in list
& click Edit

Click File/Load HOL
record from server
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Streamliners Policy: Guidelines for Editing Copy
Cataloging

The following recommendations are meant to apply to the copy cataloging of most books.
In a few instances, some special editing may be done for certain categories of material.
They may also be applied to copy cataloging for other formats, according to the appendix
noting special circumstances. (Appendix under construction.) 

General Principles
Because we assume that the copy we use from other libraries has been cataloged
according to national standards, we do only a minimal amount of editing of bibliographic
records.

We are concerned primarily with user access, not descriptive details, except to the extent
that they affect access.

We are not responsible for the entire content of the bibliographic record when accepting
another library's copy. The presence of 040 |d MnU (MnSU, MnU-B, MnU-L) merely
means that we have changed something on a record, not that it has been brought up to
AACR2 standards or that everything on it is perfect. Thus, we do not upgrade pre-
AACR2 cataloging except forms of names and series headings or other discrepancies that
would inhibit access. If a record is missing information, we enter it according to current
guidelines, but we do not go back and verify or correct the format of information entered
by other catalogers.

We are, however, responsible for doing authority work according to our established
guidelines. Our guidelines are designed to ensure that needed references will be added to
the database either by catalogers or by Database Management, with a minimum of
duplicate effort between the two. (Refer to “Authority Work for Copy Cataloging” in this
manual.)

We are also responsible for holdings information on records.

Access Points and Description
[Where treatment of CIP copy differs, it is noted in brackets following that for completed
copy]

Access points should agree with what is suggested in the descriptive portion of the
cataloging copy and the item. When checking for access points, look at only the
descriptive portion of the record and item t.p., t.p. verso, cover, and series t.p. It is not
necessary to examine preface or introduction.



University of Minnesota Aleph Cataloging Manual Page 95
Issue Date: 02-19-2003 Cataloging Procedures
Revised Date: Streamliners Policy: Guidelines for Editing Copy Cataloging

Author: Leslie Bohm

Do not delete existing access points, even if they seem extraneous. Add access points
only if they are "glaring" omissions, e.g., a joint author on title page was omitted, a series
was omitted (if in your judgment item is still the same edition), a differing spine or cover
title was omitted.

[CIP: Information of "bibliographic significance" on the t.p. must be covered somewhere
in the record's descriptive fields. If cataloger is not changing the description, access
points can usually be accepted as they are. But if names or titles are added to or deleted
from the description, corresponding access points must be added or deleted.]
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Streamliners Cheat Sheet: Guidelines for Editing Copy
Cataloging

Editing Bib Screen
1. To check LDR, click on the field and press [Ctrl-F] to bring up form. Check only the

following five fields:

Tag Field Name Most Common Values
05 Record status n

c
p

new
corrected
increase in encoding level from pre-publication

06 Type of record a printed language

07 Bibl level m monograph/item

17 Encoding level ^
4
8

full
core
pre-publication

18 Descriptive cataloging a
i

AACR2
isbd

 Click on Help for other values.

2. To check 008, click on the field and press [Ctrl-F] to bring up form. Check only the
following four fields:

06 Type of date

07-10 Date

15-17 Publication place

35-37 Language

Click on Help for field values.

3. Variable fields:

040 Add $$dMnU (MnSU, MnU-B,MnU-L) when making substantial change to
record.

[CIP: always add $$d]
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1XX/
7XX

Do authority work as required.

� Access points required by the statement of responsibility on the item
and in accord with the “rule of 3” should be present.

� Do not be concerned whether an access point is tagged 1XX or 7XX as
both are searchable.

245 � Verify accuracy of second indicator (non-filing characters).

� Verify that title proper ($$a) and subtitle ($$b) are correct and complete.

[CIP: same as completed copy, but also verify that statement of
responsibility ($$c) matches t.p. except where the following cataloging
principles apply: “rule of 3,”  “bibliographic significance” of responsible
parties named, and bracketed information taken from source other than t.p.]

246 Use for most added title access points, unless the title is of an analytical
nature, in which case the 740:X2 coding is appropriate.

250 Should be present if item contains a true edition statement.

260 � If you are confident that copy corresponds with the item in hand, accept
260 as is.

� As long as the form or division of publisher’s name in the 260 field of
copy is somewhere in the item, accept it.

� If distributor is on copy, accept; if not, do not add.

� If publication and copyright dates differ, do not add copyright date; it is
not necessary to add “c” to copyright date.

263 Not applicable to completed copy.

[CIP: Always delete.]

300 � Completed copy needs subfields $$a, $$c, and $$b if applicable.

� Do not count pages except for obvious errors, e.g. 160  vs. 610 p.

� If item contains any illustrations, add $$b ill. with no further
elaboration.

� Do not measure item unless size is borderline octavo/quarto/folio.

� Accept 300 as is on pre-AACR2 copy.

[CIP: Complete subfields $$a, $$c and $$b if applicable.  Ignore numbered
or unnumbered plates unless they represent a substantial portion of the
item.]
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4XX/
8XX

Do authority work as required.

We trace all series, so there should be either a 440 or a 490 with a subfield 1
and accompanying 8XX field, whenever a series is present.

[CIP:  Check for series information that may not have appeared on item
prior to publication]

5XX Accept as is.  Make sure that access points suggested by 5XX notes are
present in the record.

[CIP: It is important to look for new information, e.g., bibliographies,
indexes, earlier editions with different title requiring an additional access
point.]

6XX Do authority work as required for 600, 610, 611.

At least one 6XX with second indicator 0 required, unless item is a work of
literature by a single author.   (If subject missing, pass on to original
cataloger.)

9XX Accept as is.

4. Save to server.

Creating Holdings Record
1. From File menu, click  Load HOL record from server [Ctrl-O].

2. Select HOL record in list & click Edit; or if no record in list, click Add.

3. From Edit menu, click Expand from template [Ctrl-E].

4. Choose appropriate template, e.g. holMnU.mrc (Local) and click Open.

5. Open LDR--click on the field and press [Ctrl-F] to bring up form.

Correct values for single-part item:

05 n
06 x
17 1 (encoding level)

18 n

6. Open 008 form—click on field and press [Ctrl-F|` to bring up form.

Correct values for single-part item:

06 2 complete

12 8 permanently retained

16 4 not applicable, single-part item
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7. Complete 940 field.

$$b CAT
$$c YYYY-MM-DD (e.g. 2003-01-15)

8. Complete 852 field.

Most common values:

First indicator  (0=LC, 1=Dewey, 3=SuDoc, 4=local,5=title)

$$a MnU (MNSU for St. Paul)

$$b TWILS (TSCI, TMAGR, etc.)

$$c GEN, etc.  N.B.  Verify that subloc matches subloc in book.

$$k Type in Quarto or Folio for oversize items.

$$I Insert x after Cutter if member copy.

9. Save to server.

Creating Item Record
1. From Holdings Record Push to Items.

2. Click Modify if Item is linked, then skip to step #6. (Refer to “Linked and Unlinked
Items” in this document for more information.)

3. For unlinked Items*, click Retrieve HOL on Item List. (Refer to “Linked and
Unlinked Items” in this document for more information.)

4. Select correct holdings record and click Link to Item.

5. Click Modify and then Refresh.

6. Click General info tab 2 to clear previous tracking notes or add required notes.

Circ. note: Enter pieces here.
Internal note: Enter tracking information here.
Order number: Enter order number for cat seps here if not present.

7. Click General info tab 1.

8. Edit fields as needed.

Most common values:

Item process status blank=not in process (if not routed for aut or cls)

Item status 01=Regular loan
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Material type BP=Book (Print)

Copy number 0=1

Call number type 0=LC

Note: If Call number type is blank, go back to Holdings
record and make sure you have coded 852, first indicator.

9. Wand in barcode if dummy barcode appears.  If your scanner is not programmed to
enter after a scan, you will need to update.
If item has not been barcoded (Wilson procedure)…

� For paperbacks--place red barcode at the top of the page on last page of the book.

� For hard covers—place white barcode at top of back cover.

Finishing Up: Handing Off Classification, Special Shelflisting
Questions or Authority Work

1. Deliver books with classification or authority questions to your team’s designated
shelves.

2. Tracking location of items is noted on Item record in an Internal note (found on
General Information tab 2). Refer to “Tracking Codes (MAC Wilson)” in “Aleph
Codes and Lists” for more information.

3. These items will have item record status changed to blank (not in process) by those
doing classification and authority work.  They will also delete tracking code
information and click Update.

Record Statistics

Supplementary Information

Rule of Three (AACR2r 1.1F5)

If a single statement of responsibility names more than three persons or corporate bodies
performing the same function, or with the same degree of responsibility, omit all but the
first of each group of such persons or bodies. Indicate the omission by the mark of
omission (…) and add et al. (or its equivalent in a nonroman script) in square brackets.
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Bibliographic Significance (LCRI 1.1F1)

Guidelines for Recording Statements of Responsibility
To achieve the objective stated above, observe the following guidelines:

1)  Include in statements of responsibility the names of those whose contributions
are judged to be of bibliographic significance if such names appear prominently.
Judge bibliographic significance as follows:

a) Editors.  Bibliographic significance in this context encompasses that portion
of the definition of the term "editor" in the glossary stating that the editorial
labor includes "… revision (restitution) or elucidation of the text, and the
addition of an introduction, notes, and other critical matter."

Excluded from this category and, therefore, not candidates for transcription
are credits for "in-house" editors, editorial supervisors, publications editors,
managing editors, photo-editors, sponsoring editors, and the like.

b) Others.  Bibliographic significance in this context equates to the definition of
statement of responsibility in the glossary, namely "… persons responsible for
the intellectual or artistic content of the item … or performance of the content
of the item."  Excluded from this category and, therefore, not candidates for
transcription are statements of technical credits, often performed by in-house
staff members of publishing firms.  Note that statements of technical credits
are often elsewhere than the chief source. 

2)  If there is doubt whether a statement is of bibliographic significance, proceed as
follows:

a) If the statement is in the chief source, transcribe it.

b) If the statement is not in the chief source, do not transcribe it.

True Edition Statement

In foreign imprints, an edition statement is often a printing.  

Foreign publishers of belles lettres, listing a long publication history of the title, and
using edition and printing interchangeably, pose a particular problem. Suspect that the
"edition" statements are really only printing statements, and therefore they should be
disregarded. As a general practice consider this principle: Use what information is
known, however the knowledge comes to you in the course of your work.
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Quarto/Folio

Folio Over 31 cm.

Quarto Over 27-31 cm.

Quarto Over 26-31 cm. (MAC Wilson only)

Note: These are actual measurements.  31 cm. would still be a quarto.  31.1 centimeters would
be transcribed as 32 centimeters (always rounding up.)—and would be a folio.

Linked and Unlinked Item Records

In the Item List display, the first column on the left is Hol+Sublib+Coll+Call. The first
element in Item display should be the holdings number. If it doesn't start with a number,
but starts with the sublibrary (TWILS or whatever), then the item is not linked to a
holdings.

Item Status

Item status is not always Regular loan.  TWILS,REF; TWILS,BUS; TAND and its
sublocs are all 02 (non-circulating).  Be aware of exceptions in areas for which you
catalog.  Refer to “Collection Codes” in “Aleph Codes and Lists” for default Item
statuses.
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CJK Addendum to Streamliners
Additional items to consider on CJK records:

� Add parallel character fields for access points, if missing from record.
Parallel character fields, whenever appropriate, are a requisite for access points in a
full standard RLIN CJK records. 

� Add aggregation of Roman fields and spacing between groups of characters, if
missing.  Spaces between groups of characters need to be non-Roman spaces,
rather than Roman spaces. 
The spaces are necessary for keyword searching. 

� Remove a centered dot in the record and replace it by a space or a comma plus a
space as appropriate. 

The centered dots do not count as spaces between words and the RLIN system does
not deal well with long strings of characters without spacing. 

� Change any 490 field with a first indicator set to zero by LC, to a 440 field with
second indicator set to zero, so they will index in LUMINA™.
This is especially important on the analytic entries for the big Chinese sets, so that
users can call up all the analytics in the set by series title for browsing. 

� Recognize problems with older series entries and update when "fix" is clear cut -
otherwise pass to original cataloger 

� Index under title if it had been previously indexed under compiler 

� Standardize series form if multiple forms have been used on the various analytic
records of large sets 
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Call Number Guide for Copy Catalogers

Approved Call Numbers
Use these call numbers “as is”:

� Call number from 050 field

� Except when second indicator is 4.

� Except when call number is one of types listed below.

� PZ1-PZ4 call numbers from any source, unless cataloging children’s
literature.

� Z call numbers over Z1200 from any source, for those locations that use
alternate class numbers for bibliographies.

� Set call numbers for works we are classing separately.

Use these call numbers by changing or adding date:

� LC-assigned call number for another edition.

� LC CIP call number when date does not match date of publication in the 260 field.

Use these call numbers adding x to final cutter, and a date (if not already present):

� National Library of Canada call numbers (except FC, K and PS80001-8599).

� Found in 055 field  (St. Paul Campus does not accept these).

� Found in NLC CIP data in book (St. Paul Campus does not accept these).

� RLIN and OCLC member library call numbers (except those mentioned below under
DO NOT USE).

� Found in 050: 4.

� Found in 090 or 950 fields.

� Found in RLIN CALL and LCAL fields.

Do Not Use the Following Call Numbers
� RLIN/OCLC member call numbers containing a .X1 Cutter.

� Member library numbers containing a triple Cutter (except in class G where they are
valid in certain cases).

� Call numbers in K classes (law)  unless assigned by LC, GPO, Harvard Law, Cornell
Law or MnU-L; send to Monographs Cataloging Coordinator.
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� National Library of Canada (NLC) call numbers FC, K, and PS8001-8599. (These
may be followed by alternate call numbers which are usable.)  N.B. Frequently an
online record may have an incomplete 055 (class number only) or lack an alternate
055, but the complete or alternate number will be found in Canadian CIP copy in the
book.

� Call numbers from CIP copy other than LC or Canadian (British, Russian, etc.)
British CIP call numbers are found in 050: 4: when 040 |a is Uk (RLIN) or UKM
(OCLC).

� PZ call numbers from any source unless cataloging children’s literature.

� Z call numbers over Z1200 from any source, for those locations that use alternate
class numbers for bibliographies.

� Set call numbers for works we are classing separately.

� Other strange-looking call numbers such as those lacking valid LC class letters or
having an abnormal pattern of class number and Cutter numbers.

Example: 950: : |a FA .7 |b .64

Locations Using Alternate Bibliography Numbers
� TAND and its sublocs, excepting TAND,CLRC and TAND, IHRC

� IT Libraries (TARCH, TMATH, and TSCI)

� St. Paul Campus (TMAGR, AHL, TEFW, TFOR, TLAKE,  TPP, TVET)

� TMUSI

� TWILS and its sublocs, excepting TWILS,EAS

Bibliographies with numbers under Z1201 will be classed in Z.

Bibliographies with numbers Z1201 and up will normally be classed with the subject
and not in Z.

Locations Using Z Schedule for Bibliographies
� TAND,CLR

� TAND,IHRC

� TJOUR

� TWILS,EAS

Note: Beginning October 2002, Don Johnson requested that Ames (TWILS,AME)
bibliographies be classed in the alternate scheme, i.e., with the subject.
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Call Number Dates
� Dates will be added to all locally assigned call numbers (with x) and to call numbers

we "derive" from Library of Congress assigned call numbers for a different edition or
translation.

� Call numbers taken directly from Library of Congress for the same edition (050 field
with appropriate indicators) will generally be used as is.

� No date will be added if none exists in the 050.

� If there is an incorrect date in the 050 because it was assigned pre-publication
(CIP), the date will be corrected in our local call number.

Which Date to Use

Editions

� Facsimile or photocopy editions of original: use imprint date of original followed
by a, i.e. 1859a. Additional facsimile or photocopy editions are assigned aa, ab, ac,
etc.

� Successive editions (2nd, 3rd, 1st American ed.) and reprints: use imprint date of
successive edition or reprint. If two or more editions are published in the same year,
add letter to date, starting with b.

� Facsimile or photocopy edition of a successive edition: use imprint date of original
successive edition followed by a. For example, a photocopy of a 1981 1st American
edition might be 1981ba. (b for 1st American ed., a for photocopy).

Imprint Date Unclear

� If the imprint date is uncertain and is bracketed, use the date provided, i.e. for
[1892?] and [ca. 1892 use 1892.

� If the imprint date is uncertain and two dates are bracketed, use the earlier date,
i.e. for [1892 or 1893], use 1892, and for [between 1906 and 1912] use 1906.

� If the imprint date cannot be determined beyond the decade or century, use the
earliest date of the decade or century plus the letter "z", i.e. for [196] and [196?] use
1960z, and for [19] and [19?] use 1900z.

� If the imprint date contains a date of publication and a copyright date, use the
date of publication, i.e. for 1966, c1964, use 1966. However, if the date of the first
impression of the edition cannot be ascertained and the imprint date contains the
copyright date and the date of a later impression, use the copyright date, i.e. for
c1971, 1977 printing, use 1971.
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� If the imprint date contains a date of publication and a printing date, use the date
of publication, i.e. for 1969, 1971 printing use 1969, and for 1970, t.p. 1973 use 1970.

� If the imprint date contains a date of publication that has been corrected, use the
corrected date of publication, i.e. for 1966 [i.e. 1965] use 1965; for 1966 [i.e. 1965,
c1962] use 1965; and for 1975, cover 1976, use 1976.

� If the imprint date of a multi-volume work covers more than one year, i.e. 1826-
1828, use the earlier date.

� If the imprint date is an open entry, i.e. 1826- , use the date provided.

Main Entry Under Name of Conference, Congress, etc.

� Add date for year in which the congress met. If the congress met for more than one
year, assign only the latest year.

� In order to formulate unique call numbers, consecutive work letters, i.e. a, b, c,
etc. are added to date (z is not used). If all single work letters have been used,
double letters are assigned, i.e. aa, ab, ac, etc. Thus facsimiles, reprints, translations,
etc. will not stand next to the original or related publication. The same procedure
applies to a congress which was held two or more times within one year.

LC Call Number With Incorrect Date Assigned at Time of CIP
Cataloging

� Do not alter the 050 on the bib record.

� Use the correct date in the call number you assign to the book on the holdings record.
Correct date will usually be actual date of publication, unless rules in 1-3 above
apply.

Date as Part of Class Number
Occasionally, a date is used as part of the class number and precedes the Cutter
number. This most frequently happens in classes G and J, but can occur in other class
numbers as well. Thus in some cases, the call number will contain two dates, one as part
of the class number and another as the edition mark.

Example

Did monetary forces cause the Great Depression? / P. Temin. 1976.
HB
3717
1929 (refers to date of Great Depression)
.t45
1976 (date of publication)
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Note: Information in this document was taken from Immroth's Guide to the Library of Congress
Classification, 4th ed., by Lois Mai Chan. See Chan for further information: editions, p.
68-70; imprint date unclear, p. 67-68; conferences, p. 323-326; date as part of class
number, p. 66-67.
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Call Numbers for Translations
When a call number is not available for a translated work and the title of the original is
known, try to obtain a call number for the original and use it to construct a call number
for the translation, following these guidelines:

Translations of a work normally follow the original text in an alphabetical
arrangement by language. This is achieved by using successive Cutter numbers. (The
numeral 1 is inserted in order to avoid interference with other titles by the same author.)
The following table provides a general guide for arranging translations. A translation in a
language not listed here may be assigned a Cutter number which will place it in the
proper alphabetic place in the sequence.

Table for Translations

.x      Cutter number of work in original language

.x13  English translation

.x14  French translation

.x15  German translation

.x16  Italian translation

.x17  Russian translation

.x18  Spanish translation

If a Bulgarian, Chinese, or Czech translation is to be inserted, the Cutter number .x12
may be used; if a Hebrew translation, .x15 or .x16; a Portuguese translation, .x16 or .x17,
depending upon what has already been used.

Reverse the method when the book in hand is an original work and a call number for a
translation is available, by deleting the last two digits from the translation Cutter number
to obtain a Cutter number for the original.

When to Add x and/or Date
1. When working from a Library of Congress assigned call number:

� If LC has assigned a call number for the original work, when constructing a
number for a translation (by extending the Cutter), add a lower case x to the new
number.

� If LC has assigned a call number for a translation, when constructing a number
for the original (by deleting 2 digits from the Cutter), it is not necessary to add the
x to the new number.
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2. When working from RLIN or OCLC member assigned call numbers, always add
the x to the newly constructed number, whether translation or original.

3. Always add a date to the newly constructed call number, whether the original
number is obtained from LC or a member library.

Note: These guidelines were taken from Immroth's Guide to the Library of Congress
Classification, by Lois Mai Chan. See Chan, p. 100-101 and p. 320 for further
information.
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East Asian Copy Cataloging for Monographs
Refer also to these procedures:

Monograph Copy Cataloging: Editing Copy (Streamliners)

CJK Addendum to Streamliners

Searching and Copy Cataloging in RLIN

Searching

Title Searches
� Start with a roman title phrase search (fin tp).

� Truncate tp searches unless title too short and non-distinctive for truncated searching
(e.g. title search on “mon#” will get you thrown out of the RLIN system).

� Search short and non-distinctive periodical titles in serials file (sel fil ser).

� Search by character title phrase (fin ctp) when uncertain of the readings.

Author Searches
� Start with personal name exact search (fin pe).

� Prefer pe (personal name exact) to pn (personal name) search for Chinese and Korean
authors (to prevent hundreds of false hits).

� Try a pn search if pe search is unsuccessful (pe search will not retrieve names with a
subfield c, such as “|c Emperor of China”, or “|c pseud.” or “|c Sir”).

� Search by character personal name (fin cpn) when uncertain of the readings.

� Do not truncate name searches.

Format of Name
� East Asian Library does no authority work when creating their order records.

� Name on order record and t.p. may differ from established heading for author.

� Names that were never in Wade-Giles romanization were not affected by the
conversion to pinyin (e.g., Chiang Kai-shek and Sun Yat-sen).

� They appear in their Westernized forms IN ACCESS POINTS.

� They appear in pinyin in transcribed fields.

� Check the RLIN authority file if you are uncertain  if the name you are searching is
an exception to the pinyin rule.



University of Minnesota Aleph Cataloging Manual Page 112
Issue Date: 03-2002 Cataloging Procedures
Revised Date:  05-05-2003 East Asian Copy Cataloging for Monographs

Authors: Leslie Bohm, Doris Seely

ISBN Searches
� Search by isbn when both author and title are ambiguous.

� Since all records do not include the isbn number, you may want to continue with an
author or title search—to be certain you have found everything.

Atlases, Scores, Serials
Note: Copy catalogers need not catalog sets, serials, scores, maps, or atlases, but may be asked

to search for copy.  If copy is found, fold printout and insert in book.

� Atlases, scores and serials which have been ordered in the books file may have copy
in the maps, scores and serials files respectively.

Example

sel fil ser/fin tp zhongguo jin dai shi#.

sel fil map/fin pe wanf,dasan.

sel fil sco/fin sp operas, chinese#.

� Resuming the search in another file:
After searching the books file with a search like “fin tp zhongguo di tu ji#”, resume
search in another file (e.g., maps) by typing “sel fil map/res”

Selecting Copy

Identifying Copy
� The LC RLIN LI (library identifier) for CJK records is DCLP, not DCLC, as it is for

Roman alphabet materials.

� Only a few incomplete or Roman-only LC East Asian records from the early 1980’s
will have the DCLC LI.

� Many CJK materials cataloged by LC before 1984 or so will have LC copy in RLIN
which has been input by member libraries under their own LI’s. As far as I know,
most of this copy has been transcribed from LC’s old CJK catalog cards, either the
cards themselves, or the cards as reproduced in the NUC or the LC shelflist fiche.

� To identify this LC-based member copy, look at the FULl display to see if there is an
010 field, which shows the LC card number, and an 050 field with the first (and
recently also the second) indicator set to zero. You have to be a little careful about the
050 fields with first indicator zero, because apparently a few libraries mis-tag and
put their own local call numbers there, but in general an 050 field with a zero as the
first indicator means an LC assigned call number.
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Navigating
� To see the FULl display for each record in a cluster, use a command such as “FUL 5”

to display the first record in cluster 5.

� Press F7 to display each succeeding record in the cluster in turn.

� To go back to the preceding record, press Shift + F7.

� To go back from the display of one record in a cluster to look at the display of all the
LI’s in the cluster, type PRI, for primary display.

� To choose one record from within the primary display, type ful [LI] (e.g., ful njpx or
ful ctyo).

Selecting Best Copy
� If there are many LC-based member records for the same item, try to find and derive

from the most complete one.  Derive only from complete full level or core level
records.

� Incomplete records will usually be DCLC records with cat cat values of  9110 or
9650 or DCLP records with the cat cat values 9554.

� LC apparently sometimes upgrades 9554 records to full level but forgets to
change the cat cat values.  Accept a 9554 record with subject headings and an 050
field with a bona fide call number as full standard LC copy.  Change the cat cat
values to 9114 when deriving.

� Some will have the 010 field but not the 050; some will have the 050 but not the 010;
some will have both.

� They may have no aggregation, partial, or complete aggregation.

� Some may be missing parallel character fields for access points.

� Some may have the contents note in Roman-only, others in characters only; some
may have dropped the contents all together.

� Some may have both romanization and characters.

� Serials records may or may not have 780 and 785 fields for earlier and later titles, etc.

� An original cataloger will frequently put together the best features from three or four
records when deriving. In serials, it may be necessary to put together six or eight.
Copy catalogers are not expected to go that far, but should try to do a bit of
comparison shopping and derive from the best record they can find.
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Selecting a Call Number
� There are a number of things that appear in LC 050 fields that are not LC call

numbers. “ACQUISITION IN PROCESS” is obviously not an LC call number;
neither are:

� LAW

� LAW<CHINA DICT 018 1989>

� MLCSC 92/01274 (P)

� Some records have only partial call numbers.

� A call no. ending with a “+”

� A call no. lacking a Cutter number and a date (for recent monographs)

� A call no. occurring in a second |a after a complete LC call number

� Bibliographies and indexes class in Z rather than with the subject.

� If there is first a complete call number which classes a book as, say, volume 103 of a
set, and then a second incomplete call number for that volume as an individual work,
and if we have only volume 103 and none of the other 102 or more volumes, ignore
the first call number for the set, complete the second call number for the individual
volume, and use that.

Updating and Overlaying Acquisitions Records With Copy Found

Bibliographic Screen
� To update to cataloged status a post-1988 acq record with RTYP=0, call up the record

and then give the command: set fun cat mai/upd.

Note: There are a few pre pre-1998 acq records with RTYP=a; to update these,
set fun cat (not cat mai).

� After you SEND this command, the record will redisplay in update mode.
1. If the acq record is based on a complete LC record with a complete call number in

the 050 field, this UPD command is all that is necessary.

2. If the acq record is not a full standard LC record and you find a suitable LC
record elsewhere in RLIN, overlay the MNUO acq record with the LC record.

� If the LC record is in the same cluster as our acq record, set fun cat mai,
display the DCLP record and give the command “ful mnuo/cop id [RLIN id
no. for the DCLP record which you have displayed]. The easy way to do
this is to copy it onto the cursor and paste it in; then you don’t have to worry
about keying errors.
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� If the DCLP record you want to use is not in the same cluster, use a tp or pe
search to call up both clusters together. Note the number of the cluster which
has the MNUO acq record. Display the DCLP record. Make sure the function
is set to catalog maintenance (set fun cat mai). Give the command: ful [no. of
cluster with MNUO acq record]/cop id [DCLP record no. from the top of
the screen].

Note: After you send this command, the MNUO acq record will display in
update mode, with the bib screen now overlaid by the DCLP record. If you
find that you have made a mistake and overlaid the wrong acq record, or
used the wrong DCLP record, you can undo the whole thing by sending
the cursor home and typing “can” for cancel.

Once you have the MNUO record displayed in update mode, by any of the methods listed
above:

� Tab to RTYP in the fixed fields and change “o” to “c.”
Note: For records with RTYP=a do not change.  System will change it to b (for

both--acq and cat) when upd is entered.

� Add an 035 field with the LUMINA ID from the order record, using the format:
(MnU)ABC1234.

Note: To insert the line for the 035 field, you position the cursor anywhere in the
line below where you want the 035 inserted and hit SHIFT + INSERT. If you
insert too many lines, there is no way to delete them, but the system will
automatically delete them when you enter your update.

� Save the call number in the 050 field on the cursor or on one of the keys of the
RLIN keyboard, so that you can copy it onto the holdings screen.

� Go to the end of the bib record and delete the PVT field with the acq information.

� Copy Catalogers may now edit best available copy according to guidelines of the
Streamliners document and the CJK Addendum to Streamliners.

Holdings Screen
� Accept the HOL prompt to go to the holdings screen.

� Tab to CIN (Cataloger’s initials) and enter your initials.

� Tab to CALL and enter the call number you saved from the 050 field.

� Decimal point must appear before first Cutter number.

� Subfield must appear before the last Cutter number.

� Locations in angle brackets (e.g., <Orien China>) should not be transferred to
RLIN holdings screen.
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� Tab to INS (Instructions) and enter: n (for no instructions).

� Tab to LOC. LOC should already be filled in as EA. If not, fill in: EA.

� Tab to LCAL.

� If book was ordered as Ref, enter: |d\Ref\|a[call no.].

� If hard cover book is 26-31 cm., enter: |d\Quarto\|a[call no.]

� If paperback book is to be bound and is 25 ½--30 ½ cm., enter: |d\Quarto\|a[call
no.]

� If hard cover book is more than 31 cm. Enter: |d\Folio\|a[call no.].

� If book is both Ref and oversize, enter: |d\Ref\Folio\[call no.]

� Tab down to COP and enter 1, for copy 1 in most cases.

� If the item is a paperback, tab down to SHNT and enter |upbd, (this helps locate
book in process).

� If the work is in more than one volume, tab to the MDES field and record our
holdings. Below are some examples of possible formats:

� v. 1 thru 12

� v. 2

� v. 6; v. 9 thru 12; v. 17

� no. 12 thru 23

� yr. 1937, no. 1-7; yr. 1937, no. 9-12; yr. 1939 thru 1944

� v. 3, pt. 2 thru 3; v. 6, pt. 1

� When everything on the holdings screen has been filled in, accept the ENTer prompt
on the command line by pressing SEND.

Finishing up in RLIN
� After you get the “Transaction successful” message, make a printout of the whole

record, including the holdings screen. Fold it and put it in the book.

Note: To print the whole RLIN record on one page, while in RLIN, click on
SETTINGS, and under SETTINGS on TERMINAL, and under
TERMINAL you uncheck AUTOEJECT. Then you display the first bib
screen and press CONTROL + p. Display the second bib screen, if there is
one and press CONTROL + p; display the holdings screen and press
CONTROL + p. Then press Shift + F4 and all three screens should print out
on the same page.

� Write the RLIN ID next to the Aleph ID on the page following the title page.
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� Complete the books you intend to catalog that day.  (RLIN records cannot be passed
on the same day they are input or updated—because they index in RLIN overnight)

� Pass your records the following day.

When There Is No Acquisitions Record in RLIN

Derive a MNUO record in RLIN when there is an acq record in Aleph, but none in RLIN,
or when there is no acq record in Aleph or in RLIN—as for analytics, cat seps or gift
books.

� Derive from a matching LC record in RLIN.

� Give command: set fun cat (if you are not already in cataloging function) then give
command der.  You can chain the commands: set fun cat/der.  Once you send the
der command, you can go into the record and make any necessary changes:

� Add the 035 field only if acq record was already created in Aleph (by mistake?)
with no RLIN acq record.  For gifts, anals, and cat seps, there will be no record in
Aleph to put in the 035 field.

� SHNT field on holdings screen—when appropriate.

� For cat seps enter subfield u cats; ordn=

� For analytics enter subfield u anal; set=

� Fill in the holdings screen and Enter (When you enter a derived record, you
create a new record in RLIN with a new record ID.)

� Write this ID number on the page following the title page; new RLIN records
index overnight and can be retrieved only by ID number on the first day they are
entered.

� Make a printout of the record and insert it in the book for use when updating
the record in Aleph.

� Pass your records the following day.

Passing MnU Records From RLIN and Updating Them in
Aleph

Books With Order Record in ALEPH

1. Open GUI OPAC.

2. Connect to RLIN.

3. Use FIND search to retrieve RLIN #.
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4. Activate first Macro rlin [preceded by activation code xx] to:

� Push record through to cataloging.

� Duplicate the record.

� Format 035 field(s), and fill in some of the fixed fields.

� Edit 008 field (38) for romanized record r.

5. When macro stops, delete second date (11-14) in 008 if it has come up as an error.

6. Activate second macro r2 [preceded by activation code xx] to:

� Delete 066 field, 090 field.

� Delete all subfield 6’s  at the beginning of variable fields.

� Delete all 880 fields.

� Delete SID field.

� Add 965 field with subfield a NOEXP and subfield b CJK.
7. When macro stops:

� Do not save record to server.

� Copy record.

� Call up acq record in Aleph, usually by 035 field.

� Paste catalog record (that you have just imported from RLIN and updated) over
acq record you just called up.

� Delete duplicate 035 field.

� Save newly overlaid record to server.

� Delete the record you just imported from RLIN.

8. Activate third macro ctrl + h [preceded by activation code xx] to:

� Load HOL record from server.

� Check fixed fields in LDR and 008 and correct any that have not filled in
properly.

� Fill in 940 field with subfield a MNU,  subfield b CAT and subfield c today’s
date.

� Fill in 852 field:

� Change indicators to 0 and blank.

� Fill in  subfield k  with Quarto or Folio if appropriate.
9. When macro stops:

� Add subfield x  to 852 field with any necessary info, e.g. $$x pbd.
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� Delete any tracking info from 852 subfield x.

� Fill in 866 $$a with volume holdings info if record is for a multi-volume set.

� Save holdings record to server.

� Retrieve Item record (should be mostly filled in).

� Change Material type to BP.

� Change Item status to 01.

� Change Item process status to blank.

� Fill in Enumeration and Description if record is for multi-volume set.

� Scan in barcode.

� Use white barcodes for hardcover books and place barcode at top of
back cover.

� For oriental style books, place barcode on the bottom of what would
normally be the front cover (but is actually the bottom of the back cover
for this style of book).

� Use red barcodes for paperbacks and place barcode inside the book.

� Place hardbacks on truck for marking.

� Take all paperbacks down to the East Asian Library with the printouts still in
them and give them to Su Chen with a note saying that they are ready for binding
decisions.

� The ones they are going to bind stay in East Asian Library; Li gets them ready
for Bindery Prep and then delivers them there once a month.

For the few paperbacks they decide not to bind, Li puts the barcodes on the outside and
perhaps deletes the “pbd” from the holdings screen and sends them back up to the
marking room.

Special Cases: Gift Books With No Record in RLIN

1. Open GUI OPAC.

2. Connect to RLIN.

3. Find record by RLIN record # search.

4. Activate first macro rlin [preceded by xx] to:

� Push to cataloging.

� Duplicate.

� Edit 008 field (38) for romanized record r.
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5. Activate second macro r2 [preceded by xx] to:

� Delete 066 field, 090 field.

� Delete all subfield 6’s  at the beginning of variable fields.

� Delete all 880 fields.

� Delete SID field.

� Add 965 field with subfield a NOEXP and subfield b CJK.
6. When macro stops:

� Save to server.

� Push to Acq.

7. Activate macro ord [preceded by xx] to:

� Create Acq record for gift book.

� Arrive book.
8. Return to BIB record and activate macro alt + h [preceded by xx] to:

� Load HOL record from server.

� Check fixed fields in LDR and 008 and correct any that have not filled in
properly.

� Fill in 940 with subfield a MNU, subfield b CAT and subfield c today’s date.

� Fill in 852 field.

� Change indicators to 0 and blank.

� Fill in subfield k with Quarto or Folio if appropriate.

While macro runs:

� Write call no. in book.

� Put barcode on book.

9. When macro stops:

� Add  852 $$x pbd if book is paperback.

� Save to server.

� Call up Item Record and scan in barcode.
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Special Cases: Added Volumes

In RLIN:

1. Find the record for the set in RLIN.

2. Close dates in Fixed fields and 260 field if last volume of set.

3. Fill in the number of volumes in 300 field if appropriate.

4. Update Contents note with information from this volume if appropriate.

5. Update the MDES field on the HOL screen.

If the set is an analyzed set, try to find an analytic record for the added volume. If you
find one, derive an analytic for MNUO and follow procedures under Special Cases:
Analytics.

In Aleph:

6. Check Bib record for possible updates in these fields:

� 008 (07-10)

� 260 $$c

� 300 $$a

� 505

7. HOL record:

� Change values in 008 for complete sets.

� (06) Change “4” for “currently received” to “2” for “order complete”.

� (16) Change “2” or “3” for “incomplete set” to “1” for “complete set”.

� Add the volume to 866 $$a field.

8. Create the Item record for the volume, remembering to fill in the volume number in
the enumeration and description fields.

Special Cases: Analytics

1. Create Catalog record in RLIN.

2. Pass to Aleph following day.

3. Open GUI OPAC.

4. Connect to RLIN.

5. Use FIND search to retrieve RLIN #.
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6. Activate first macro rlin [preceded by activation code xx] to:

� Push record through to cataloging.

� Duplicate the record.

� Format 035 field(s), and fill in some of the fixed fields.

� Edit 008 field (38) for romanized record r.

7. When macro stops, delete second date (11-14) in 008 if it has come up as an error.

8. Activate second macro r2 [preceded by activation code xx] to:

� Delete 066 field, 090 field.

� Delete all subfield 6’s  at the beginning of variable fields.

� Delete all 880 fields.

� Delete SID field.

� Add 965 field with subfield a NOEXP and subfield b CJK.
9. Activate third macro alt + h [preceded by activation code xx] to:

� Load HOL record from server.

� Check fixed fields in LDR and 008 and correct any that have not filled in
properly.

� Fill in 940 field with subfield a MNU, subfield b CAT and subfield c today’s
date.

� Fill in 852 field.

� Change indicators to 0 and blank.

� Fill in subfield k  with Quarto or Folio if appropriate.

10. When macro stops:

� Add subfield x to 852 field, e.g. $$xanal; set=ACF1234 [or Aleph bib record
no.].

� Delete any tracking info from 852 subfield x.

� Save HOL record to server.

Note: Process is complete—there is no item record.

Special Cases: Cat Seps

1. Create Catalog record in RLIN.

2. Pass to Aleph following day.

3. Open GUI OPAC.
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4. Connect to RLIN.

5. Use FIND search to retrieve RLIN #.

6. Activate first macro rlin [preceded by activation code xx]  to:

� Push record through to cataloging.

� Duplicate the record.

� Format 035 field(s), and fill in some of the fixed fields.

� Edit 008 field (38) for romanized record r.
7. When macro stops, delete second date (11-14) in 008 if it has come up as an error.

8. Activate second macro r2 [preceded by activation code xx] to:

� Delete 066 field, 090 field.

� Delete all subfield 6’s  at the beginning of variable fields.

� Delete all 880 fields.

� Delete SID field.

� Add 965 field with subfield a NOEXP and subfield b CJK.
9. Activate third macro alt + h [preceded by activation code xx] to:

� Load HOL record from server.

� Check fixed fields in LDR and 008 and correct any that have not filled in
properly.

� Fill in 940 field with subfield a MNU, subfield b CAT and subfield c today’s
date.

� Fill in 852 field.

� Change indicators to 0 and blank.

� Fill in  subfield k  with Quarto or Folio if appropriate.
10. When macro stops:

� Add subfield x to 852 field, e.g. $$xcats; ordn=.

� Delete any tracking info from 852 subfield x.

� Save HOL record to server.

� Push to Items and create item records. 
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Special Collections/Archives Copy Cataloging

Copy Cataloging Guidelines for Special Collections and
Archives Materials—Monographs

Monographs cataloged for special collections and archives units typically have special
requirements for handling and processing that differ from materials cataloged for
circulating or open-stack collections. The following guidelines do not outline the
complete copy cataloging workflow, but describe the areas in which special collection
treatment is different from standard treatment, or areas to which particular attention
should be paid. For complete information on copy cataloging workflow and procedures,
consult the Streamliners procedures and other monograph copy cataloging procedures in
this manual.

Note: Individual collections and projects may have additional or variant requirements.

Bibliographic Record

Limited Editions
Definition: The book bears a statement that it is a special or limited edition. Often there is
a preliminary page for the limited edition statement. The book may be a different size,
have a different type of paper or binding than the standard edition. Often a statement is
made as to the number of copies in the limited edition.

� The piece should be cataloged separately from the standard edition. Search for
matching copy in OCLC or RLIN, or duplicate a record from MnCAT and edit as
needed.

� If not already present, add a 500 note describing the limited edition. You can often
quote the edition statement in whole or in part. However, do not include the specific
numbering of the copy in hand: this information will go in the Holdings record.

Example

500 ## $$a “The autographed edition of this book is limited to two hundred
copies”—Prelim.

500 ## $$a “Fifty signed and numbered copies bound in three-quarter calf with
marble boards”—Colophon.

500 ## $$a Limited edition of 100 copies.
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Advance Readers’ Copies/Uncorrected Proofs
These materials can either be cataloged separately or treated as added copies of the record
for the published version. Base your decision on how much the proof varies from the
published book. 

� If the descriptive information (title, author, size, number of pages) matches the
published version and the only significant difference is wording on the title page or
cover that indicates it’s a reviewers’ copy or proof, treat as an added copy. A note
will be added to the Holdings record indicating the variation.

� If there are significant differences in the size, pagination, or representation of the title
or author’s name, catalog as a separate record. Since the book you have is
unpublished and was not intended for mass distribution, treat as a manuscript. Pay
particular attention to the following fields:

� LDR: Type of record (06): t (manuscript)

� 008: Publication place (15-17): xx (unpublished)

� 260: Do not enter subfields a and b; enter only the date in subfield c

� 500: Add a note indicating publication information:

Example

500 ## $$a Advance readers’ copy of book published in 2002 by
Farrar, Straus, and Giroux.

Bibliographies
A 510 field can be used to reference a title’s listing in a standard bibliography. Only add
a 510 if instructed to do so for a specific project.

Example

510 0# $$a De Waal C2456

Call Numbers
Note: Refer to the “Holdings Record” section of this procedure for detail on entering call

numbers.

Library of Congress:  For materials in LC-classed collections, if a Library of Congress
call number is not present in a 050 or 090 field, one must be added in a 050 #4. The smart
barcode macro (see below) captures the call number information from the bibliographic
display. If it is member copy or locally-supplied, the macro will prompt you to add a
work letter and/or date to the call number if they are lacking. 
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Local Call Numbers:  Some collections may be shelved by a locally-devised shelving
number. If supplied at the time of cataloging, enter in a 099 field. Use only subfield a;
leave spaces where needed for clarity.

Example

099 ## $$a MM An24c

Smart Barcodes
Unlike circulating materials, adhesive barcodes are normally not affixed to special
collections materials. A set of macros has been established to generate barcode slips
bearing the System ID, sub-library, collection, call number, main entry, and title. The
slips must be printed on acid-free paper.

After the bibliographic record has been edited and saved to the server, the first barcode
macro should be activated. When prompted, edit the call number as needed, including
size designation, work letter, and date.

Note: Refer to “Smart Barcode Slips” in this manual for complete instructions. See specific
project guidelines to determine whether smart barcode slips or adhesive barcodes are to
be used.

Gift Acquisitions Record

For auditing purposes, every bibliographic record for which we know the source of
acquisition needs an order record. Many special collection materials were received as
gifts, so many books will need a Gift acquisition record. Create a Gift order record only if
you know that the book was a gift. Gift books will bear a gift tag or an inscription from
the donor, or you will be instructed that all materials for a specific project are to be
considered gifts. There is no difference in the procedure from that for other monographs.
Refer to the “Gift Processing” procedure in this manual for instructions.

Holdings Record

852 Field
1st Indicator Corresponding subfield(s)

0 – Library of Congress Call Number h, i   Add work letters and dates as needed

4 – Local Call Number or Accession
Number

j       Local call number

5 – Shelved by Title l       Name or title shelved by if different from 130
or 245 title
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� Subfield k (Shelving designation): Use authorized text for a characteristic of the copy
that is significant for shelving (e.g., size, form, special collection). There is some
variation across units, so consult specific project guidelines for correct size
designations and terminology.

� Subfield t: Enter the copy number if it is an added copy for the same collection. Do
not precede the number with the word Copy. Note any variation between the copies in
866 notes. 

866 Field
Use an 866 note in subfield z to record public notes on elements specific to the copy in
hand.

Provenance: This is an indication of who the former owner was. It may be written in the
book or be present on a book plate.

Example

866 #1 $$8 0 $$z Provenance: Paul Robeson.

866 #1 $$8 0 $$z Book plate of: Jennifer Even-Gerth.

Gifts: If the book is a gift to the library from someone, put in a note.

Example

866 #1 $$8 0 $$z Gift of Elmer L. Andersen.

Presentation Copy: This will usually have a to and from statement, possibly with a
small message.

Example

866 #1 $$8 0 $$z Presentation copy: To Elmer Andersen from Charles
Lindbergh.

866 #1 $$8 0 $$z Author’s autograph/presentation copy to John Bennett Shaw.

Inscriptions: If the book is signed by the author and/or illustrator but is not a
presentation copy.

Example

866 #1 $$8 0 $$z Copy signed by author.

866 #1 $$8 0 $$z Copy signed by illustrator.
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Limited Editions: Enter a note to record the specific numbering of a copy that is part of
a limited, numbered edition.

Example

866 #1 $$8 0 $$z No. 8 of 250 limited ed. copies.

Advance Copy or Review Copy: Add a note if cataloging as a variant printing of the
published version

Example

866 #1 $$8 0 $$z Advance uncorrected proof.

866 #1 $$8 0 $$z Review copy.

Edition and Printing Statements: If an edition statement appears that according to
AACR2r is a printing statement and would not appear in the bibliographic record, make a
note.

Example

866 #1 $$8 0 $$z “9. Edicion.”

If the printing number is stated, quote it in the Holdings note.

Example

866 #1 $$8 0 $$z “14th printing, 1987.”

866 #1 $$8 0 $$z “1st Scholastic printing.”

Other Bibliographic Notes: Note anything else of significance that would distinguish
this copy from others in the collection or is not addressed in the bibliographic record
(defects, variant bindings or dust jackets, etc.).

Example

866 #1 $$8 0 $$z Errata slip inserted.

866 #1 $$8 0 $$z Title page missing.

866 #1 $$8 0 $$z Leather binding with slipcase.
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Entering Multiple 866 Fields: For multi-volume sets, record holdings information in
subfield a. Use multiple 866 fields when multiple subfield z notes are appropriate. This
will generate a list of such elements for each copy in the public catalog holdings display.
However, note the exception below for some multi-volume works.

Example

866 #1 $$8 0 $$z No. 10 of 50 limited edition copies.

866 #1 $$8 0 $z Gift of Elmer L. Andersen.

Multi-Volume Sets: For multi-volume sets, record holdings information in subfield a. If
the subfield z notes only apply to specific volumes, create a separate 866 field for each
volume specified. If multiple subfield z notes apply to a specific volume, repeat subfield
z's within a single 866 field. For display purposes end each note with a period.

Example

866 #1 $$8 0 $$a v.1 $$z Gift of John Bennett Shaw.

866 #1 $$8 0 $$a v.2 $$z Gift of Philip Hench. $$z Missing title page.

866 #1 $$8 0 $$a v.3-4 $$z Gift of John Bennett Shaw. 

In some cases, you may want to add an internal note; i.e. one that is only viewable in staff
mode but invisible in public mode. Use a subfield x.

Example

866 #1 $$8 0 $$x Gift of Jane Benedict.

In this instance, the donor did not want her gift made public, but unit staff
wished to be able to search by her name to retrieve a list of the books donated.

Item Record

Pay particular attention to the following fields:

Tab 1
� HOL Link: Make sure the item is linked to the appropriate Holdings record.

� Description: Fill in the volume numbering or piece designation if a multi-volume set.
Each volume should have its own item record.

� Item status: change to 02 (Non-circulating)
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Tab 2
� Order number: Fill in if not automatically generated from order record. The order

number can be found by going to the Navigation map, expanding the tree and
selecting “Orders.”

Click update once all the item information is entered correctly. Once the item list is
displayed with the correct item highlighted, generate the second barcode macro. Refer to
“Smart Barcode Slips” in this manual for complete instructions.

Physical Handling

Dust Jackets and Other Containers
Do not discard dust jackets, slipcases, or other containers.

Marking
� Write lightly with a sharp no. 2 pencil.

� Write sub-library, collection, System ID and copy number if 2 or higher in upper
right-hand corner of page following title page.

Example

TAND, RARH                                                       

3734192  c.2     

� If the page following the title page is signed, has an inscription, or has the limitation
statement, mark the next page, or the verso of the signed page instead.

� On broadsides or other single-sheet materials, mark on the upper right-hand corner of
the back (i.e. non-printed) side of the sheet.

� In general, do not mark artists’ books (i.e. the book itself is considered a work of art)
unless an appropriate place can be found where a pencil marking does not detract
from the artistic value of the piece.

Security
Keep rare materials in a locked and secured location (i.e. locking book cart or flipper)
when away from your desk.

Disposition
Return cataloged materials directly to a staff member in the unit holding the collection.
Some materials may be sent via Campus Mail; assume materials are to be transferred by
hand unless collection procedures specify otherwise.
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Children’s Literature Research Collections Monographs
Cataloging

References:

Chan, Lois Mai. Immroth’s Guide to the Library of Congress
Classification. 4th ed. Englewood, Colo. : Libraries Unlimited, 1990.

Zuiderveld, Sharon, ed. Cataloging Correctly for Kids: An
Introduction to the Tools. 3rd ed. Chicago : American Library
Association, 1998.

Workflow and Division of Responsibilities

1. Materials should be cataloged on receipt.

2. Gift materials and titles directly ordered/purchased by CLRC and delivered to them
will be shipped to MAC PD.

3. Cataloger will search MnCAT, OCLC, and RLIN for acceptable copy and catalog if
found. If no acceptable copy is found, cataloger will deliver to original cataloger. In
addition, materials needing classification, subject headings, and/or authority work can
be given to original cataloger. CLRC materials will not be sent to RESEA, nor will
provisional records be created.

4. During retention of material in Wilson Library for processing, the materials will be
locked in a locking book truck, flipper shelf, or the book room. Upon completion of
cataloging, material will be shipped to CLRC.

5. CLRC Curator will notify cataloger of materials that should be cataloged as a series.

6. Book plates and Mylar jacket covers will be applied by CLRC staff.

7. Cataloger will add a Holdings note to an existing record when the copy is inscribed.
When books are inscribed after cataloging, CLRC staff will add the notes.

Example

866 #1 $$8 0 $$z Copy inscribed by author.

866 #1 $$8 0 $$z Copy inscribed by illustrator.

866 #1 $$8 0 $$z Drawing inscription by illustrator.

Cataloging Procedures

Books cataloged for this collection will receive standard AACR2 cataloging and LC
classification. In addition, due to the "special collections" nature of these materials,
certain aspects of the book in hand will be recorded in notes in the Holdings record. The
books will be assigned AC (Annotated Card Program) children's subject headings and,
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where appropriate, LC subject headings (with the subdivisions |v Juvenile literature, |v
Juvenile fiction, |v Juvenile poetry, etc.).

See “Streamliners” and “Copy Cataloging Guidelines for SC/AR Materials—
Monographs” procedures in this manual for more details.

Particular attention will be given to the following aspects:

Bibliographic Record
� Translators and illustrators (including jacket illustrators). Cataloger will enter

them in the 245 subfield c or in a 500 note as appropriate, and will trace each in a 700
field, with a subfield e relator term.

Example

245 10 $$a Henry Huggins / $$c Beverly Cleary ; illustrationen Emmy-Claire
Haag ; [übersetzt von Erika Schreiweis].

500 ## $$a Jacket illustrator: Monika Glauss.

700 1# $$a Haag, Emmy-Claire, $$e ill.

700 1# $$a Schreiweis, Erika, $$e tr.

700 1# $$a Glauss, Monika, $$e ill.

� Series. Cataloger will check MnCAT for a series authority record and/or a
bibliographic record for the series. If this check turns up no recorded sep/set treatment
decision in MnCAT, and the book is for TAND CLRH (Hess Collection) or cataloger
questions whether the material should be cataloged as a series, cataloger will check
with CLRC Curator for a decision. In general CLRC would like almost all TAND
CLR titles cataloged separately.

Cataloger will record treatment decision: 

� On series authority record in 64X fields, $$5 MnU

� On order record if necessary (i.e. if title ordered as a set is cataloged separately,
“CATS” is recorded in Library note on Tab 1.)

Special care should be taken to add series such as “An I can read book” which is
treated as a series (added as a 440 field) as opposed to “A Laura Geringer book” or
“Silver Whistle books” which are added as a quoted note.

� Subject headings on juvenile materials (does not apply to adult materials)

� On member copy or LC copy modified by a member library, at least one 650
#1 must be present for fiction, and at least one 650 #0 and one 650 #1 must be
present for non-fiction.

� If member copy includes an LC (650 #0) heading without a subdivision
beginning with the word “Juvenile”, accept subject heading and add $$v Juvenile
literature, $$v Juvenile fiction, $$v Juvenile poetry, etc.

http://www.loc.gov/marc/relators/
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� Cataloger will assign the following heading as the last heading for books
measuring 10 cm. or less in both height and width:

650 #0 $$a Miniature books $$v Specimens.

Note: Miniature books also require size designations in the holdings record.

� For books which incorporate elements such as movable parts, sound effects,
scents or other characteristics which expand its scope beyond a traditional book,
add the subject heading:

650 #0 $$a Toy and movable books $$v Specimens.

Consult LCSH for narrower terms for specific types of toy and movable books.

� Valid free-floating subdivisions

Juvenile drama
(H 1690) [Form subdivision]

Use under names of countries, cities, etc., names of
individual persons and corporate bodies, and under
classes of persons, ethnic groups, and topical
headings.

Juvenile fiction
(H 1690) [Form subdivision]

Use under names of countries, cities, etc., names of
individual persons and corporate bodies, and under
classes of persons, ethnic groups, and topical
headings.

Juvenile films
(H 1690) [Form subdivision]

Use under subjects.

Juvenile humor
(H 1690) [Form subdivision]

Use under names of countries, cities, etc., names of
individual persons and corporate bodies, and under
classes of persons, ethnic groups, and topical
headings.

Juvenile literature
(H 1690) [Form subdivision]

Use under subjects.

Juvenile poetry
(H 1690) [Form subdivision]

Use under names of countries, cities, etc., names of
individual persons and corporate bodies, and under
classes of persons, ethnic groups, and topical
headings.

Juvenile software
(H 2070) [Form subdivision]

Use under topical headings for actual software items,
i.e., machine-readable editions.

Juvenile sound recordings
(H 1690) [Form subdivision]

Use under subjects.
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� Fixed Fields (008)
For juvenile materials, cataloger will enter “j” in Target Audience (17). If the
publisher provides a more specific age level, cataloger may optionally assign one of
the following codes:

a – Preschool Code a indicates the item is intended for preschool children,
approximate ages 0-5 years.

b – Primary Code b indicates that the item is intended for children,
approximate ages 6-8 years.

c - Pre-adolescent Code c indicates that the item is intended for young people,
approximate ages 9-13 years.

d – Adolescent Code d indicates that the item is intended for young people,
approximate ages 14-17 years.

Gift Acquisitions Record
Create a gift order record for materials received as gifts.  Refer to “Gift Processing” in
this manual for procedures.

Holdings Record
� Valid sub-library and collection codes

� TAND CLR – Most books

� TAND CLRR – Reference *

� TAND CLRH – Hess Collection

� TAND CLRE – Ellis Collection

� TAND CLRC – Publication catalogs
* Reference books are defined as books about children's literature, including
biographies of children's authors. They are almost always adult level material. Adult
materials acquired because the author has donated the manuscript, for example, will
be cataloged for TAND CLR. Cataloger will make the judgment about whether a title
is a reference book, consulting with CLRC staff in questionable cases.

� Size designations
CLRC is in the process of reshelving their books into permanent-location trays.
Decisions about the size of tray a book fits in, and the assigning of the tray number to
the book and adding it to the Holdings record, will typically be done by CLRC staff
after the book has been cataloged. Therefore, most traditional size designations are no
longer needed. However, as the width of the largest size tray is 25.4 cm and many
children’s books are wider than standard, it is important to measure the height and
width of each book cataloged.
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Place in sub-field k of the 852 field:

� Mini – measuring less than 10 cm. (both height and width) 
Note: Miniature books also require a special subject heading.

� Oversize – measuring over 30 cm. in height and/or over 25 cm. in width. 

� Classification

� Follow usual practice in accepting LC and member copy call numbers. Most will
be in PZ, but non-PZ numbers are acceptable for juvenile fiction.

� When classifying locally, assign PZ numbers for juvenile fiction. For adult
materials and juvenile non-fiction, class with the topic in the other subject classes.

� As CLRC books are not shelved by call number, the classification numbers on
member copy will be accepted without modification.

� Translations of juvenile material into a foreign language are classed in the
language and cuttered with the LC unique author number. The author number is
expanded using the number for expansion from the cutter table that corresponds to
the first letter of the title of the translation.

Example

852 0# $$a MnU $$bTAND $$c CLR $$h PZ43 $$i .T395 1995

Where PZ43 is the classification for Italian, .T39 is the author number for Theodore Taylor,
and the expansion number 5 corresponds to the letter I from the title L’isola di Phillip (The
cay). Translations into English are classed in PZ7-PZ10. For more detailed information, see
Chan, p. 340-341.

� Holdings notes
Follow standard SC/Ar monograph procedures for adding copy-specific notes.
Inserted items. Items, such as letters, postcards, etc. inserted into the books should
be removed and returned to CLRC for storage in their vertical file. If such an item is
removed from a book, make an internal note in the 866 sub-field x. 

Example

866 #1 $$8 0 $$x Inserted letter from Jane Smith relocated to CLRC vertical
file.

866 #1 $$8 0 $$z Copy inscribed by author. $$x Inserted clipping from New
York Times relocated to CLRC vertical file.

Item Record
Follow standard SC/Ar monograph procedures. Generate smart barcode slips for CLRC
materials. Refer to “Smart Barcode Slips” in this manual for complete instructions.
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Physical Handling
Follow standard SC/Ar monograph procedures. 

Marking: Be especially certain to record copy numbers when adding multiple copies of a
title.

Disposition: Materials may be returned to CLRC through inter-campus mail, unless
materials are particularly valuable or fragile.
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Streamliners Cheat Sheet: Modified for University Archives—
MM Collection

Finding Copy

1. Search Cat module to see if item is an added copy.

� Scan by Title to find and display record.

� If no copy is found, skip to step 2.

� If item matches copy exactly:

� It is not necessary to completely edit bib screen.

� Verify only that University of Minnesota-affiliated persons and/or
departments have access points (if named as author, editor, publisher or
sponsor on title page or verso of title page).

� If you add access points, do any required authority work.

� An added access point may require a corresponding 500 note.

� Modify 040 field with $$dMnU if you have modified record; Save to server.

� Skip to Creating Holdings Record.
2. Search RLIN/OCLC for copy; import record.

� In OPAC, go to File and connect to RLIN or OCLC. 

� Perform a Find search, searching first by ISBN.

� Make certain copy matches book exactly (click Tab 3, MARC tags).

� Push record to CAT.

� Select record’s format & click OK.

� Go to File and Duplicate record.

� You may now edit the bib screen.
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Editing Bib Screen

1. To check LDR, click on the field and press [Ctrl-F] to bring up form. Check only the
following five fields:

Tag Field Name Most Common Values
05 Record status n

c
p

new
corrected
increase in encoding level from pre-publication

06 Type of record a printed language

07 Bibl level m monograph/item

17 Encoding level ^
4
8

full
core
pre-publication

18 Descriptive cataloging a
i

AACR2
isbd

 Click on Help for other values.

2. To check 008, click on the field and press [Ctrl-F] to bring up form. Check only the
following five fields:

06 Type of date

07-10 Date

15-17 Publication place

028 Government publication: s (use for publications by U or M or one of its
departments)

35-37 Language

Click on Help for field values.

3. Variable fields:

040 Add $$dMnU when making substantial change to record.

[CIP: always add $$d]
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1XX/
7XX

Do authority work as required.

� Access points required by the statement of responsibility on the item.

� Additional access points as required to establish a University of
Minnesota connection.

� Do not be concerned whether an access point is tagged 1XX or 7XX as
both are searchable.

245 � Verify accuracy of second indicator (non-filing characters).

� Verify that title proper ($$a) and subtitle ($$b) are correct and complete.

[CIP: same as completed copy, but also verify that statement of
responsibility ($$c) matches t.p. except where the following cataloging
principles apply: “rule of 3,”  “bibliographic significance” of responsible
parties named, and bracketed information taken from source other than t.p.]

246 Use for most added title access points, unless the title is of an analytical
nature, in which case the 740:X2 coding is appropriate.

250 Should be present if item contains a true edition statement.

260 � If you are confident that copy corresponds with the item in hand, accept
260 as is.

� As long as the form or division of publisher’s name in the 260 field of
copy is somewhere in the item, accept it.

� If distributor is on copy, accept; if not, do not add.

� If publication and copyright dates differ, do not add copyright date; it is
not necessary to add “c” to copyright date.

263 Not applicable to completed copy.

[CIP: Always delete.]

300 � Completed copy needs subfields $$a, $$c, and $$b if applicable.

� Do not count pages except for obvious errors, e.g. 160  vs. 610 p.

� If item contains any illustrations, add $$b ill. with no further
elaboration.

� Accept size as stated.

� Accept 300 as is on pre-AACR2 copy.

[CIP: Complete subfields $$a, $$c and $$b if applicable.  Ignore numbered
or unnumbered plates unless they represent a substantial portion of the
item.]
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4XX/
8XX

Do authority work as required.

We trace all series, so there should be either a 440 or a 490 with a subfield 1
and accompanying 8XX field, whenever a series is present.

[CIP:  Check for series information that may not have appeared on item
prior to publication]

5XX � Accept notes as they appear.  Make sure that access points suggested by
5XX notes are present in the record.

� Additional notes may be required to justify added entries for
University of Minnesota-affiliated persons and/or departments (when
named as authors, editors, publishers, or sponsors on title page or verso
of title page).

[CIP: It is important to look for new information, e.g., bibliographies,
indexes, earlier editions with different title requiring an additional access
point.]

6XX Do authority work as required for 600, 610, 611.

At least one 6XX with second indicator 0 required, unless item is a work of
literature by a single author.   (If subject missing, pass on to original
cataloger.)

9XX Accept as is.

4. Save to server.

Creating Gift Acquisitions Record

No acquisition records will be created for this collection.

Creating Holdings Record

1. From File menu, click Load HOL record from server [Ctrl-O].

2. Click Add record.

3. From Edit menu, click Expand from template [Ctrl-E].

4. Highlight holMnU.mrc (Local) and click Open.

5. Open LDR--click on the field and press [Ctrl-F] to bring up form.

Correct values for single-part item:

05 n
06 x
17 1 (encoding level)
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18 n

6. Open 008 form—click on field and press [Ctrl-F|` to bring up form.

Correct values for single-part item:

06 2 complete

12 8 permanently retained

16 4 not applicable, single-part item

7. Complete 940 field.

$$b CAT
$$c YYYY-MM-DD (e.g. 2003-01-15)

8. Complete 852 field.

First indicator  (4=local)

$$a MnU 
$$b TAND
$$c UNA
$$k Size (if Folio)

$$j Call number

9. Complete 866 as appropriate.

Indicators  [blank] 1

$$8 0 
$$z Book plate of:  xxx.

$$z Copy signed by author.

10. Save to server.

Creating Item Record

1. From Holdings Record Push to Items.

2. Click Retrieve HOL on Item List.

3. Select correct holdings record and click Link to Item.

4. Click Modify and then Refresh.
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5. Edit fields as needed.

Most common values:

Item process status blank=not in process 

Item status 02=Non-circulating

Material type BP=Book (Print)

Copy number 0=1

Call number type 4=Local

6. Attach white barcode label at top of back cover and wand in.  If your scanner is
not programmed to enter after a scan, click Update.

7. General Information (Tab 2)—If required for Pieces (indicate in Circ note).

Record Statistics
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Serials

E-Journal Copy Cataloging

Online Record
Note: The University of Minnesota Libraries use the CONSER one-record option (adding

information on online access to the print record) unless they do no hold the print version
of the journal or the journal is available only online.

The steps involved in this process are discussed in more detail below.

Step 1 Search catalogs and pass record into MNCAT.

Step 2 Update the Bibliographic Record.

Step 3 Create a holdings record. 

Step 4 Create an item record.

1. Search Catalogs and Pass Record into MNCAT

1. Search MNCAT for the title. If the Libraries do not hold the title, search OCLC or
RLIN for the online record.  

2. Pass the record into MNCAT.  

3. If no record is found, give to a serials cataloger.

2. Update the Bibliographic Record

The online record should have the following fields:

006
(Computer file)

Form of material
(00)
Type of computer
file (09)

m

d
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007
(Computer file)

Category of
material (00)
SMD (01)
Color (03)
Dimensions (04)
Sound (05)

Ignore remaining
tags.

c

r
c
n
u

008
Serials fixed
fields

Date 1

Form of item
Form of original

Year of beginning online coverage (This
should be changed if online coverage changes.)

s
s

If the online resource has an online ISSN listed:

022:   : $$a online ISSN

If the online resource has the online and print ISSNs listed:

022
ISSN

022:   : $$a online ISSN
$$a print ISSN

362
Online coverage

If online coverage does not begin with the first issue of the title, the
record should have an unformatted 362.  This field can be adjusted as
coverage expands to include earlier issues.

 
Example

Record has the following unformatted 362 stating the
coverage began with v. 15, but the earliest issue now
available is v. 14:

362:1 : Coverage as of (March 16, 1999): Vol. 15, no.
1 (Jan. 1999)-
Change the coverage statement:

362:1 : Coverage as of (today’s date): Vol. 14, no. 1
(Jan. 1998)-
Change the first fixed field date to reflect the earliest
year of coverage.

500
Description
based on note

This note should not be altered if online coverage changes.
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538
System
requirements
(optional)

This is an optional note, but should be placed before the 538 Mode of
access note.  

This note should be restricted to specific hardware or software
requirements. Avoid mentioning the need for “Internet connection
and World Wide Web browser.”

538
Mode of access
(mandatory)

538:   :

538:   :

Mode of access: World Wide Web.  (856 has URL with
www)

Mode of access: Internet.  (856 that does not have URL with
www)

506
Access
restrictions

If the online serial is a licensed resource, there might be a generic
statement about access being available only to subscribing
institutions.

515
Numbering
peculiarities

515:   :

515:   :

Continuously published articles are cumulated into
volumes.

Successive articles are uniquely identified by a manuscript
number and date.

516
Type of
computer file
or data

516:   :

516:   :

516:   :

516:   :

516:8  :

516:8  :

HTML and PDF

HTML (electronic journal)

Text (electronic journal)

Text and graphic

Written in ISO 9660 and dBase III format

Electronic journal available in ASCII, Acrobat, and
PostScript file formats

530
Additional
physical form
available

This note is used to note the existence of one or more versions in
different physical formats.  Use the following note when a print
version exists:

530:   :     Online version of the print publication.

590
Local note to
enhance
retrieval

For all electronic serials add a 590 :   : ejour  to the bibliographic
record.
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6XX
Subjects

Treat electronic serials like other serials and include appropriate
subjects.
Note: There are several subject headings or subdivisions that

describe electronic resources (Computer network resources,
Electronic journals, E-zines, Electronic newspapers). None of
these are form subdivisions. Use print form subdivisions ($$v
Periodicals, $$v Directories).

7XX
Linking fields

Other relationships should be identified as needed:
� Editions (775)

� Supplements (770, 772)

� Other physical formats mentioned in 530 (776)

� Preceding/Succeeding titles (780/785)

730
Added entry –
Uniform title

A 730 is added if the print title differs from the online version.

Record for online:

245:00:

530:    :

730 :0 :

776 :1 :

DGRweb $$h [electronic resource].

Online version of the print publication.

Directory of graduate research.

$$t Directory of graduate research $$w
(DLC)sn 79003432 $$w (OcoLC)5229212

Record for the print:

 
Example

245:00:

530:    :

730 :0 :

776 :1 :

Directory of graduate research.

Also available on the World Wide Web.

DRGweb.

$$t DGRweb  $$w (DLC)sn 99034838 $$w
(OCoLC)4752026
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776
Other physical
formats

This is one of the most frequently used linking fields. The example
below illustrates its use:

Record for print:
245:00:

530:    :

776 :1 :

Banks in insurance report.

Also available on the World Wide Web.

$$t Banks in insurance report (Online) $$x
1530-9991

Record for online:

 
Example

130:0  :

245:00:

530:    :

776 :1 :

Banks in insurance report (Online)

Banks in insurance report $$h [electronic
resource].

Online version of the print publication.

$$t Banks in insurance report $$x 8756-6079
$$w (OCoLC)14239346

856
Electronic
Location and
Access

If the online resource is licensed, remove any URLs from the
bibliographic record.  The appropriate URLs for the University of
Minnesota should be placed in the holdings record.

If the online journal is not a licensed resource, leave the 856 on the
bibliographic record.

3. Create a Holdings Record

Please refer to the “TINTE Holdings Record” procedure in this manual.

4. Create an Item Record

1. Create a TINTE item record by pushing the title to the Items module.  If a TINTE
item record already exists, do not add another.  Only one item record is needed to
represent the TINTE holdings even though there are multiple 856 fields in the
holdings.
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2. On the item record complete the following fields:

� Tab 1

Material type: SE
CF
ER
WS

(electronic serial),
(computer file),
(electronic reference), or
(web site)

Item status: 07

Item process status: blank

HOL link: Select the TINTE holdings.

� Tab 3

Arrival date: Enter date of item creation.
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Adding Online Access to Print Records
Note: The University of Minnesota Libraries use the CONSER one-record option (adding

information on online access to the print record) unless they do no hold the print version
of the journal or the journal is available only online.

The steps involved in adding online access to the print record are discussed in more detail
below.

Step 1 Update the print bibliographic record.

Step 2 Create (or edit) a TINTE holdings record. 

Step 3 Create an item record.

1. Update the Print Bibliographic Record to Reflect Online Access

1. Add fixed fields: 006 (additional material characteristics) and 007 (remote computer
file).

006 (Computer file)

Form of material (00) m
Type of computer file (09) d

007 (Computer file)

Category of material (00) c
SMD (01) r
Color (03) c
Dimensions (04) n
Sound (05) u

Ignore remaining tags.

2. Add 530:  : $$a Also available on the World Wide Web.

3. Add 590:  : $$a ejour (used for retrievel).
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4. Add a 740 title added entry when the title of the online version differs from the print.

Example

130:0  :
245:00:
740 :0 :

RBM (Paris, France)
RBM : $$b revue européenne de biotechnologie médicale.
$$a RBM news.

5. If a separate ISSN has been assigned to the online serial but a separate record doesn't
exist, add field 776:1 : $$t $t and $x online ISSN

6. If a resource is free to the world, add 856 with the URL in $$u.  The indicators for
use with the one-record option: 41.  If the resource is licensed, the 856 should be
placed in the Holdings record.

Add any coverage or explanatory notes in separate subfields z.  For order of notes and
examples, see instructions below in the Holdings record information.

Example of print record below has the added 006, 007, 530, 590 and 776 fields.
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2. Create a TINTE Holdings Record

Please refer to the “TINTE Holdings Record” procedure in this manual.

3. Create an Item Record

1. Create a TINTE item record by pushing the title to the Items module.  If a TINTE
item record already exists, do not add another.  Only one item record is needed to
represent the TINTE holdings even though there are multiple 856 fields in the
holdings.

2. On the item record complete the following fields:

� Tab 1

Material type: SE
CF
ER
WS

(electronic serial),
(computer file),
(electronic reference), or
(web site)

Item status: 07

Item process status: blank

HOL link: Select the TINTE holdings.

� Tab 3

Arrival date: Enter date of item creation.



University of Minnesota Aleph Cataloging Manual Page 152
Issue Date: 11-05-2002 Cataloging Procedures
Revised Date: 03-20-2003 Serials: TINTE Holdings Record

Author: Cecilia Genereux

TINTE Holdings Record
A TINTE holdings record is created, if one does not already exist, when cataloging
internet resources or online serials.  To add a new holdings record click Ctrl O or under
the File menu select Load HOL record from the server.  Click Add record to create a
new TITNE holdings record or click Edit record to edit an existing TINTE holdings
record.  

The following are instructions for completing the holdings record:

� Complete the LDR.

Record status (05)

Type of record (06)

Encoding level (07)

Item inf. in record (18)

n

y

3

n

� Complete the 008.

Receipt status (05)

General retention (12)

Completeness (16)

1

0

0

� Add a 940.
More detailed information on the 940 field is available in the “HOLdings Record
Field Values” section of “Aleph Codes and Lists.”
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� Add URLs.
If the resource is licensed, add 856 with URL obtained from vendor list or selector
(occasionally from ITS).  The URL for licensed materials must include the
proxy/counter URL at the beginning of the vendor URL.

Indicators used with the print record: 41.

856:41: $$u http://ej.lib.umn.edu/?url=http://muse.jhu.edu/journals/fhs/
Indicators used with the online record: 40.  

856:40: $$u http://ej.lib.umn.edu/?url=http://muse.jhu.edu/journals/fhs/ 

Sequencing of URLs
Catalogers do not have to consider sequencing of URLs when adding the first URL,
but multiple URLs have caused problems for public service.  Use this procedure and
order of URLs only when there are URLs from more than two sources or vendors:

1. Direct access URL(s) first (from society or association sponsoring journal, for
example)

2. Access to recent issues (such as Project Muse)

3. Back issues (such as JSTOR)

Place ECO and OVID URLs last (OVID last, in all instances).

� Add notes to URLs.
All notes are added in $$3 before the URL or in $$z after the URL in this order:

1. Coverage

2. Access note

3. Explanatory notes

1. Coverage (only if holdings are known and are stable); e.g.,

Example

$$3 Oct. 1995-
For JSTOR:

For Project Muse:
$$3 Back issues: v. 1 (1995)-

$$3 Recent issues.

This note should come before the $$u containing the URL.  If holdings are not stable
or cannot be covered by above examples, add an 866 to the holdings record:

866:31: $$8

$$z

0

Check Internet address for current coverage.
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2. Access note:
An access note is added to all licensed materials:

$$z  Access for the University of Minnesota, Twin Cities only.
If there are no restrictions, no access note is necessary.

3. Explanatory notes:

$$z  Select “Full text: all collections.”

$$z  Click on “Browse Journals.”
Text will vary depending on pathway.

The example below is a TINTE holdings record with multiple URLs that contain
coverage and access notes.
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Publication Patterns Workflow
In order to expedite serial check-in we will want to have publication patterns on as many
active journal titles as possible. Some publication data will come from outside sources.
Other patterns will be created using templates stored in the Aleph system, while still
others will have to be created by modifying existing templates or creating them from
scratch. There will always be those titles that come so irregularly that a pattern will not
work. These titles will have to have item records created manually for each issue.

Initially, we anticipate that many staff will be involved in setting up publication patterns
for existing titles. There will also be considerable clean-up of serial holdings as NOTIS R
statements were converted to multiple 866 (textual holdings) fields in the holdings
record. These statements will have to be deleted once an appropriate item record is
created for the issue, either manually or by a publication pattern. Converted records
should also be checked to make sure they have a subscription record, which is linked to
the order and holdings record. Specific steps for conversion clean-up are in development.

Below is a tentative workflow for the ordering of new serial titles and the establishment
of publication patterns.

Processor (Before Title Is Cataloged)
� 1st issue of a volume arrives

� Update order record

� Review and update Order Log as needed

� Update Note field on Order record as needed

� Push record to Serials module

� Update Subscription Record (adding relevant processing notes in Check-In notes field

� Retrieve Holdings Record (button in Subscription List window) and link to
subscription record 

� Change Item Processing Status in Item Record to "In Process"

� Forward piece to Cataloger

Cataloger
� Catalog title

� Load Holdings Record from server and Edit holdings record

� Push record to Serials module
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� Delete Item record

� Push record to Catalog ADM and create Publication patterns record

� Open Publication Schedule window in Serials

� Click on Schedule Form to view pattern for accuracy. Accept pattern or cancel out of
Schedule form. Revise patterns and reopen Schedule Form to review for accuracy.
Accept and Continue if pattern looks correct.

� Return to Processor for Check-in 

Processor (After Issue Has Been Returned From Cataloging)
� Update Order Record and Order Log

� Update Subscription Record as needed

� Check Item Status and make sure status is set properly for Sub-library the
subscription is for.

� Add/Update processing notes in Subscription Record Check-In notes field.

� Open Issues

� Arrive issue
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Special Formats

Completing Holdings and Items for LRC Materials (MAC)
Complete holdings and items records for audiovisual materials to be housed in the
Learning Resources Center according to standard procedure with the exceptions detailed
below. This procedure applies to videocassettes, DVDs, audiocassettes, audio compact
discs, and CD-ROMs. For other types of LRC materials, consult the Special Formats
Coordinator.

Completing the Holdings Record
LRC materials are shelved in closed stacks by accession number. LRC staff assigns an
accession number when an item arrives at the LRC. For this reason, MAC staff
cataloging LRC materials should not enter an LC call number in the holdings record
(though one may still be assigned and entered on the bib record). Instead, complete field
852 as follows:

� The first indicator of the 852 field is 4, not 0 as it would be for an LC call number.

� Subfield j is used instead of subfields h and i. Subfield j should contain the phrase “In
process,” which serves as a placeholder until LRC staff update the holdings record
with the assigned accession number.

� Remember to supply 866 fields when appropriate.

Completing the Item Record
Complete specified fields in the item record according to the table below:

Field Value
Material Type Supply the appropriate value. Most common values: 

� VR (videorecording)

� SD (sound recording)

� CF (computer file)
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Field Value
Item Status � Use 04 (In Library Use) for all videorecordings (videocassettes and

DVDs)

� Use 12 (One Week Loan) for all other materials

Circ. Note (Tab 2) Enter a note indicating the number of pieces the item has according to
the following example:

Pieces: 3

Note: Under some circumstances, the cataloger may need to create additional item records for
an entity with multiple pieces. As a general guideline, a single item record is usually
sufficient when all of the pieces fit into a single container (plastic videocassette box,
vinyl portfolio, etc.) Multiple item records are needed when this is not the case. If in
doubt about the number of item records required for a specific item, consult LRC staff or
the Special Formats Coordinator.

Choosing and Placing the Barcode
Apply a red or white barcode and place it on the item according to the table below. If in
doubt or faced with a situation not covered below, use a red barcode placed in the least
conspicuous spot on the outside of the item’s container.

Type of Item Barcode Type Placement
Videocassette Red Place barcode on outside of container in the

least conspicuous location. Try to avoid covering
textual information.

DVD White Place barcode inside container centered above
disc carrier, if adequate space. If not, place
centered below disc carrier. If DVD is in
nonstandard container, use a red barcode and
place according to instructions for videocassettes
above.

Audio CD or CD-ROM
in jewel box

White Place barcode centered on upper back of jewel
box (as for a book).

Set of audiocassettes in
a container

Red Place barcode centered on upper back of
portfolio or container (as for a book). Adjust
placement if necessary to avoid covering text.

Single audiocassette in
standard plastic
container

White Place barcode on the lower front of the container
(orient the container upright as if it were going to
be opened like a book).
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Recording Sublibrary, Collection, and System ID
Sublibrary and collection codes and System ID numbers should be written on LRC
materials whenever possible. The table below describes how this should be done for
various types of materials. If in doubt or faced with a situation not covered below, write
the system ID number on a slip of paper to be kept with the item.

Type of Item Instructions
� DVD

� Audio CD

� CD-ROM

Use a black fine-point Sharpie pen to write the sublibrary,
collection, and system ID number on the innermost, usually
clear ring of the disc itself.

� Videocassette

� Audiocassette

Use a pencil to write the information on the cassette label.

� Books, booklets or
pamphlets accompanying
other materials

Use a pencil to write the information in the upper-right hand
corner of the page after the title page (book) or the first page
(pamphlet).
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Gift Processing

Processing One-Time Gifts (Monographic or Serial)

Find, Import, or Create a Bibliographic Record
� Search Aleph for bibliographic record.

� If no record exists in Aleph, search OCLC and/or RLIN and import a bibliographic
record if found.

� If no record exists in OCLC or RLIN, create a bibliographic record in the cataloging
module using a cataloging template.

Save the record to the server if you are not using an existing Aleph bibliographic record.

Create an Order Form in the Acquisitions Module

An Order Form must be filled in for all gifts. Push the bibliographic
record into the Acquisitions module by clicking the Acquisitions icon:

A Navigation Window and Order List window displays:
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From the Order List window in the
Acquisitions module, click Add. An
Order Type window displays.

Accept the prompt for Order Type
Monograph, click OK.

Exception: If the gift is open ended, and you think we will be receiving additional volumes as
gifts, choose Standing Order as the Order Type, and click OK. An Order Form
displays.

Subsequent volumes received as gifts are added to the gift order record by adding
an Arrival and creating a new Item Record for the volume.

(Requests for gifts from specific vendors, or gift subscriptions are handled
differently.)
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Fill in the Order Form

Tab 1. Order Information

Order Status: Change to CLS.

Order Number 2: Enter selector’s name.

Order Group: Enter the name of the unit processing the gift. (Click on the
arrow to the right of the field for a list of possibilities.)

Material Type: Choose the appropriate values for your material. (Click on the
arrow to the right of the field for a list of possibilities.)

Sub-library: Choose the appropriate Sub-library. (Click on the arrow to the
right of the field for a list of possibilities.)

Acquisition method: Enter GI for Gift.

Borrower ID: If patron notification is requested click on the arrow to the
right of the field to find, highlight and select the patron name.
This will place a hold on the record for the patron.
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Tab 2. Vendor

Click on tab 2. Vendor to display the Vendor Tab of the Order Form.

Vendor code: Enter GIFT and press the Enter key, or if you wish to associate
the gift with a specific vendor, enter the specific vendor code, or
find it in the Vendor List by clicking the arrow to the right of the
field.

Rush: Click on the Rush box if the title is to be rush cataloged.



University of Minnesota Aleph Cataloging Manual Page 164
Issue Date: 09-06-2002 Cataloging Procedures
Revised Date: Processing One-Time Gifts (Monographic or Serial)

Author: Lois Christian Approved by ACG and CCG 09-04-2002

Tab 3. Quantity and Price

Click on tab 3. Quantity and Price to display the Quantity and Price tab of the Order
Form.

Number of units: Enter the number of volumes you are processing. The
number you enter here will cause the same number of Item
Records to be created. (For multiple copies, complete a
separate Order Form for each copy.)

Create Item Records: Accept the default checked box to automatically create Item
Records. Uncheck this box only if you do not want to create
an Item Record.

Item Collection: Enter the appropriate value (Click the arrow to the right of
the field for a list of possibilities.)

Encumber budget: Enter a budget only if you want to associate the gift with a
budget (usually only for serial gift subscriptions).
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Click OK to redisplay the Order List with the newly created order:

Saving Defaults
Saving defaults works best if gift processing is the only type of acquisitions activity that
you perform. If you perform other acquisitions activities, a gift macro might work better
for you.

When you fill in the Order Form, you often enter much of the same information for all
or most of your orders. To save re-keying this information, the Save Def button can be
used to record certain information and automatically insert it into the Order Form when
you create new order records.

To save this default information, fill in an Order Form with all the data you wish to save
as default, and then click the Save Def button before clicking OK. The next time you
open an Order Form, this data will be inserted for you.
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The following fields can be saved by the Save Def button, for automatic insertion into
other orders:

� Order status � Library note

� Order number 2 � Vendor code

� Order number 3 � Rush

� Order group � Batch claiming

� Material type � Number of units

� Sub-library � Unit price

� Acquisition method � Quantity note

� Borrower ID � Item Collection

� Send directly � Price note

To remove previously saved defaults, click File or use Alt + f. Click Delete order
defaults.

Record Arrival of the Material

From the Order List click the Arrival button. A
dialog box will tell you the order is closed and ask if
you want to continue. Click Yes.

An Arrival List displays:
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Click Add to display an Arrival Form:

No. units arrived: Enter the number of units (or volumes) you have in hand.

Note: Enter specific volume information if you have multiple
volumes or a specific volume in a set.

Click OK to record the arrival.

Click Close to close the Arrival List and return to the Order List and Navigation
Window.
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Add a Holdings Record
From the Navigation Window in the Acquisitions Module, click the Catalog HOL
button to push the record to the Cataloging Module and open the Holdings List:

� Click the Add record button.

� From the menu click Edit, then Expand from template.

� Select hol.mrc (local) and click Open.

� Edit the Holdings record as needed and save it to the server.

Modify the Item Record

Push the record to the Items Module by clicking the Items icon:
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An Item List displays:

� With the gift item highlighted, click Modify.

� Check the Hol link field for the presence of a link.

� Wand in real barcode and edit fields as needed.
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One-Time Gift Processing Job Aid
1. Find, import or create a bibliographic record and save it to the server if necessary:

� Search Aleph, if no record in Aleph,

� Search OCLC and/or RLIN and import, if no record in OCLC or RLIN,

� Create a bibliographic record using an appropriate cataloging template.

2. Push the record to the Acquisitions module.

3. Click Add to add an order record:

� Usually choose the Monograph order type

� If the gift is open ended and you think we’ll be receiving additional volumes as
gifts, choose the Standing Order order type. Subsequent gift volumes are added to
the order record by adding an Arrival and creating a new Item Record.

4. Fill in the Order Form (You can Save Defaults for these values.):

Order Status CLS

Order Number 2 Selector’s name

Order Group Unit processing the gift

Material Type Choose appropriate value

Sub-Library Choose appropriate value

Acquisition Method GI

Borrower ID If patron request

Vendor Code GIFT

Rush If rush catalog request

Number of Units Number of volumes you’re processing. Fill in another
Order Form for multiple copies

Create Item Records Leave checked unless you do not want Item Records

Item Collection Choose the appropriate value

Encumber Budget Use only if associating the gift with a budget

� Click Save Def if you want to save defaults for these values.

� Click OK.
5. Record arrival of the material

� Click the Arrival button and continue by clicking Yes on the dialog box.

� Click Add to display the Arrival Form
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� No. of units: Enter number of volumes you have in hand

� Note: Enter specific volume information if you have multiple volumes or a
specific volume of a set.

� Click OK.

� Click Close.

6. Push the record to the Cataloging module by clicking Catalog HOL on the
Navigation Window.

7. Add a Holdings record.

� Edit and fill in the Holdings record as appropriate.

� Save the Holdings record to the server.
8. Push the record to the Items module.

9. Highlight the gift item and click Modify to display the Item record.

� Wand in the real barcode and edit fields as needed.

� Click Update.
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One-Time Gift Processing Workflow

One-Time Gift Processing Workflow*

CREATE ORDER
RECORD FOR GIFT*:

Click Acquisitions
icon to push record

to Acquisitions
module

Navigation
Window & Order

List display

From Order List,
click Add

Select Order Type
Monograph** & 

click OK

Order Form
displays

�If you do not perform other acquisitions activities, it is recommended that you save defaults for completing gift order forms.
�If you do perform other acquisitions activities, it is recommended that you use a macro for completing gift order forms.

Display bib
record (existing,

imported, or
created)

Complete Order
Form using
appropriate

values for a gift***

Tab 1: Order Information
•Order status: CLS
•Order number 2: selector’s last name
•Order group: name of unit processing gift
•Material type: [as appropriate]
•Sub-library: [as appropriate]
•Acquisition method: GI
•Borrower ID: Add if patron notification.

Tab 2: Vendor
•Vendor code: GIFT, or, to associate the gift with a specific vendor, use that code.
•Rush: Check if rush cataloging.
Tab 3: Quantity and Price
•Number of units: Number of volumes/issues you are processing. (For multiple copies,
 complete a separate Order Form for each copy.)
•Create Item Records: Accept default of checked to automatically create item record(s).
 Uncheck only if you do not want to create an item record.
•Item collection: [as appropriate]
•Encumber budget: Enter a budget only if you want to associate the gift with a budget
 (usually only for serials subscriptions).

***ORDER FORM VALUES FOR GIFTS:

ARRIVE GIFT*:

Click
OK

With new order
selected on Order
List, click Arrival

Click
Yes

Arrival List
displays

Dialog
displays with

message: Order
is closed.
Continue?

Click
Add

Enter number of volumes/
issues in hand in No. units
arrived. For multivolume

sets, enter specific
volume info in Note.

Arrival Form
displays

Click OK on
Arrival Form

Click Close on
Arrival List

In Navigation
Window click
 Catalog HOL

Holdings
list displays in

Cataloging
module

Click Add in
Holdings List

ADD HOL RECORD FOR GIFT*:

Return to
Cataloging 
Workflow

*For gift cataloging, steps must be done in this
order to ensure correct linkage between order,
item, and holdings records:

1. Create bib record.
2. Create order record, including item record
    creation.
3. Arrive gift.
4. Create holdings record.
5. Edit item record(s).

For multiple copies, complete a new Order
Form for each copy.

From
Cataloging 
Workflow

**Exception: For open-ended
gifts, if you think we will be
receiving additional gift
volumes, select Order Type
Standing Order.

Last updated 9/6/02
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Analytics and Bound-Withs

Linking Serial Analytics
1. Call up the analytic title’s bibliographic record in the cataloging module.

2. Call up the analyzed (serial) title in the Items module or, alternatively, in the GUI and
push it to items.  View the Item record for the volume you are analyzing, by
highlighting the item and clicking View :

3. Note the System Number of the analyzed title’s ADM record (see circled number
above). This number cannot be copied from anywhere, as far as we are aware.
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4. Add a Dual Linkage field (LKR) to the end of an Analytic record. Press F6 to create a
new field, type LKR, then Ctrl+F will open its form.

The following fields should be completed:

Link Type: will always be ITM

Sys no. of linked doc record: this is the  ADM number (off the Item list)

Library …: will always be UMN50

Volume, part, issue link: fill in the Enumeration and Chronology
information to match the Item Form.

Generally, you should be able to get the correct enumeration information from the
series tracing fields and/or the marking on the piece.  When filled in, the form should
look something like this:



University of Minnesota Aleph Cataloging Manual Page 175
Issue Date: 09-20-2002 Cataloging Procedures
Revised Date: Analytics and Bound-Withs

From: 406 Linking Analytic/Bound With Records Manual

Important Notes:

� The links must match the item record exactly.  Note above, that although the
analytic series statement does not include the “+index,” it must be included in the
issue link, or a match will not occur.

� The subfield order of the LKR form is volume link (Enum A), part link (Enum C),
issue link (Enum B), but the Item record order is enum a, enum b, enum c.  Be
very careful when transferring the information. (We have tried to correct the order
on the LKR form, but have been unsuccessful.)

5. Click OK, and save the record to the server.

6. Check the Web OPAC to make sure the link is good, i.e. availability information
shows.

� Open the Web OPAC.

� Find the analytic record.

� Click on the link for All Holdings and Availability.

� Make sure the correct Circulation Information displays.

Special Instructions for Multi-Copy or Multi-Volume Analytics
There will be instances where multiple copies of an analyzed serial exist, either within
the same sub-library or at different sub-libraries.  As long as the ENUM fields in the item
records are exactly the same, only a single LKR field to the bibliographic record for the
analytic needs to be added to the record.  (If the ENUM is not the same, the data in the
differing fields needs to be fixed or a separate LKR needs to be created.)
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Both copies’ availability will display to the public.

However, multi-volume analytics require multiple LKR fields, in order to show
availability to all volumes of the analytic title.  After the first LKR is created, the field
can be duplicated as many times as necessary, changing the ENUM field(s) for each new
LKR.

This particular serial and its corresponding analytics are held by both Magrath and Bio-
Med.  Because they share an ADM record and the ENUM fields are exactly the same,
both volumes, in both libraries display.



University of Minnesota Aleph Cataloging Manual Page 177
Issue Date: 09-20-2002 Cataloging Procedures
Revised Date: Analytics and Bound-Withs

From: 406 Linking Analytic/Bound With Records Manual

Linking Bound-Withs and IN Analytics
The same basic steps are followed for creating dual linkage for first titles of a bound with
volume and the succeeding titles or for IN analytics, as were followed for serial analytics.
The biggest difference is in the fields that are filled in on the LKR form.  

1. Call up the main/first title in the items module.  (Any module is fine.  However,
looking the title up in the items module, will assure that you are on the bibliographic
record with the item record.)  Note the ADM number from the top of the Item List.

2. Call up the secondary title in the cataloging module and add an LKR field, by
clicking F6; type LKR and press Ctrl + F to open form.

3. Complete the following fields: 

Link Type: will always be ITM

Sys no. of linked doc record: this is the  ADM number (off the Item list)

Library …: will always be UMN50

4. Click OK, and save the record to the server.

5. Check the Web OPAC to make sure the link is good, i.e. availability information
shows.

� Open the Web OPAC.

� Find the analytic record.

� Click on the link for All Holdings and Availability.
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� Make sure the correct Circulation Information displays.

Creating a LKR Template
Expanding from a template, instead of opening the LKR form, may expedite filling in the
LKR subfields.  Since relatively few staff members catalog analytics, we are
recommending that the template be created on local drives, as opposed to the server. To
create a template:

1. Choose book format, after clicking on New Record from the File menu.

2. Click past the forms for LDR, 008, and 260, 300.  

3. Press F6 to add a blank field and type in LKR.

4. Open the LKR form by pressing Ctrl+F and fill in the following subfields:

a ITM

l UMN50

Leave the following fields blank: b, y, v, p, i, k

5. Click OK to get out of the form.

6. Delete the following subfields: n, m, r

The record should look like this:
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7. From the File menu, click Create Template on Local Drive.  The Create template
box will pop up so that you can assign a name to your template, perhaps: LKR.

8. Click OK.  The template will be saved on your local hard drive.

Using the Template
When cataloging an analytic: 

1. Click on Expand from Template from the Edit menu at any point in your
cataloging.  The LKR field is always added to the end of the record, so you may fill
the field in right after you expand or complete it as your last cataloging step.   Make
sure to fill in the necessary LKR subfields.

2. Save to the server.

Holdings Issues
LKR data will match against the same data in every item record in the specified ADM
record, regardless of sub-library.  This works out nicely if all libraries holding a serial are
analyzing the title’s volumes.  However, if only one library has added a holdings
statement on an analytic record and multiple libraries hold the serial the result can be a
confusing display to the public.  

In these circumstances, it will be necessary to create an additional holdings statement for
the other library.  There appear to be two options: notify the non-analyzing library to add
the holdings or have the analyzing library add an additional holdings statement,
especially since staff will already be on the record.  Workflow will have to be worked out
for these situations.

Maintenance Issues
The exact nature of the data in the LKR poses issues for analytic cataloging workflow
and/or maintenance of analytics. Many analytics are cataloged when they are unbound
journal issues.  This usually means that there are additional Enum fields than there would
be for the bound issue.  Therefore, if the unbound serial analytic includes a LKR field,
e.g. $$v59, $$i4 and the issue is bound with others later, the link will be broken because
the system cannot match the Enum data between the analytic LKR and the bound serial
volume item record.  The display will result in the return of the “Check shelf if
print/microform resource…”
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Transfers
Note: These procedures do not include transfers to Law Library or MLAC.

Transferring an Entire Set or Single Volume Monograph 
Use this procedure to transfer an entire set or a single volume monograph, i.e., when no
volumes will remain in the original location.

Sending Unit
If you are actually sending physical volumes to another location, before sending them,
add to the Holdings Record an 852 |x note on the transfer, including names and date
sent, e.g., v.1-8 sent from D. Wdowychyn to M. Kraus, 11/4/02.

Receiving Unit

Holdings Record

1. Retrieve the Holdings List.

� If a volume is in hand, search by barcode in the Items Module, then click
Retrieve HOL from the Item List to display the Holdings List. 

� If a volume or barcode is not available, find the title in Cataloging Module and
from the menu select File / Load HOL record from server.

OR

Find the title in the GUI OPAC, click Add to Nav. Map, then from the
Navigation window click Catalog HOL.

2. With the correct Holdings Record highlighted in the list, click Edit.

3. Edit the Holdings Record to reflect the new sub-library/collection and save changes:

� 852  Edit |a, |b, and |c only if the transfer:

|a Involves an NUC code change, i.e., among  Minneapolis (MnU), St. Paul
(MnSU), Bio-Med (MnU-B), and Law (MnU-L).

|b Is between sub-libraries, e.g. from Forestry (TFOR) to Magrath (TMAGR).

|c Is between collections within a sub-library, e.g. from Reference (REF) to the
General Collection (GEN).
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� 940: Transfers will contain a 940 field with |b UPD. For complete instructions on
updating the 940, including whether to modify an existing 940 or add a second
940 field, refer to Aleph HOLdings Record Fields.

The set was cataloged in NOTIS
and is being transferred:

940__$$a MNUB $$b UPD $$c 2002-11-22

Example The set was cataloged in Aleph
and is being transferred.

940__$$a MNSU $$b CAT $$c 2002-10-12
940__$$a MNSU $$b UPD $$c 2002-11-22

� For transfers involving reclassifications, change other holdings fields as needed.

Item Record(s)

4. Sub-library/collection information on all items linked to the holdings record will
automatically be updated. However, you may need to change the Copy Number (if
copy 2 or greater), Item status (if the loan period varies between old and new
locations), and/or Item Process Status.

Order/Subscription

5. If the order/subscription is still active, consult acquisitions policies on transferring
orders/subscriptions to another sub-library/collection.

Transferring Only Some Volumes of a Set
Use this procedure to transfer some, but not all, volumes of a set to another location.

Sending Unit
If actually sending physical volumes to another location, before sending them, the
sending unit should:

� Add to their Holdings Record an 852 |x note on the transfer, including names and
date sent, e.g., |x v.7-8 sent from L. Gries to P. Mills, 11/11/02.

� Update their Holdings Record’s 866, 940, and any other fields necessary to reflect
volumes being removed.
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Receiving Unit

Holdings Record

1. Retrieve or create a Holdings Record for the new location:

� To retrieve an existing Holdings Record, follow steps 1 and 2 under
“Transferring an Entire Set or Single Volume Monograph.”

� To create a Holdings Record if one does not exist for the new location:
a. In Cataloging Module select File / Load HOL record from server from the

menu.

OR

In the GUI OPAC, click Add to Nav. Map, then from the Navigation
window click Catalog HOL.

b. Click Add.

2. On the new location’s Holdings Record, modify/create the 866, 940, and any other
fields necessary to reflect transfer of the volume(s), and save the changes.

3. Write down the Holdings Record number. (This is the number on the Holdings
Record that appears in the blue title bar and is identified as a system number.)

Item Record

4. Retrieve the Item Record.

� If the volume is in hand, search by barcode in the Items Module.

� If the volume or barcode is not available, find the title in Cataloging Module and
use the icon to push to the Items Module.

OR

Find the title in the GUI OPAC and click Items to push to the Items Module.

5. An Item List will display. If the item was searched by barcode, it will be highlighted.
The procedure for modifying the Item Record(s) depends on the number of volumes
being transferred:
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5a. To transfer one volume:

� With the item to be transferred
highlighted, click Global Changes to
display the Global Changes form.

� On the form, change HOL Link to link
the item to the new location’s holdings.

� Sub-library/collection information on
all items linked to the holdings record
will automatically be updated.
However, you may need to change the
Copy Number (if copy 2 or greater),
Item status (if the loan period varies
between old and new locations), and/or
Item Process Status.

� Click OK.

� Click Yes on the Confirm Changes
box that displays.

5b. To transfer multiple volumes:

� From the Item List, click Bind/Changes to display the Items List for Binding.

� Select the volumes to be transferred from the list on the left. (Use the Shift or
Ctrl key to select multiple volumes.)

� Click the right arrow to copy the selected volumes into a list on the right.

� Select the volumes in the list on the right and click Changes to display the Global
Changes form.



University of Minnesota Aleph Cataloging Manual Page 184
Issue Date: 11-27-2002 Cataloging Procedures
Revised Date: Transfers

Authors: Cecilia Genereux, Sue Koelmel Approved by CCG 11-13-2002

� On the form, change HOL Link to link the selected items to the new location’s
holdings.

� Sub-library/collection information on all items linked to the holdings record will
automatically be updated. However, you may need to change the Copy Number
(if copy 2 or greater), Item status (if the loan period varies between old and new
locations), and/or Item Process Status.

� Click OK.

� Click Yes on the Confirm Changes box that displays.

� Click Cancel on the Items List for Binding to return to the Item List.

6. The Item Record changes have been made, and the system has automatically updated
the sub-library, collection and call number based on the link to the Holdings Record.
However, the Item List is not automatically refreshed. To view the changes, select an
item and click Modify.

7. It is always good practice to check one of the moved Item Records to make sure that
all appropriate data has been changed and that no fields were missed.
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Withdrawals

Withdrawing a Volume
To withdraw volume(s) from a set, when at least one volume remains, use this procedure.

Item Record
1. Retrieve the Item Record.

� If the volume is in hand, search by barcode in the Items Module.

� If the volume or barcode is not available, find the title in Cataloging
Module and use the icon to push to the Items Module.

OR
Find the title in the GUI OPAC and click Items to push to the Items Module.

An Item List will display. If the item was searched by barcode, it will be highlighted
in the list.

2. With the item to be withdrawn highlighted, click Modify to display the Item Form.
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3. On Tab 1 of the Item Form,
change Item Process Status
to WD (Withdrawn).

4. Click Update.

5. Repeat steps 2-4 for each
additional volume to be
withdrawn from the set.

Holdings Record
6. Display the Holdings Record by clicking Retrieve HOL from the Item List to

display the Holdings List, and then, with the correct record highlighted in the list,
clicking Edit.

7. Edit the Holdings Record:

� Check the values in the LDR field, especially 06 and 17, to make sure that they
are correct for the multivolume title.
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� Check the 008 field, especially Completeness (16), to make sure that the values
reflect the correct information for the volumes that remain.

� Modify the 866 to reflect withdrawal of the volume(s).

� Change the 940 or create one, where |a<institutional symbol>, |b UPD and |c is
today’s date.

8. Save Holdings on server and local drive.

Withdrawing a Copy
To withdraw the last remaining or only volume for a copy, use this procedure.

Item Record
1. Retrieve the Item Record.

2. With the item to be withdrawn highlighted, click Modify to display the Item Form.

3. On Item Form Tab 1, change Item Process Status to WD (Withdrawn).

4. Click Update.

5. Repeat steps 2-4 for each additional volume to be withdrawn from this set.
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Holdings Record
6. Display the Holdings Record by clicking Retrieve HOL from the Item List to

display the Holdings List, and then, with the correct record highlighted in the list,
clicking Edit.

7. Edit the Holdings Record:

� Change the LDR Record status to d.

� Add 852 |x wdr

� Change the 940 or create one, where |a<institutional symbol>, |b DEL and |c is
today’s date.

� Add an STA field with |a SUPPRESSED
Note: A shortcut is to type S and press the Tab key.

8. Save Holdings on server and local drive.
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Withdrawing the Last Copy
To withdraw the last or only copy linked to a bibliographic record, follow “Withdrawing
a Copy” steps 1-8 for Item and Holdings records, then do the following:

Bibliographic Record
9. Display the bibliographic record by clicking Catalog BIB from the Navigation

Window in either the Items Module or GUI OPAC.

10. Edit the bib record:

� Change the LDR Record status to d.

� Add an STA field with |a DELETED.

Note: A shortcut is to type D and press the Tab key.

11. Save bib record on server and local drive.
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Reinstatements (NOT YET AVAILABLE)
To be written.
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Cat Seps
Cat Sep Cataloging Workflow

Cat Sep Cataloging Workflow

Cataloger
receives cat sep with

 location & order number
(for standing order)

written in piece or slip
of paper in piece

Search
Aleph

Check copy
against piece,
edit as needed

Need
series auth

record in Aleph/
other auth

work?

Yes

No

Click
Update

Send to
marking

*HOL fields to edit:
•LDR (different for multivolume)
•008 (different for multivolume)
•852: call#
•940: |a, |b, |c

**If scanner is programmed  to enter
after scan, make wanding barcode the
last step on item record.

Additional
volumes?

Yes

No

Edit HOL
as needed*

BIB RECORD:

Select item in
list & click
Duplicate

Save bib record
on server &
local drive

To
Authority 
Workflow

Multi-
volume?

Yes No

Save
HOL to
server

Add 866;
add 867,
868 as
needed

Multi-
volume?

Yes

No

Enter volume
designation in
 Description

Item has
pieces?

Yes

No

Indicate in
Circ. Note,

e.g., 2 pieces;
CD and text

To Overlay
Bib Record 

Workflow

Check error
messages  & correct

or override as needed

Push to
Items module

ITEM
RECORD(S):

•For LDR & 008, click on field,
 then from menu click Edit/
 Open form  to display/edit.
•It is not necessary to delete
 9XX fields or SID.

Route
for auth work,
call #, etc.?

Change
Item

process
status to

blank (not
 in process)

Change Item
process
status to

In process
& add

appropriate
Internal

note code

Yes No

Edit fields in
new item as

needed

Click
Add

Click
Refresh

System
supplies fields

based on
first item

If dummy
barcode is

present, wand
in real one**

Last updated 3/12/03

Yes Bib
record
found?

No

Search
resource files

Record
found?

No

Yes

No

Need
better
copy?

Yes

Complete
template to

create bib recd
on desktop

Import
record

HOL RECORD:

From menu click
Edit/Expand from
template. Select
the appropriate
hol.mrc (local)

template &
click Open

Add
852 & 940

Click File/Load
HOL record
from server

Edit fields as
needed:
Copy #,

 Material type,
Item status

In Order number
 enter number

exactly as written
in piece or

on slip
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Lost Holdings/Bibliographic Record Links

When to Use
This procedure is covers the situation when the bibliographic record becomes
disconnected from the holdings and items and the items can still be viewed in the Items
window of the Serials module or in the Items module.

Catalogers will need to create a new holdings, relink the items and relink the subscription
record (if there is an active subscription). 

Procedure
The following steps walk through this process:

Holdings Record
1. Create a new holdings record, including summary statements.

� In order to accurately re-create the summary statements in the 866 fields, check
the shelves to determine what the library owns.

� Determine if a “Latest edition in” or “Keep latest issue” note needs to be added to
the holdings.  Depending on the order type, the information will be in different
places:

O-type orders: Library note field on Tab 1 of the order record.

S-type orders: Check in note field on Tab 2 of the subscription
record.

Converted orders that
have not been cleaned up:

Review the DIV note in the order log for that order.

� Once you have re-created the holdings record, save the new holdings record to the
server and write down the holdings number.  The holdings number is the number
that appears in the blue title bar for that holdings record and is identified as a
system number.
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Item Record(s)
2. The items linked to the lost holdings need to be transferred to the new holdings.

� Push the bibliographic record to the Items module.

� In the Items list window of the Items module, click on an item to highlight it.

� Click the Bind/Change button.

� A window with two columns will open.  From the left column, select all items to
be moved by clicking on the item.  The item to be moved should now be
highlighted.

� Once all items to be relinked are highlighted, click on the arrow pointing to the
window on the right.  All the selected items should now appear in the right
column.

� Select/highlight all the items in the right column.  Click the Changes button.

� A Global Change form will open with the top portion grayed out.

� In the lower portion of the form complete the following fields:

HOL Link: Enter the holdings number for the new holdings.

� Click OK.

� You will get a message asking you to confirm the change.  Click Yes.

� The Item list window in the Items module does not refresh automatically to reflect
the changes you have just made.  To double check that the items are now linked to
the new holdings, select an item and click Modify.  Check the HOL link field to
be sure the item is linked to the new holdings record.  The field is located on the
bottom of Tab 1.

Subscription
3. Next, if there is an active subscription associated with the lost holdings record, relink

the subscription record to the new holdings record.

� Push the bibliographic record to the Serials module and open the Subscription list
window.  

� Select the appropriate subscription record and click on the Retrieve Hol button.
A list of holdings record numbers associated with the title will display.  

� Select the number for the new holdings that was just created and click the Link to
copy button.
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Moving Items Between Bibliographic
Records
Note: Staff must have appropriate Aleph security to move items between bibliographic records.

If you are unsure if your security level allows this, contact Sue Koelmel
(s-koel@tc.umn.edu) for information.  You may need to get someone else to complete the
task or talk to your supervisor about upgrading your security.

Option 1: Delete and Re-Create the Item

When to Use
� When an item was created in error on the wrong bibliographic record.

� No circulation data (loans, fines, etc.) are connected to the item.

Steps Involved

1. Delete the item placed on the wrong title.

2. Create a new item on the correct title.

Option 2: Moving Items Between Bibliographic Records

When to Use
� Use Option 2 when an item needs to be moved from one bibliographic record to

another and circulation data accompanies the item.  The need to move items between
titles is common in serials cataloging with missed title changes, but there may be
other cataloging situations that require moving items between bibliographic records.

Steps Involved

1. Search for and place both bibliographic records in the GUI OPAC Navigation
window.

mailto:s-koel@tc.umn.edu
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2. Open the tree structure for both records so that the list of Items can be viewed.
Arrange the two titles so that you can select the item to be moved and so that you can
see the UMN50 area of the second title without scrolling down the window. The
system does not allow you to scroll down the window once you start moving an item.*

If UMN50 does not appear on the target title (Title B), create one by clicking the
Catalog ADM button.  The record will be pushed to the cataloging module and the
ADM record will open.  Without touching the ADM, save it and close it.  In the GUI
OPAC, select the title and click the Refresh button.  There should be a UMN50 area
once the tree is expanded.

3. Locate the items to be moved from Title A.  Items can only be moved one at a time.
If the item is on loan, the system will not allow the item to be moved.

4. Select the item (left click on it and while holding down the left mouse button), drag
the item and drop (release the left mouse button) when the item is hovering on the
Items heading on the tree of Title B.

5. The item moved will lose the link to the holdings record on Title A.  To relink the
item to a holdings record associated with Title B, push Title B to the Items module.
Select the item just moved to that title.  Click the Retrieve Hol button.  Select a
holdings record to link to the item and click the Link to Item button.

*If you are unable to move an item because there are too many items listed when the tree
structure is opened, set the project aside.  Further investigation is needed into the
possibility of moving the items via a Web Services report, deleting and recreating the
items, or using a Shelved as note in the holdings record.
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Authority Workflow
Authority Workflow

Need
authority 

work?

Yes

Click on heading in bib, then
from menu click Search/

Search field headings of 
current library

SEARCH LOCAL BIB & AUTHORITY FILE:

System
replaces hdg in bib
record w/authorized

term

Authority &
bib record headings

same entity?

Yes

No

Need to
edit authority

record?

Yes

No

Replace
bib heading w/auth

heading?

Yes

No

Click
Select

Edit
record

Save to
server

Close authority
record

Create authority
record or route

per unit
procedures

SEARCH OTHER
AUTHORITY FILES:

Be sure that authority
record is still

selected in list of
records & click OK

Select heading & click
Expand to view full

authority record

Authority
record
found?

Yes

No

Authority
heading matches

bib?

Click
 Cancel

Yes

No
Have all

authority files been
searched?

Click on heading in bib,
then from menu click
Search/Search field

headings of other library

Yes

No

Select library
& click OK

From
Cataloging 
Workflow

Return to
Cataloging 
Workflow

Return to
Cataloging 
Workflow

Return to
Cataloging 
Workflow

Return to
Cataloging 
Workflow

Last updated 9/4/02
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Authority Work in Aleph
Staff have asked for clarification about how much authority checking needs to be done in
Aleph, and what kinds of authority work should be done.  The following is a working
document to address these questions.  Parts of it will be rewritten when we begin
routinely loading updates to the LC authority file in UMN10, when other changes are
made, or in response to additional questions from staff.  Topics covered:

� Authority files

� Authorizing headings and providing references

� Using the Y/N Update flag

� Adding an authority to UMN10

� Local updates to UMN10

� Heading maintenance

Refer also to “Searching Authority Records” and “Creating Authority Records” in this
manual.

If you have questions about authorities or authority work, please contact the Authority
Control Coordinator (Stephen Hearn, s-hear@tc.umn.edu, 612-625-2328).  If your
question is about a particular heading or record, please include the heading or record
number in your query.

Authority Files
We have three active authority files in Aleph:

� UMN10 contains the complete LC name and subject authority files as of mid May
2002.  It is used to authorize name, series, uniform title, and LC subject headings and
to provide references in the Aleph bib indexes.  Weekly updating of this file has not
yet begun.

� UMN11 contains the authorities from NOTIS which we locally created or modified.
It is intended as a resource file in Aleph, but does not actively authorize headings or
add references to the bib index.

� UMN12 contains the current MeSH authority file.  It is used to authorize medical
subject headings and provide references.  Work on MeSH headings is primarily the
responsibility of Biomed library staff.

mailto:s-hear@tc.umn.edu
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Authorizing Headings and Providing References
When you create or bring in a new bib record and save it to the server in UMN01, Aleph
does an automatic check of all the controlled headings in the record against the authority
files.

� Name and subject headings which find a match on either a 1XX or a 4XX form are
automatically linked to the 1XX form. This updates the form of the heading in the bib
record if the match was on a 4XX, and creates the link to the authority that appears in
the right column of the UMN01 indexes when a heading is searched. For many
records, this automatic correction and linking process is all the authority work that’s
needed.

� Heading which don’t match an authority are reported out in the Check Record pop-
up window.

� When a heading appears in this window, it should be searched in the UMN10 to
determine if there is an authorized form of the heading which differs from the
form in the bib record.

� If nothing is found in UMN10, UMN11 should also be searched to determine
whether we have authorized the heading locally in the past.

� Lastly, the heading should be searched in OCLC (using the OCLC client, not the
Aleph Z39.50 connection) or in LC’s new web file of authorities at
http://authorities.loc.gov.

Both of these versions of the file will contain new and updated records not yet
added to UMN10.  But note that we do not have a way yet to copy records easily
from either of these sources into Aleph.

Subdivided Subject Headings and Series Headings
Some headings will be reported in the Check Record window as unauthorized, but do
not need to be checked.  In particular, subdivided subject headings and series headings
are often reported unnecessarily, since these headings are not routinely established at the
same level of specificity that they have in bib records (e.g., without subdivisions, or
without series numbers).  Generally they can be ignored.

Common, Unqualified Personal Names
Be careful with common, unqualified personal name headings. There are many authority
records which authorize or contain references from simple forms of personal names.
When Aleph makes an automatic match on such an authority, it is not considering the
supplementary information on the authority record usually found in 670 fields, which
may indicate that the authorized name is really for a different person.  When dealing with

http://authorities.loc.gov/
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common personal names which lack dates or fuller forms, please check the authority file
to be sure that the name on the bib record matches the correct authority.

Headings on Recent LC Bib Records
In general, headings on LC bib records created within the last two years have a very good
chance of being correct and authorized, and do not need to be checked routinely.

Using the Y/N Update Flag
Recognizing that some authorities should not be used for automatic updating (e.g.,
because the 1XX or a 4XX is likely to match on more than one person or body or series),
Aleph defines an Update value for each authority record.  This value appears in the right
column of the index display, e.g., “1001 , aab, UPD=Y”.  Any authority which lacks a
UPD field is assumed to have the value Y, i.e., to be used for updating.  When we
identify a record which should not be used for updating, we can manually reset the
default value to “no” by entering a UPD field on the authority, e.g., “UPD __ a N” Once
flagged with the “no” update field, the record will not be used to automatically change
bib headings.

If you find an authority record which has incorrectly updated a bib heading, please add
the UPD=N field to the record, fix the incorrect heading, and report it to Stephen Hearn
(s-hear).

Adding an Authority Record to UMN10
If you find an authority in OCLC or LC’s catalog which is not yet in UMN0, there are
three reasonable levels of response, depending on how much time you have and how
likely you think it is that the heading or a variant form of it will be searched in the next
few months.

Option 1 Make the bib heading match the LC authority, and let it wait that way until
the authority gets loaded. Do not create an authority in UMN10.

Option 2 Make the bib heading match the LC authority, and create a local authority
in UMN10 with an 010 TEMP field, a 1XX field, and any crucial 4XX/5XX
references; but do not attempt to recreate the full authority in UMN10.

Option 3 Make the bib heading match the LC authority, and recreate the LC authority
in UMN10, including the LC 010 and all other fields.

Any of these responses could be considered appropriate. Cataloger's judgment is needed
to decide among them. When we return to a regular weekly updating of the LC authority
file in UMN10, this problem will be greatly diminished; but it will never completely go
away.
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Local Updates to UMN10

Updating Authority Records
Authority records in UMN10 can be updated locally to add references or other useful
information (e.g., to add birth/death dates or fuller forms of name in a 670).

� When a record with a valid LCCN in 010 is changed, the 010 should be left as is.

� If you find a match on a 4XX reference form while searching UMN11 which is not
present on an authority in UMN10, the Copy Field function on the Edit menu can be
used to add the 4XX form and any supporting 670 field to the record in UMN10.  If
the UMN10 record already a valid LCCN in 010, leave it as is.

Creating Authority Records
Local authority records can be created in UMN10. Refer to “Creating Authority Records”
in this manual for detail on the process.

� If you find a heading authorized in the UMN11 file but not in UMN10, the Copy
Record function on the Edit menu can be used to copy and paste the authority into a
blank UMN10 record.

� You can also enter a record directly.  

In both cases, be sure to mark the 010 field with TEMP on the locally created authority
so that it can be overlaid if a national authority record is loaded later.

NACO Contribution
Authority record updates and creation can also be done through NACO contribution.
NACO contribution is slower to affect the UMN01 indexes, but it is also more lasting,
since local changes are subject to overlay when the national record is modified.  Feel free
to include such new records or changes in other NACO work if you are authorized to do
so, or to report them to an authorized NACO contributor.

Policy and Process for Authority Record Creation 
Existing policies on when to create a new authority record continue to apply.  The
process for creating and editing authorities is up to individual teams.
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Heading Maintenance
Various kinds of heading maintenance work and corrections are being done.  Some of
these derive from problems with the initial generation of the Aleph indexes; others are
inherent to the dynamic nature of authority control.  These include:

� 100s missing subfield q.  Many 100 fields were indexed without including subfield q
for fuller forms. This was due to an incorrect table setting, which has since been
corrected.

The missing subfield can be restored by calling up the record and simply saving it to
the server, which will cause all the headings to be reindexed.

� Incomplete corrections.  The background processing of corrections which had been
backlogged during the index generation had to be cancelled in order to improve
response time.  This left some bib headings matched to 4XX forms on authorities, but
not yet corrected to the 1XX form. 

These can be corrected by calling up the record in cataloging and saving it to the
server, which dynamically causes the automatic correction process to occur.

� Odd exclamation points.  An early error in the Aleph tables caused some 100 fields
to be saved to the server with an exclamation point in place of the correct ending
punctuation. 

The table has been corrected, and these headings can now be revised as they are
found.

� New normalization differences.  Aleph is more scrupulous than NOTIS was when
comparing bib headings with minor variations, e.g., spacing, punctuation,
capitalization, subfielding, etc.  

When these variations are in controlled headings with an authorized form, they are
corrected to match the authorized form.

� Heading changes.  When we resume loading new and updated LC and MeSH
authorities, the load process will automatically create new links and update bib
headings.  This will generally be a major improvement over maintenance in NOTIS,
where new authorities were only occasionally linked to existing bib headings, and
updating bib headings was a largely manual process.

There will be occasional instances where the automatic process is in error.  When
these errors are found, they will be corrected. 
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Authority Work for Copy Cataloging

General Procedures

Headings to Verify
Verify headings only if variations exist:

� Heading(s) on material varies from heading(s) on catalog record.

� Variant form of heading is implied from heading structure, e.g. compound name.

AND
Cataloging copy is one of the following types:

� Member copy, including member-completed CIP.

� Pre-1985 LC copy.

� CIP copy only if form in the descriptive field of the catalog record (245, 4XX, 5XX)
differs from the material, or if there is a name or series on the material which is not in
the description.

OR
Series is coded 490 0^ -- regardless of the type of cataloging copy.

Fields to Verify
Verify these fields if above conditions apply:

� 100, 110, 111, 130

� 440, 490

� 600, 610, 611, 630

� 700, 710, 711, 730

� 830

Verification Procedures
1. Highlight heading to be checked.
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2. Click on Search/Search field headings of current library (F3).

� Highlight record.

� Verify heading use codes.

� Click Expand.
3. If  authority heading matches heading on catalog record:

� Accept all 4xx and 5xx references.

� If your work requires x-references not on authority record

� Click on Select to edit authority record.

OR

� Close screen and skip to Step 16.
4. If heading is the same entity, but does not match the heading on your record, close

screen, then click OK to replace heading in bib record.

5. If there is no match, close authority screens and continue with Step 6.

6. Click on Search/Search field headings of other library (Ctrl + F3).

7. UMN 10 will be highlighted, click OK.

� Highlight record.

� Verify heading use codes.

� Click Expand.
8. If  authority heading matches heading on catalog record:

� Accept all 4xx and 5xx references.

� If your work requires x-references not on authority record

� Click on Select to edit authority record.

OR

� Close screen and skip to Step 16.

9. If heading is the same entity, but does not match the heading on your record, close
screen, then click OK to replace heading in bib record.

10. If there is no match, close authority screens and continue with Step 11.

11. Click on Search/Search field headings of other library (Ctrl + F3).

12. Highlight UMN 11, Click OK.

� Highlight record.

� Verify heading use codes.

� Click Expand.



University of Minnesota Aleph Cataloging Manual Page 205
Issue Date: 11-27-2002 Authority Work
Revised Date: Authority Work for Copy Cataloging

Author: Leslie Bohm

13. If authority heading matches heading on catalog record:

� Accept all 4xx and 5xx references.

� If your work requires x-references not on authority record

� Click on Select to edit authority record.

OR

� Close screen and skip to Step 16.
14. If heading is the same entity, but does not match the heading on your record, close

screen, then click OK to replace heading in bib record.

15. If there is no match, close authority screens and continue to Step 16.

16. If no authority record has been found for access points requiring verification or the
record needs editing, complete cataloging, then route to your team’s authority shelf.

� Leave item process status as IP (in process).

� Put tracking information in Internal note field on tab 2 of Item record.

� Insert pink flag.

� Check Authority work category.

� Indicate which fields need authority work.

� If x-refs are needed, note only those which are not obvious.

17. Designated person will:

� Edit or create any needed authority records.

� Change Item process status to Not in process.

� Remove tracking codes.

� Update.

� Send to Marking room.

Appropriate Heading Use Codes

Names aab a=appropriate

Series aaa b=not appropriate

Topical subjects bab
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Adding Cross References

Copy catalogers can add certain types of conference and personal name x-refs, but should
always pass along series and corporate/geographic name x-refs to their team’s authority
work shelf. See individual procedures for each type of heading:

� Personal Names

� Series

� Corporate and Geographic Names

� Conferences

Personal Names
Note: For general authority work procedures, including types of cataloging copy for which

authority work is required, verification procedures, and heading use codes, refer to the
“General Procedures” section of this document. 

Verify Headings
Verify personal name headings (100, 600, 700, 800) only when a variant form of the
name is implied from the structure of the name heading, or appears on your material.

Variant Form Implied From Structure of Name Heading

� Compound surnames
(including hyphenated)

Examples

100 1^ $$a Lloyd George, David, $$d 1863-1945.
400 1^ $$a George, David Lloyd, $$d 1863-1945.

� Forenames 100 0^ $$a Raunaq Singh, $$d 1922-
400 1^ $$a Singh, Raunaq, $$d 1922-

100 0^ $$a Jean, $$c de Meun, $$d d.1305?
400 1^ $$a Meun, Jean de, $$d d.1305?

If the established heading is a
surname, but person is commonly
known by forename, check/make
forename x-ref.

100 1^ $$a X, Malcolm, $$d 1925-1965.
400 0^ $$a Malcolm X, $$d 1925-1065.

� Names containing
prefixes

100:1^ $$Adelung, Friedrich von, $$d 1768-1843
400:1^ $$aVon Adelung, Friedrich $$d 1768-1843

100 1^ $$a De Kooning, Willem, $$d 1904-
400 1^ $$a Kooning, Willem de, $$d 1904-
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Note: Over the years, LC practice has changed regarding x-refs from prefixes.  It is not
necessary to add or delete x-refs from prefixes on existing authority records;
accept the ones which are there as complete and correct.

Examples

100 1^  $$a Garcia de la Fuente, Olegario
400 1^  $$a Fuente, Olegario Garcia de la
400 1^  $$a De la Fuente, Olegario Garcia
400 1^  $$a La Fuente, Olegario Garcia de  (Accept all x-refs.)

100:1 ^ $$a Figueroa, Francisco de, $$d1536?-1620.
(No 4xx present on LC authority record; not necessary to add any.)

Variant Form Appears on Material

� Name appearing in
book varies in fullness
from established
heading. Examples

100 1^ $$a Marchal, Jean Yves.
400 1^ $$a Marchal, J.Y.$$q (Jean Yves)

100 1^ $$a Sethi, K. C.
400 1^ $$a Sethi, Krishan C.

Generally, do not be concerned with
differences in fullness of middle
names.  Exceptions to this are:
� Surname and forename are so

common that you feel there
could be more than one person
with the same surname,
forename, and middle initial.

100 1^ $$a Smith, John W. $$q (John Wilson)
400 1^ $$a Smith, John Wilson

� Person is cited in book by middle
name only.

100 1^  $$a Smith, W.  Eugene, $$d 1918-
400 1^  $$a Smith, Gene, $$d 1918-
400 1^  $$a Smith, Eugene, $$d 1918-

� Variant spellings appear on
material.

100 1^ $$a Raleigh, Walter, $$cSir, $$d 1552?-1618.
400 1^ $$a Ralegh, Walter, $$c Sir, $$d 1552?-1618.

100 1^ $$a Mao, Tse-tung, $$d 1893-1976.
400 1^ $$a Mao, Zedong, $$d 1893-1976.

� Different names for the same
person appear in book, such as
pseudonyms, name changes,
religious titles, etc.

100 1^ $$a Schickele, Peter.
400 1^ $$a Bach, P. D. Q.

100 0^ $$a John Paul $$b II, $$c Pope, $$d 1920-
400 1^ $$a Wojtyla, Karol, $$d 1920-

� Names on pre-AACR2 copy, which
you suspect may have changed with
AACR2.

100 1^ $$a Twain, Mark, $$d 1835-1910.
400 1^ $$ w nna $$a Clemens, Samuel Langhorne,
$$d 1835-1910.
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Procedures to Add Cross References
Add cross references to an existing authority record (or forward to your team’s authority
work shelf for additions) as follows:

400 (“Search Under”) Cross References

Add standard 400 (“search under”) x-refs to authority record, if not already present.

1. First indicator in 400 must match the structure of the x-ref you are adding (0 for
forename only, 1 for surname, 3 for family name), e.g.
400:1^  Singh, Raunaq, $$d 1922-
400:0^  Malcolm X, $$d 1925-1965
400:3^  Kennedy family

2. Add date(s) to 400 x-ref if present in established heading (100), e.g.
100:1^ Moffett, Thomas, $$d 1553-1604
400:1^ Muffet, Thomas, $$d 1553-1604

3. Add $$q (parenthetical qualifier) to 400 x-ref if available from established heading
(100), e.g.
100:1^ Dempsey, Michael W., $$d 1951-
400:1^ Dempsey, M. W. $$q (Michael W.), $$d 1951-

When there is a long sequence of names, place $$q at the end of the name.  $$q
should include the entire surname or forename-middle name(s) sequence, with the
exception of prefixes,  e.g.
100:1^ Rossi Varese, Marina F. $$q (Marina Federica)
400:1^ Varese, Marina F. Rossi $$q (Marina Federica Rossi)

100:1^ Beethoven, Ludwig van, $$d 1770-1827
400:1^ Beethoven, L. van $$q (Ludwig), $$d 1770-1827     (prefix omitted from x-ref)

100:1^ Garcia de la Huerta I., Marcos $$q (Garcia de la Huerta Izquierdo), $$d 1936-
400:1^ Huerta I., Marcos Garcia de la $$q (Huerta Izquierdo), $$d 1936-

4. Add 040 $$d MnU
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Pseudonyms

Pseudonyms may appear on authority records as either 400 or 500 fields.  Forward to
your team’s authority work shelf any authority record which you think may need a 500
(“search also under”) x-ref.  If there is any question whether an existing x-ref or one to be
added is a pseudonym, forward to your unit’s authority work shelf.

Example

100:1^ Stewart, J. I. M. $$q (John Innes Mackintosh), $$d 1906-
500:1^ Innes, Michael, $$d 1906-

100:1^ Creasey, John
400:1^ Ranger, Ken

Series
Note: For general authority work procedures, including types of cataloging copy for which

authority work is required, verification procedures, and heading use codes, refer to the
“General Procedures” section of this document. 

General Principles
� The default treatment for series is "fully analyzed, traced, classed separately."

On authority record: 644: : $$a f

645: : $$a t

646: : $$a s

� A series authority record is required only if the series title has known variants or if the
series treatment differs from the default treatment.

� 4xx field on bib record should match the series statement exactly as it appears on the
material being cataloged.

Note: Be especially careful when comparing series in material against 4xx field of
CIP copy; even a slight difference is important.

� When cataloging a new title, series must be tagged either 440 or 490:1 : with an
accompanying 8xx field.

Exceptions: 

Reprints and facsimiles: series for original in 500 or 534 $$f with accompanying
8xx

Microforms: series for microform in 533 $$f with accompanying 8xx

� $$v must be used in 440 or 8xx for numbered series. (You may need to add this on
older cataloging copy.)
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Authority Work Procedures
Note: These procedures apply to series which are cataloged separately. If there is any question

on how your material should be cataloged (sep, set, or serial), do not proceed with
cataloging; instead, check with HN or forward material to his sep/set questions shelf.
(Leave process status as IP and add tracking code set/sep and team designation AR or
AH in internal note field.) On an authority record, a 646 field with $$5 MnU and $$a
other than s means that MnU catalogs the series as a set.

1. Verify series headings (4xx, 8xx) only when a variant form of the series title is
implied from the structure of the series heading(s) or appear(s) on your material.

� Bib record has 490 with or without accompanying 8xx, e.g.,

490:0 :Time-Life library of art
490:1 :Proceedings / SPIE ; $$v v. 1099
830: 0:Proceedings of SPIE--the International Society for Optical Engineering ; $$v v. 1099

Exceptions: Do not verify 490/8xx if only variation is:

� Initial article, e.g.,
490:1 L'univers historique
830: 0 Univers historique

� Form of caption in $$v, e.g.,
490:1 :Garland bibliographies in sociology ; $$v vol. 4
830: 0:Garland bibliographies in sociology ; $$v v. 4.

� 440 field on bib record does not match material (most often occurs on CIP copy),
e.g.,

440: 0:Advances in systems, control & information engineering
On material: Advances in systems, control, and information engineering

� Multiple forms of series title appear on material.

� Initialisms, e.g.,
440: 0:Econometric Society monographs ;$$v no. 12
Also on material: ESM 12

� Foreign language equivalents, e.g.,
830: 0:Studien zur interkulturellen Geschichte des Christenums ; $$v Bd. 57.
Also on material:
Etudes d'histoire interculturelle du Christianisme
Studies in the intercultural history of Christianity
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� Other variant forms, e.g.,
440: 4:The Cambridge applied linguistics series
On series t.p.: The Cambridge applied linguistics series
On cover: Cambridge applied linguistics

830: 0:NATO ASI series. $$n Series C, $$p Mathematical and physical sciences ; $$v
no. 339.
Also on material: Advanced Science Institutes Series

� Evidence of series title change on material, e.g.,
440: 0:Wiley series in child and adolescent mental health
Previous title mentioned on material: Wiley series in child mental health

2. If necessary to verify series heading, make certain that 440 or 8xx on bib record
matches 1xx on authority record; if not, change bib record as follows:

� If 1xx matches bib record 490, change 490 to 440 and delete any 8xx.

� If 1xx does not match bib 440, 490, or 8xx, tag series 490:1 : and add/change 8xx
field to match 1xx.

� If authority record record indicates a series-like phrase (008 Series type c and a
note instructing that it not be used as a series), change the 4xx/8xx to a quoted
500 note or delete it entirely, according to the authority record’s instructions.

3. Do not add cross references to an existing series authority record.

� Accept all x-refs (4xx and 5xx) on authority records.

� If additional cross-references are needed, forward material to your team’s
authority work shelf.

4. Forward material to your team’s authority work shelf in the following cases:

� Series requires authority record but no acceptable authority record is found.

� Cross references are needed on authority record, including 4xx variant forms and
5xx title changes.

� Series on CIP copy, when 4xx field does not exactly match the series statement in
your material, LC's authority record is based on the erroneous CIP, and LC has
not yet updated their authority record.
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Corporate and Geographic Names
Note: For general authority work procedures, including types of cataloging copy for which

authority work is required, verification procedures, and heading use codes, refer to the
“General Procedures” section of this document. 

Verify Headings
Verify corporate and geographic name headings (110, 610, 651, 710), but not 650 $$z
only when a variant form of the name is implied from the structure of the name heading
or appears on your material.

Variant Form Implied From Structure of Heading

� Heading on bibliographic record includes a personal name within a corporate name,
e.g.,
610:2^:Harold E. Stassen Center for World Peace.
Implied variant: Stassen Center for World Peace

Variant Form Appears on Material

� If heading on bibliographic record has more or fewer levels than name on material,
verify entire heading as a whole. Do not verify any superior levels of the hierarchy
unless the form of that level varies from that on the material. (See next bullet.)
110:2^:Association for Library Collections & Technical Services. |b Acquisitions Committee
On material: ALCTS, Resources Section, Acquisitions Committee

110:2^:Hubert H. Humphrey Institute of Public Affairs.
On material: Hubert H. Humphrey Institute of Public Affairs, University of Minnesota

610:2^:Harold E. Stassen Center for World Peace.
On material: Harold E. Stassen Center for World Peace, Hubert H. Humphrey Institute of
Public Affairs, University of Minnesota

� If form of any level of the heading varies from that on material, verify that level.

� Initialisms appear on material, e.g.,
110:2^:American Society for the Prevention of Cruelty to Animals.
On material: ASPCA

710:2^:American Society of Mechanical Engineers. |b Applied Mechanics Division.
On material: Applied Mechanics Division, ASME

Note: Look for authority record only for the highest level ($$a of this 710),
because its form varies on the material.



University of Minnesota Aleph Cataloging Manual Page 213
Issue Date: 11-27-2002 Authority Work
Revised Date: Authority Work for Copy Cataloging

Author: Leslie Bohm

� Foreign language equivalent of corporate name appears on material, e.g.,
610:2^:Council of Europe.
On material: Conseil de l’Europe

110:2^:Council of Europe. |b Council for Cultural Co-operation.
On material: Consejo para la Cooperacion Cultural del Consejo de Europa

Note: Look for authority record both for the highest level alone and for the entire
heading because form of both levels varies on the material.

� Other variant forms appear on material, e.g.
110:2^:Woodrow Wilson International Center for Scholars.
On material: Wilson Center

710:2^:Society of Friends. 
On material: Quakers

� If there is a name change indicated on the material, e.g.,
110:2^:Exxon Corporation.
Earlier name indicated on material: Standard Oil Company

� If you have pre-AACR2 copy with a corporate or geographic name heading you
suspect may have changed with AACR2. The most common type of corporate name
AACR2 change was from place plus name (pre-AACR2) to direct order name
(AACR2), e.g., 
Pre-AACR2: 110:1^:Minneapolis. $$b Walker Art Center.
AACR2: 110:2^:Walker Art Center.

Do Not Add Cross References
Do not add cross references to an existing authority record for a corporate or geographic
name.

� In most cases 4xx cross references on an existing authority record will be complete
and correct. Generally, look for the following types of 4xx references, if applicable to
the work you are cataloging, but do not spend a lot of time deciphering or evaluating
every reference. If any of these is obviously missing OR you question whether other
types of references should be added to the record, forward the material to your unit's
authority work shelf.

� X-ref from surname when corporate name contains a personal name that begins
with a forename.
110:2^:Harold E. Stassen Center for World Peace.
410:2^: Stassen Center for World Peace
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� One x-ref for an initialism, without periods.
Exception: If the initialism appears on the material with periods, there should

be two x-refs, one with and one without periods.

On material: ALCTS
110:2^:Association for Library Collections & Technical Services
410:2^:ALCTS

� X-ref from variant form on material (language, wording, etc.)
On material: Consejo para la Cooperacion Cultural del Consejo de Europa

110:2^:Council of Europe
410:2^:Consejo de Europa

and
110:2^:Council of Europe. |b Council for Cultural Co-operation
410:2^: Council of Europe. |b Consejo para la Cooperacion Cultural

� X-ref from form that includes the next highest level of hierarchy when the
established heading omits that level of the hierarchy.
On material: ALCTS, Resources Section, Acquisitions Committee
110:2^:Association for Library Resources & Technical Services. |b Resources Section. |b
Acquisitions Committee 
410:2^:Association for Library Resources & Technical Services. |b Acquisitions
Committee 

On material: Hubert H. Humphrey Institute of Public Affairs, University of Minnesota
110:2^:Hubert H. Humphrey Institute of Public Affairs 
410:2^:University of Minnesota. |b Hubert H. Humphrey Institute of Public Affairs 

On material: Harold E. Stassen Center for World Peace, Hubert H. Humphrey Institute of
Public Affairs, University of Minnesota
110:2^: Harold E. Stassen Center for World Peace
410:2^:Hubert H. Humphrey Institute of Public Affairs. |b Harold E. Stassen Center for
World Peace

� 5xx cross references may or may not be present on an existing authority record.

� If you are aware that a corporate body has changed names, but no earlier or later
corporate heading (510) is present on authority record, forward to your team’s
authority work shelf.

� If no 510 is present for the name change indicated in your material, but authority
record instead has a 410 with an accompanying 667 note stating the name change,
forward these to your team’s authority work shelf also.
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Conferences
Note: For general authority work procedures, including types of cataloging copy for which

authority work is required, verification procedures, and heading use codes, refer to the
“General Procedures” section of this document. 

Verify Headings
Verify conference headings (111, 611, 711, and 811 conferences and 110, 610, 710, and
810 meetings), only when a variant form of the conference appears on your material.

(Although most conference headings are tagged 111, 611, 711, or 811, in some cases
meetings are entered as $$b’s of corporate headings, i.e. 110 $$b, 610 $$b, 710 $$b or
810 $$b.)

Examples:

111 2^  International Congress of Slavists $$n (10th : $$d 1988 : $$c Sofia, Bulgaria)
On material: Congresso internazionale degli slavisti

611 2^ Symposium on Solid State Device Technology $$n (7th : $$d 1982 : $$c Munich, Germany)
On material: SSSDT

710 2^ Association for Research in Nervous and Mental Disease. $$b Meeting $$n (70th : $$d1990
: $$c New York, N.Y.)
On material: ARNMD Meeting

Ongoing vs. One-Time Conferences
� If conference on bib record is ongoing, established heading (1xx) on authority record

should not include numbering, date, or place, but should consist of $$a only. (If a
conference met 10 times, there would be just one authority record, not 10.) If the
conference is numbered ($$n is present) it is ongoing. Some ongoing conferences are
not numbered, however (e.g., a periodic conference such as an annual conference).
Bib heading: 111 2^  International Machine Tool Technical Conference $$n (2nd : $$d

1984 : $$c Chicago, Ill.).
Auth heading: 111 2^  International Machine Tool Technical Conference

� If conference on bib record is not ongoing, $$d and $$c, if present, should be
included in established heading (1xx) on authority record. Accept LC's authority
record and assume the conference is not ongoing if you have no evidence to the
contrary (e.g., numbering; words indicating periodic occurrence; other conferences
with same name; etc.).
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Bib heading: 111 2^  International Symposium on Peat Utilization $$d (1983 : $$c Bemidji
State University)

Auth heading: 111 2^  International Symposium on Peat Utilization $$d (1983 : $$c Bemidji
State University)

� Occasionally when checking a conference heading, you will find an authority record
for a conference with the same name ($$a), but a different date and/or place ($$d,
$$c) than on your bib record. This usually indicates that the conference is ongoing but
this fact was not known at the time the authority record was created. In this case,
forward book and printouts of both bib and authority records to your unit's authority
work shelf. Example:
Bib heading: 111 2^  European Conference on Electronic Design Automation $$d (1984 :

$$c Warwick, England)
Auth heading: 111 2^  European Conference on Electronic Design Automation $$d (1981 :

$$c University of Sussex)

Procedures to Add Cross References
When adding cross references to an existing authority record (or forwarding to authority
shelf for additions):

� Add standard inverted x-refs for conferences to authority record, if not already
present. 4xx indicators will always be 2^. If c and/or d are present in 1xx field, do not
include them in 4xx fields. Examples:
111 2^  International Conference on a More Democratic United Nations
411 2^  Conference on a More Democratic United Nations, International

� Do not ad

� d inverted x-refs from the “root” of the conference name, e.g., More Democratic
United Nations, International Conference on a.

� Add 040 $$d MnU (whenever revising an existing authority record, except for
revision of heading use codes only).

� If other variant forms of conference heading appearing on material, including earlier
or later headings (51x), are not present on authority record, do not add them. Instead,
note the field number of the conference heading on a pink flag and forward material
with flag to your team’s shelf. Examples:
111 2^  History symposium of the International Academy of Astronautics.
On material:  IAA History of Astronautics Symposium

111 2^ International Conference on a More Democratic United Nations.
On material:  CADMUN

111 2^  Conference on Library Orientation for Academic Libraries.
On material (later heading):  Library Instruction Conference
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